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What’s new in this guide?

This version of the CallPilot Administrator’s Guide is a compilation of three 
previous volumes (Basic and Advanced 1 and 2). This guide provides an en
end view of how to set up and configure a CallPilot system. To support task
such as system backups and system monitoring, please see Monitoring and 
Security for the Administrator.

The following points outline changes in CallPilot 1.07:

� Removal of references to MAT

Although the CallPilot Administration Client and Meridian Application 
Tools (MAT) can coreside on the same PC, their functionality is no long
integrated.

� Third-party switch connectivity

For information on third-party switch connectivity, see “Skills you need” 
on page 18, “Related information products” on page 19, and Chapter 22, 
“Managing channels (M1 switch only).”

� Organization of systems into sites (optional)

Administrators might now need to open a site folder to see a CallPilot 
system icon. See “Connecting to a CallPilot server” on page 34.

� New access class levels

The Create/Delete and Edit access levels can now be restricted to mai
user information only. See “Access levels” on page 81.

� Automatic distribution of users across volumes

When this feature is enabled, new user mailboxes are automatically 
distributed in proportion to the size of the MMFS volumes created for th
CallPilot server. See Chapter 9, “Adding a mailbox user group.” 

� AutoAdd enhancements

Administrators can view or print the AutoAdd error log and include 
additional CallPilot fields in the AutoAdd data file. See Chapter 9, “Adding 
a mailbox user group.”

� Search Users enhancements

Administrators can search for users based on system greeting or mess
blocking capabilities. See Chapter 12, “Searching for users.”
14 CallPilot
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About configuring and administering CallPilot

Introduction

Once your switch is installed and provisioned and your CallPilot server is 
installed and configured, set up a very basic CallPilot system. After that has
smoothly over a period of routine maintenance, extend the system function
to meet the requirements of your organization and users.

What is CallPilot?

CallPilot is a powerful multimedia messaging system that offers a single 
solution for managing many types of information, including

� voice, fax, and e-mail messages

� telephone calls (including conferencing)

� calendars

� directories

� call logs

CallPilot users can send and receive both voice and fax messages through
display-based phonesets, wireless sets, Windows desktop computers, or a s
recognition interface.

What is the CallPilot Administration Client?

Use the CallPilot Administration Client to connect to a CallPilot server. Onc
you have connected to the server, you can create and maintain the informa
the server uses to provide CallPilot messaging services to authorized users

This information includes

� user groups and permissions

� system settings

� messaging service settings
Administrator’s Guide 15
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Delegation of administrative tasks

The CallPilot Administration Client encompasses diverse functionality. The 
administrators who use it can be distributors, support technicians, or regular
to-day administrators of customer systems. 

When you use the CallPilot Administration Client, you can delegate 
administrative tasks among different administrators. For example, you set u
your CallPilot system so that a user group administrator controls user acce
CallPilot messaging services while a network administrator controls system
configuration and backups. 

See also
� “Connecting to a CallPilot server” on page 34

Remote administration

For most systems, delegating administrative tasks necessitates remote 
administration of the server. This guide includes instructions for using the 
Symantec Corporation product pcANYWHERE32 for setting up remote 
administration at an administrator’s site.

One licensed copy of pcANYWHERE32 Version 8.0 is provided for the serv
on the CallPilot server software CD. pcANYWHERE is installed on the serve
the factory. 

To install pcANYWHERE Version 8.0 on the administrative PC, you must 
purchase a separate license for the administrative PC.

See also
� Chapter 23, “Configuring remote administration of the server”
16 CallPilot
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About this guide

Introduction

The Administrator’s Guide provides the information you need to 

� set up user and messaging administration of a CallPilot system

� perform frequent or routine administrative tasks

� extend the functionality of a CallPilot system

See also
� system monitoring and troubleshooting information in Monitoring and 

Security for the Administrator

� “Related information products” on page 19

Assumptions

This guide assumes that

� the CallPilot server has been correctly installed and is operational

� the switch has been installed and provisioned to support your CallPilot
system

If the CallPilot server has not been installed, then install it before proceedin
For installation instructions, refer to the software installation and configurati
guide appropriate to your server type.

If the CallPilot server has been installed but is not operational, refer to 
Monitoring and Security for the Administrator for information on 
troubleshooting your system.
Administrator’s Guide 17
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Skills you need

Switch technology knowledge

Knowledge of, or experience with, one or more of the following products is 
recommended:

� Meridian 1 (M1) PBX equipment, X11 release 23c and greater

� MSL-100 equipment

� Lucent equipment

� Mitel equipment

� Rolm equipment

� Matra equipment

PC experience or knowledge

Knowledge of, or experience with, the following PC products is assumed. F
more information on these products, please refer to the documentation prov
by the manufacturer:

� Microsoft Windows NT, 95, or 98

Other experience or knowledge

Other types of experience or knowledge that can be of use include

� network management

� client/server systems
18 CallPilot
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Related information products

Introduction

The following list of CallPilot documents are stored on the CD-ROM that yo
receive with your system. You can search the entire suite of documentation
online, or you can print part or all of a guide. 

Planning and engineering guides

Use these guides before you install CallPilot to help plan your system, and 
plan a migration of data from Meridian Mail to CallPilot. 

Installation and configuration guides

These guides describe how to install hardware and software for the CallPilo
server, client, and desktop messaging. Instructions for configuring the switch
also provided.

Document Titles

Planning and Engineering Guide

Meridian Mail to CallPilot Migration Utility Guide

Document Titles

200i Installation and Configuration Guide

702t Installation and Configuration Guide

1001rp Installation and Configuration Guide

Desktop Messaging Software Installation and Maintenance Guide
Administrator’s Guide 19
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Administration guides

These guides provide specialized information to help you configure CallPilo
administer and maintain it, and use its features. 

Networking guides

These guides describe how to plan, install, set up, and troubleshoot networ
services. 

Document Titles

Getting Started Quick Reference Card

Administrator's Guide

Reporter Guide

Application Builder Guide

Monitoring and Security for the Administrator

Document Titles

Network Planning Guide

AMIS Implementation and Administration Guide

Integrated AMIS Implementation and Administration Guide

NMS Implementation and Administration Guide

Enterprise Implementation and Administration Guide

VPIM Implementation and Administration Guide
20 CallPilot
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End user guides

These guides are intended for end users of CallPilot, such as phoneset use
desktop messaging users.

Trouble-shooting reference

This reference provides step-by-step troubleshooting procedures for CallPil

Using the online Help, guides, and tutorials

CallPilot contains three online sources for information:

� Online Help provides brief answers to the questions “What’s this?” and
“How do I...?”

� Online guides provide detailed conceptual information, as well as 
information on how to perform detailed tasks.

� Online tutorials provide a complete product overview, as well as specifi
information on how to use Application Builder.

You can access all information using either the Help menu or Help buttons.

Contacting Technical Support

For help with troubleshooting your system, contact your distributor’s technic
support organization.

Document Titles

Multimedia Messaging User Guide

Speech Activated Messaging User Guide

Desktop Messaging Quick Reference Guide

Document Title

CallPilot Troubleshooting Reference
Administrator’s Guide 21
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Contacting Nortel Networks

If you have comments or suggestions for improving CallPilot and its 
documentation, Nortel Networks would like to hear from you. Please contac
at the following address:

http://www.nortelnetworks.com/callpilot_feedback
22 CallPilot
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Overview

Introduction

This chapter summarizes the tasks required to configure and administer a 
CallPilot system. 

This chapter is organized into two levels of CallPilot configuration tasks:

� High-level task flow describes the functional areas that must be set up 
before you can provide a CallPilot system to an organization.

� Detailed task lists provide a more detailed description of each task. 

Note: These tasks lists are numbered only where the order of the tasks
be identified.

Starting point

The following tasks must have been completed successfully:

� messaging network configuration

� switch installation and provisioning

� server installation and configuration

� CallPilot Administration Client installation

High-level task flow

Task Detailed task list

1 Set up a basic CallPilot system and verify that 
it is running smoothly.

“Detailed task flow: Initial system 
setup” on page 25

2 Perform ongoing maintenance tasks. “Frequently performed tasks” on 
page 26

3 Extend system functionality as needed. “Detailed task flow: Extending 
system functionality” on page 28
24 CallPilot
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Detailed task flow: Initial system setup

Introduction

The first set of tasks is to set up a basic voice messaging system and ensu
it is running smoothly. These tasks must be performed before the system ca
effectively.

Administrative role

Typically, these tasks are performed by the distributor.

Basic CallPilot configuration task flow

Task See

1 Configure the Voice Messaging SDN. Chapter 4, “Making the basic service
available”

2 Configure dialing information, message 
delivery thresholds, holidays, and specialized 
DNs, and customize system prompts.

Chapter 5, “Configuring basic 
messaging options”

3 Configure system-wide logon requirements and 
apply the global restriction/permission list 
(RPL). 

Chapter 6, “Configuring mailbox 
security” 

4 Customize the global RPL. 

Note: By default, no off-switch dialing is 
permitted.

Chapter 7, “Customizing dialing 
restrictions and permissions” 

5 Configure access classes for administrators and 
managers.

Chapter 8, “Controlling access to 
administration programs”

6 Add mailbox users. Chapter 9, “Adding a mailbox user 
group”

7 Customize mailbox classes. Chapter 10, “Configuring mailbox 
capabilities for a user group”
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Frequently performed tasks

Introduction

Once the basic system is running smoothly, there are routine maintenance 
to perform whenever users

� cannot access their mailboxes

� join or leave the organization

� change job function

Administrative role

Typically, these tasks are performed by one or more on-site customer 
administrators.

See also
� information about installing and configuring Desktop Messaging on the

user’s PC in the Desktop Messaging Installation and Configuration Guide

Frequently performed administrative tasks

Task See

Search for a user or user group. Chapter 12, “Searching for users”

Reenable a disabled mailbox.  “Reenabling a disabled mailbox” on page 
143

Reset a user’s password.  “Resetting a user’s mailbox password” on
page 144

Enable or disable a user’s mailbox 
autologon.

 “Enabling or disabling Autologon to a 
mailbox” on page 146
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Disable or restore a user’s administrative 
privileges.

 “Disabling and restoring a user’s access to
administrative programs” on page 148

Adjust mailbox capabilities for a user 
group.

 “Resetting a user’s mailbox password” on
page 144

Move a user to a different user group.  “Resetting a user’s mailbox password” on
page 144

Add or delete a user. Chapter 15, “Adding and deleting users an
directory entries” 

Adjust mailbox capabilities for an 
individual user.

 “Customizing a mailbox for a typical user”
on page 165 or “Customizing a mailbox for 
a specific scenario” on page 175

Customize system prompts.  “Viewing and changing system prompts” 
on page 58

Create and maintain shared distribution 
lists.

Chapter 11, “Creating and maintaining 
shared distribution lists”

Task See
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Detailed task flow: Extending system 
functionality

Introduction

Once your basic system is running smoothly, you can extend its functionalit

Enhancement stages

Enhancements are performed all at once or in stages. If you perform the tas
stages, it might be necessary to repeat tasks for each stage of enhanceme

For example, you can add fax options as an enhancement. Later, when use
acquire more advanced equipment, you can enable speech recognition fea
for the user groups that require them. Then, if the customer upgrades the sy
to include Enterprise or AMIS networking, you can enable Networking for 
certain user groups and configure some feature SDNs for sharing.

As a system develops, set up remote administration PCs for various 
administrators and, if the CallPilot server is connected to an M1 switch, man
channel allocations to optimize system performance.

Administrative role

Typically, these tasks are planned and performed by the distributor.

Impact on user environment

The process of adding some optional Multimedia Messaging features involv
upgrading end user equipment, and might involve upgrading the CallPilot 
system. 

See also
� information about hardware requirements and associated software in th

Desktop Messaging Installation and Configuration Guide
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Tasks for extending system functionality

Additional tasks for system functionality

Task See

1 Make additional services available to users.Chapter 17, “Making optional 
services available”

2 Configure session profiles for Application 
Builder applications (voice menus).

Chapter 17, “Making optional 
services available”

3 Configure additional messaging options. Chapter 18, “Configuring mailboxes 
for optional services”

4 If a second language has been added, make 
system prompts bilingual.

 “Making system greetings bilingual” 
on page 242

5 Configure outcalling services. Chapter 19, “Configuring outcalling 
services”

6 Create any new RPLs that are required and 
apply them to the new features.

Chapter 20, “Configuring RPLs for 
optional messaging features”

7 If the system is complex enough to require a 
hierarchy of user groups, create and organize 
new user creation templates.

Chapter 21, “Adding user creation 
templates”

Task See

M1 switch only: Reallocate channels to 
different media.

Chapter 22, “Managing channels (M1 
switch only)”

Configure the remote administrative PC. Chapter 23, “Configuring remote 
administration of the server”
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Connecting to a CallPilot server

Introduction

You must connect to your CallPilot system server before you can

� perform administrative tasks

� build or work with CallPilot applications

Selecting a system—the CallPilot Administration Client Explorer 
window

After you open the CallPilot Administration Client, select your CallPilot syste
either directly from the CallPilot Administration Client Explorer window or 
from a folder that has been created to group all related systems together.

Getting there  Start > Programs > Nortel Networks CallPilot Administration Client
34 CallPilot
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Selecting an administrative program—the CallPilot Administration 
Client

When you select a system from the CallPilot Administration Client Explorer
you are prompted for a user ID and password. Once CallPilot validates the 
compatibility between the server and client software, as well as the user ID 
password, the CallPilot Administration Client window for the selected system
appears. 

If the server software has been installed, upgraded, or reinstalled since the
time you connected to the system using the sysadmin account, change the
default password (see “Changing the sysadmin account password” on page 3.

Note: The following illustration shows the window with the program list 
expanded.

The CallPilot Administration Client gives you access to your system and 
administrative programs, using a navigation tree to display the system’s 
hierarchy. 
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Changing the sysadmin account password

Introduction

The password for the default system administrator account is automatically
to nortel whenever CallPilot server software is installed, upgraded, or 
reinstalled. Afterward, when you first use the default system administrator 
account (sysadmin) to connect to the CallPilot system, you must use nortel as 
the password. CallPilot immediately prompts you to change the password. If
do not specify a new password, you cannot connect to the system.

Also use this procedure when your password expires and you have to chan

The only other way to change the sysadmin account password is to reset it 
default nortel.

See also
� “Connecting to a CallPilot server” on page 34

� “Resetting a user’s administrative password” on page 150
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Getting there  Start > Programs > Nortel Networks CallPilot Administration Client

To open a system with new or upgraded software

1 Double-click the system name.

Result: The CallPilot Administration Client system logon window appears.

2 In User ID, type sysadmin .

3 In Password, type nortel .
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4 Click OK.

Result: The CallPilot Administration Client prompts you to change your 
password.

5 Click Change Password.

Result: The Change Password dialog box appears.

6 In the Old Password box, type the new password.

7 In the New Password box, type the new password.

8 In the Confirm New Password box, type the new password again.

9 Click OK.

Result: The CallPilot Administration Client system window appears.
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Simultaneous access to administrative 
resources

Introduction

Multiple administrators can log on to CallPilot at the same time without 
overwriting one another’s work.

If you try to access a resource (such as a specific mailbox class or user pro
that is currently being edited, you see a read-only view of the property shee
You are not notified when the resource is released, but must try to access t
property sheet again to see whether its status has changed. 

If you are the first to log on to a particular resource and another administrat
tries to access the same resource, a message informs you of the access at
You have the following options:

� Keep editing.

� Save your changes, and release the resource to the other administrato

� Cancel your changes, and release the resource to the other administra

If you do not respond to this prompt within two minutes, the system release
resource and all your unsaved changes are lost.

Refreshing screens

Because multiple administrators can access the same database at the sam
use the Refresh command (available from the View menu) to ensure the 
information you are seeing is the most up to date. 

For example, if you are viewing a list of users when another administrator 
deletes a user, the only way to see the change is to refresh the screen. The
refresh the screen regularly.

See also
� Chapter 8, “Controlling access to administration programs”
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Service directory number overview

Introduction

To make a service or application available to callers, you must add a unique
service directory number (SDN) to the SDN table and then publish the num
to users of the service. Until you do this, the service or application exists in
system but callers cannot use it. 

Outcalling Services, which require an outbound SDN before they can perfo
their functions, are automatically added to the SDN table during software 
installation. 

SDN Table

An SDN is the number that callers dial to access a service. Each SDN mus
unique so that when a caller dials a number, the system can identify which 
service is being requested.

SDNs are defined on the server and stored in the SDN Table. When a caller
a number to access a service, the system looks up the number in the SDN 
and activates the appropriate service.

See also
� Chapter 16, “Overview of optional services”

� Chapter 17, “Making optional services available”
42 CallPilot



April 2000 Making the basic service available

e 
Assigning a Voice Messaging SDN

Introduction

For a basic system, you need only a Voice Messaging SDN.

Access requirements

To add SDNs, you must belong to an access class that grants Create/Delet
access to Service Directory Number.

Getting there  CallPilot System > System Administration > Service Administration > 
Service Directory Number
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To create the Voice Messaging SDN

1 On the File menu, click New.

2 On the General tab, in the Service DN box, type the dialable number you 
want to assign to the application.

3 In the Application Name list, select Voice Messaging.

4 In the Media Type list, select Voice. 

Note: If all boxes are disabled, no further configuration is necessary.

5 When you finish configuring the Service DN, click Save.
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Summary of messaging configuration options

Introduction

The Messaging Administration program lets you define the system-wide sett
for the messaging services you have set up. These settings govern how 
mailboxes receive, compose, and send both fax and voice messages. The 
remainder of this chapter explains those settings and the ways to configure 

Use CallPilot Administration Client to configure the following settings:

� Mailbox storage limits and time-outs (see page 47)

� Dialing information (see page 50)

� Billing and attendant DNs (see page 54)

� Holiday schedule (see page 56)
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Setting mailbox storage limits and 
system time-outs

Introduction

To keep data and traffic from exceeding system capacity, you must set Mail
Full warning thresholds and time-outs. All these settings are found on the 
Messaging Administration General tab (see page 48).

Mailbox storage limits and warnings

Mailbox storage limits apply to all CallPilot voice items, including prompts. 
When you specify the number of minutes and seconds allowed for user 
mailboxes, also specify the percentage at which CallPilot generates a warni
the user to delete voice items.

Time-outs

Time-out values determine the amount of time that the system waits for a c
to respond to a prompt before taking action (prompting again or disconnect

Command Entry time-out
The Command Entry time-out is used when the system is waiting for a resp
from the caller. Set time parameters that, when exceeded, prompt the syste
a response. 

Short Disconnect time-out
The Short Disconnect time-out ends a call when the Command Entry time-o
has been exceeded. Callers usually have several opportunities to respond b
the short disconnect time-out is used. This time-out value is used when a c
disconnects from a thru-dial service or Application Builder menu.

Record Disconnect time-out 
This time-out value is used when prompts are recorded for menus, 
announcements, and thru-dial services. The system disconnects the sessio
when, during recording, the specified length of silence is recorded. 
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Access requirement

To specify mailbox storage limits or system time-outs, you must belong to a
access class that grants Edit access to Messaging Administration.

Getting there  CallPilot System > Messaging Administration > Messaging 
Administration > General tab

To specify the Mailbox Full warning threshold

1 In the percent box, type the percentage of capacity that a mailbox reaches 
before the user hears the Mailbox Full warning prompt.

2 When you finish configuring the system messaging options, click Save.

To specify the mailbox capacity

1 In the Maximum prompt size box, type the number of minutes and seconds 
allowed for all CallPilot voice items, including all system prompts, 
customized prompts, and prompts defined in Application Builder. 

2 When you finish configuring the system messaging options, click Save.
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To set message blocking options

1 If there is a check mark in the Block call answering when mailbox is full box, 
all messages except system messages are blocked until the user deletes 
messages from the mailbox.

2 When you finish configuring the system messaging options, click Save.

To specify system time-outs

1 In the Command Entry box, type the number of seconds the system waits 
for an action from a caller.

2 In the Short Disconnect box, type the number of seconds the system waits 
for user input from a thru-dial service or voice menu before disconnecting.

3 In the Record box, type the number of seconds the system waits for a caller 
to record more until the system disconnects.

4 When you finish configuring the system messaging options, click Save.
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Specifying dialing information

Introduction

CallPilot requires dialing information to translate a number into a dialable 
directory number (DN). Dialing information consists of two general types of
information, required for the following purposes:

� to call the local switch and access the network

� to distinguish certain area or city codes that require a mixture of local c
and long distance calls, depending on the exchange of the destination d
number

Note: Information entered during the installation process appears automatic

Feature use of dialing information

CallPilot users do not directly use dialing information. Certain features use 
dialing translations to generate a DN to call back.

� The system uses default access codes to handle normal situations for 
national, international, and (if they exist) ESN calls.

� Exceptional situations, such as calls to other area or city codes that are
considered local calls, use area/city codes.

Switch type dependencies

Only the M1 switch can 

� capture an external CLID with an unknown format

� translate unknown dialing numbers into a default DN

For all other switch types, the controls relating to CLID and the translation ta
are preset and disabled.
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Dialing defaults

CallPilot uses these prefixes to generate a DN that is understandable to the
switch. You must define four dialing defaults to call outside your local switch

� local prefix—to dial out of the switch and access the public network or 
private network to place a local call

Note: Enter a prefix depending on whether you use a private network o
public network to place local calls. Typical network access codes are 9
to access the public network.

� long distance prefix—to dial out of the switch and access the public 
network or a private network to place a long distance call

Note: Enter a prefix depending on whether you use a private network o
public network to place long distance calls. Typical long distance prefix
are 91 or 81 in North America, or 90 or 80 in Germany, to access the pu
network, or 6 to access a private ESN network

� international prefix —to dial out of the switch and access the public 
network or a private network to place an international call

Note: Enter a prefix depending on whether you use a private network o
public network to place international calls. Typical international access 
codes in North America are 9011 or 8011 to access the public network
6011 to access a private ESN network.

An international access code in England, for example, is 900.

� ESN access code—to dial out of the switch to place local, long distance,
international, and ESN calls using either the public network, the ESN 
network, or a combination of both

Note: To access a private ESN network, you typically dial 6 plus the dig
needed to make a national call to the same local site. For instance, the
city code of Manhattan is 212, so the access code is 61212.

Access requirements

To specify dialing information, you must belong to an access class that gran
Edit access to Messaging Administration.
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Getting there  CallPilot System > Messaging Administration > Messaging 
Administration > Dialing Information tab

To specify dialing information

1 In the Local Prefix box, type the prefix users must dial to make a local call.

2 In the Long Distance Prefix box, type the prefix users must dial to make a 
long distance call.

3 In the International Prefix box, type the prefix users must dial to make an 
international call.

4 In the ESN Access Code box, type the prefix users must dial to make a call 
on the private ESN network.

5 In the Local country code box, type the code that identifies the local area or 
city in which your switch is located.

6 In the Local area/city code box, type the code that identifies the country in 
which your switch is located.

7 To configure CallPilot to collect calling numbers from unknown dialing 
plans, make sure there is a check mark in the Capture external CLID with 
unknown format check box.

Note: For non-M1 switches, this check box is checked and disabled.
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M1 connectivity:  If you are confident that all unknown incoming calls are 
the same type, you can configure CallPilot to both collect and translate 
unknown numbers. If not, either make sure that there is no check mark in 
the Capture external CLID with unknown format check box, or click <None> 
in the Default translation list.

8 To define how your system translates unknown dialing numbers into one 
type of dialing number, select a default from the Default translation list.

Note: For non-M1 switches, this check box is set to None and disabled.

M1 connectivity: If you are not confident that all unknown incoming calls 
are the same type, but have decided to collect them, choose <None> from 
the Default translation list. 

9 When you finish configuring the system messaging options, click Save.
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Configuring special DNs

Introduction

Special DNs include

� the billing DN, which accepts billing charges if the initiator’s mailbox 
number is lost (for example, if the call is dropped) 

� the attendant DN, which specifies an extension to which the system 
transfers callers if they press 0 during a messaging session and the 
subscriber has not set up a revert DN

� the optional name dialing DN, which allows callers to dial a user by 
spelling his or her last name on the phoneset keypad

Name dialing restrictions

Disable name dialing

� to prevent external callers from identifying your system’s users

� in any country where the keypads are not mapped to an alphabetical 
sequence that CallPilot recognizes.

Access requirements

To specify or modify special DNs, you must belong to an access class that g
Edit access to Messaging Administration.

See also
� information on generating chargeback reports in CallPilot Reporter Guide
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Getting there  CallPilot System > Messaging Administration > Messaging 
Administration > DNs and Prefixes tab

To specify default billing and attendant DNs

1 In the Billing DN box, type the extension number that the system bills if it 
cannot determine a user’s extension for outcall charges.

2 In the Attendant DN box, type the default extension number to which the 
system transfers callers if they press 0 during a messaging session.

3 When you finish configuring the system messaging options, click Save.

To enable name dialing and name addressing

1 Ensure there is a check mark in the Name dialing and name addressing 
check box.

2 In the Prefix for name dialing and name addressing box, type the digits that 
users must dial to access the name dialing feature.

3 When you finish configuring the system messaging options, click Save.
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Specifying system-wide holiday service times

Introduction

When you set up CallPilot messaging for your organization, specify or mod
the days and times of day when holiday service takes effect. This schedule
affects greetings and applications created in Application Builder.

Access requirement

To specify holiday service times, you must belong to an access class that g
Edit access to Messaging Administration.

Getting there  CallPilot System > Messaging Administration > Messaging 
Administration > Holidays tab
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To specify a new system holiday

1 To create a holiday, click New.

2 In the New Holiday dialog box, in the Name box, type a name that identifies 
the holiday.

3 In the Start Date box, select the day in month/day/year format when holiday 
service begins.

4 In the Start Time box, select the time of day when holiday service begins.

5 In the End Date box, select the day in month/day/year format when the 
holiday ends.

6 In the End Time box, select the time of day when holiday service ends.

7 When you finish configuring the system messaging options, click Save.

To modify holiday date or time interval

1 Select an existing holiday from the list.

2 To change the time or date of a holiday, click Modify.

3 In the Holiday dialog box, change the time or date.

4 When you finish configuring the system messaging options, click Save.
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Viewing and changing system prompts

Introduction

Use the System Prompts Customization program to

� see a list of installed languages

� see a list of prompts used by Application Builder voice menus and serv

� change existing prompts

Note: To add new prompts, create a new Application Builder application.

Adding a corporate identity to system greetings

A system greeting is recorded by the administrator and precedes the perso
greeting of all users during a call answering session.

You can customize the content of seven system prompts. You see these se
prompts in the main window of System Prompts Customization.

Example
“Welcome to RTM Productions, Online Products Division. Hello, this is Joan
Parker. I’m not at my phone right now. Please leave a message, and I’ll retu
your call as soon as possible.”

The first sentence is the system greeting. The remainder of the message is
user’s personal greeting.

If the prompt text is not visible

The user interface can display the prompt text only in languages with chara
sets supported by Windows 95/98. If the text of a prompt is not visible, use 
Prompt ID to play the prompt.
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Phoneset requirements for recording prompts

To record customized prompts, use a phoneset with System Prompts 
Customization. 

Connecting
In the Specify Phoneset dialog box, define the phoneset you want to use to
record customized prompts. Enter its number in the same format as you wo
dial the number. You must answer the phoneset when it rings. 

Recording
After you click the Record button in the Voice Recorder dialog box, the syst
records what you speak into the phoneset. When you record, you overwrite
last recorded customized prompt. You cannot record over a WAV file.

Disconnecting
After recording a prompt, you do not have to disconnect from the phoneset
hanging up. You can stay connected and record other prompts. Disconnect
when you have finished recording all the prompts you need.

WAV file formats to use

To import already recorded WAV files into System Prompts Customization, y
must ensure the files are in the correct format. You can import only 8-, 11-, 
or 44-bit WAV (.wav) files recorded at 22 050 kHz, mono.

Access requirements

To view or play system prompts, you must belong to an access class that g
View access to System Prompts Customization.

To record or import system prompts, you must belong to an access class th
grants Edit access to System Prompts Customization.
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Getting there  CallPilot System > Messaging Administration > System Prompts 
Customization
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To view and change prompt properties

Note: If the system you are using does not support the prompt language, it 
cannot display the prompt text. To hear the prompt, follow the instructions in
“To play a system or customized prompt” on page 62.

1 Select a prompt.

2 On the File menu, choose Properties.

3 Make any changes to the prompt properties as required.

4 When you finish modifying the prompt properties, click Save.
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To play a system or customized prompt

1 Select a system prompt.

2 On the File menu, choose Properties.

3 Ensure the appropriate Prompt button is selected. 

4 Click Play. 

If you have already connected to a phoneset, go to step 8.

5 In the Enter a phone number box, type the telephone number of the 
phoneset on which you want to listen to the prompt.

6 Click Dial.

7 When the phoneset rings, answer it before its seventh ring.

8 Click Play.

9 To stop playing the prompt, click Stop.

10 Click Done to stay connected to the phoneset and return to the Prompt 
Type dialog box.

or

Hang up to disconnect from the phoneset and to return to the Prompt Type 
dialog box.

11 Click Save.
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Issues and recommendations

Introduction

When you set up your CallPilot system, you must address the following issu

� Unused mailboxes and inadequate mailbox access controls make it eas
hackers to use your system.

� Mailboxes provide access to outdialing features, for which your 
organization is charged on a per-use basis.

This section provides recommendations for avoiding the unauthorized use o
your system.

See also
� “Configuring requirements for logging on” on page 67

� “Assigning global restriction/permission lists” on page 69

� information about securing the CallPilot system in Monitoring and Security 
for the Administrator

Global dialing restrictions

Use the CallPilot Security Administration program to apply a global restricti
permission list (RPL) to all system users. 

Restriction/permission lists (RPLs)
An RPL specifies which dialing codes are permitted and which are restricte
Whenever a CallPilot feature tries to place a call via the switch, the assigne
RPL is checked to see if the call is allowed. Assign RPLs to all CallPilot featu
that can dial out of the system. 

Note: You can assign more restrictive RPLs to some user groups or to spec
CallPilot features that dial out of the system. 

See also
� Chapter 7, “Customizing dialing restrictions and permissions”
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Mailbox security issues and recommendations

Pay-per-minute services (900 calls)
Hackers often use corporate systems to pay for pay-per-minute services, w
are accessed via a 9xx access code. Apply a global RPL to prevent all calls
pay-per-minute services.

See also: “To customize the Long Distance 1 RPL for domestic long distance
on page 77

Default passwords
Users often delay changing their default passwords, which makes it is easie
hackers to gain access to a new mailbox. To work around this user habit, 
configure CallPilot to generate a password prefix.

Example: If a user’s extension and mailbox number is 2339 and the passwo
prefix is 55, the user’s default password is 552339.

Change the default password prefix regularly and include the password pre
data files used to add groups of CallPilot users. 

See also: 

� “To set global mailbox password options” on page 68

� “Adding a group of users all at once” on page 104

Unused mailboxes
Hackers look for the following signs that indicate that a mailbox is unused. T
look for mailboxes

� that do not have recorded spoken names (personal verifications)

� with the default greeting “The person at extension 8522 is not available
take your call.”

� with no messages or with old messages

Delete unused mailboxes to keep hackers out of your system.

See also: information on protecting the system against hackers in Monitoring 
and Security for the Administrator
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Users’ password habits
Users often repeat favorite passwords and choose passwords that are easy
hack.

Nortel Networks recommends that you take the following actions:

� Force users to change their passwords regularly as a good security pra
By default, users must change their passwords every 90 days.

� Play a warning message a few days before users’ passwords expire so
they can change the password before it expires. The default is five day
The warning message plays once each day until the password is chan

� Ensure that users change their passwords to new passwords, rather th
entering the same passwords. By default, users must enter five new 
passwords before they can reuse an old password.

� Educate users about how to create secure passwords to increase syst
security.

Note: Security experts recommend a minimum length of six digits, but eight
digit passwords provide more security. 

See also: “To configure mailbox access controls” on page 68

User education and guidelines

The following guidelines can help users to create better passwords. Let use
know about the security risks involved and why these measures are importa

� Do not use obvious dates, names, and words (such as favorite hobbies
food, and so on).

� Use phonetic versions of meaningful words that are easy to remember

Examples: whyzkrak, phabuluss

� Use numbers in place of some letters. These are hard for password-cra
programs to match.

Examples: 4ainbow, 8ookworm, pu22led

� Use combinations of words that result in non-words. 

Examples: apecar, teaflower
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Configuring requirements for logging on

Introduction

Use the CallPilot Security Administration program to define mailbox logon 
requirements for all system users. Enable and configure security options th
control external logons and limit the number of unsuccessful logon attempts

Access requirements

To configure logon requirements, you must belong to an access class that g
Edit access to Security Administration.

Getting there  CallPilot System > Messaging Administration > Security Administration 
> General tab
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To configure mailbox access controls

1 To let users access their mailboxes from external phonesets, make sure the 
External logon check box is checked.

2 In the Per mailbox box, type the number of unsuccessful logon attempts 
that can be made on a mailbox in its lifetime. The default value is 9.

3 In the Per session box, type the number of unsuccessful logon attempts a 
user can make in a single mailbox session. The default value is 3.

Note: For IMAP client types using the IMAP logon command, the invalid 
logon count is increased by 2 instead of 1. To make the Per mailbox and 
Per session attempts less restrictive to these types of clients, set the 
maximum invalid logon attempts to 12 and 4 or 18 and 6 respectively.

To set global mailbox password options

1 In the Prefix box, type the number that precedes the default password.

2 In the Minimum length box, type the smallest number of digits that 
passwords can contain.

3 In the Maximum days permitted between changes box, type the number of 
days that a password is valid before a user must create a new password.

4 In the Expiry warning box, type the number of days before password expiry 
that the user receives an expiry warning.

5 In the Minimum number of changes before repeats box, type the number of 
different passwords users must create before recycling an old password.
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Assigning global restriction/permission lists

Introduction

The global RPL governs the Call Answering, Express Voice Messaging, an
thru-dialing session of all CallPilot system users. 

Supplied RPLs

By default, the supplied RPLs prevent all off-switch dialing. Customize the 
supplied RPLs to meet the requirements of your system.

CallPilot provides the following RPLs:

� On Switch

� Local

� Long Distance 1

� Long Distance 2

Access requirements

To assign the global RPL, you must belong to an access class that grants E
access to Security Administration.

See also
� Chapter 7, “Customizing dialing restrictions and permissions”
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Getting there  CallPilot System > Messaging Administration > Security Administration 
> General tab

To select the global RPL

1 In the Call answering/express voice messaging thru-dial restriction 
permission list box, select the RPL that best describes how strictly you want 
to govern the outcalling activities of your users:

� To prevent all off-switch dialing, select On Switch.

� To prevent all long distance dialing, select Local.

� To prevent all international long distance dialing, select Long Distance 1.

� To allow all off-switch dialing, select Long Distance 2.

2 To view the RPL configuration, click Properties.
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Customizing dialing restrictions and 
permissions

In this chapter
 Dialing restrictions and permissions 72

 Customizing supplied RPLs 75
Administrator’s Guide 71



Customizing dialing restrictions and permissions Standard 1.0

ling 

er a 
cked 
al 

h 

e 
Dialing restrictions and permissions

Introduction

On newly installed systems, all CallPilot features that are capable of outdia
are restricted. This means that digits 0–9 are restricted and no codes are 
permitted. None of these features work until you redefine some of the 
restriction/permission lists and apply the new lists to these features. 

RPLs

An RPL specifies whether a dialing code is permitted or restricted. Whenev
CallPilot feature tries to place a call via the switch, the assigned RPL is che
to see if the call is allowed. Assign RPLs to all CallPilot features that can di
out of the system. 

Global RPLs

Global RPLs apply to all users on the system. They must permit all on-switc
dialing. See “Customizing supplied RPLs” on page 75.

Mailbox class RPLs

RPLs are applied in mailbox classes for the following outdialing features:

� External Call Sender

� Mailbox Thru-Dialing

� Custom Revert

� Delivery to Telephone and Delivery to Fax

� AMIS Open Networking

� Remote Notification

� Fax Printing

� Desktop Messaging (This RPL applies to messages composed from th
Desktop. It is imposed in addition to any other RPLs that apply to the 
message.)
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Application-specific RPLs

For services created with Application Builder, RPLs are assigned in one of 
places.

� For services that include a thru-dial block, the RPL is assigned to the b
in the application.

� For services that include fax select blocks and that allow callback fax 
delivery (enabled within the session profile), the RPL is assigned to the
entire service in the service’s SDN configuration (on the Callback Handl
tab).

Dialing codes

The restriction codes in an RPL set the general dialing rules. Permission co
indicate any exceptions to the rules described by the restriction codes.

Restriction code
A restriction code is a dialing code that CallPilot cannot dial. When CallPilo
requested to call a number or send a message to a number that begins with
restricted code, the call is blocked. Restriction codes can be up to 20 digits

Permission code
A permission code is a dialing code that CallPilot can dial. When CallPilot is
requested to call a number or send a message to a number that begins with
permitted code, the call is placed. Permission codes can be up to 20 digits 

Recommendations for common Voice Messaging features

When you customize your supplied RPLs, consider the Voice Messaging on
your system. This section provides some recommendations for commonly u
Voice Messaging features.

Call Answering/Express Voice Messaging thru-dial
With the Call Answering and Express Voice Messaging features, a caller is 
forwarded to a user’s mailbox to leave a message. At this point, the caller c
dial 0 followed by a number to thru-dial.
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Be very restrictive when assigning an RPL to these features. Select an RPL
allows callers to thru-dial to internal extensions only. Restrict these features
from dialing out to the public network.

Mailbox thru-dial
With Mailbox thru-dialing, once a user has logged on to the mailbox, he or s
can thru-dial to another number by dialing 0, followed by the number.

Mailbox thru-dial is intended for mailbox users, not for external callers. To 
prevent abuse of this feature, allow thru-dialing to on-switch extensions onl

External Call Sender
While listening to a message, a mailbox user can press 9 to place a call to 
sender of the message. Call Sender places the call if the calling line ID (CLID
known and if the assigned RPL permits outcalling to the CLID. 

Plan user groups (mailbox classes and user templates) and assign RPLs to
prevent unwanted charges from Call Sender activity.

Custom revert
Users can define their own custom revert DNs from their phonesets while log
on to their mailboxes (to revert callers to a departmental secretary, for exam
instead of the main switchboard). If a mailbox is compromised, a hacker ca
define the number of a long distance carrier as the custom revert DN.

Plan user groups (mailbox classes and user templates) and assign RPLs to
prevent unauthorized chargeable calls.

Note: If a user needs to revert calls to a long distance number, you can set th
in that user’s profile, because the RPL applies only to the user and changes
from the phoneset.

AMIS Open Networking
If you have AMIS Open Networking, users can compose and send messag
mailboxes on other messaging systems on the open (public) network. This 
openness allows hackers established on your messaging systems to charg
costs to your customer. 

Plan user groups (mailbox classes and user templates) and assign RPLs to
prevent unnecessary AMIS Open Networking calls.
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Customizing supplied RPLs

Introduction

There are four prenamed RPLs on newly installed systems. Initially, the 
restriction codes for these lists are digits 0–9 so that no off-switch dialing is
permitted. 

For some organizations, these four lists are sufficient. Organizations that ha
more complex requirements need additional lists (up to 200). 

Supplied RPLs

CallPilot supplies the RPLs that a typical system requires. Select the one th
you want to apply globally and customize it according to the customer’s nee

On Switch
You can customize this list so that it allows only on-switch numbers to be ca
All off-switch numbers, including local numbers, are restricted. This is the m
secure RPL. Apply it to features when maximum security is required.

Local
You can customize this list so that it allows both on-switch and local numbe
be called, but restricts your long distance and international access codes. T
RPL provides a degree of security since the only off-switch numbers allowed
local.

Note: The Local RPL is the default applied to all mailbox classes. If you do 
customize this RPL before you try to specify a revert DN, a callback DN, or
MWI DN for users or user groups, the operation fails.

Long Distance 1 and Long Distance 2
You can customize these lists to allow CallPilot to call long distance and 
international numbers. Be cautious about the dialing codes you permit, and
careful about the features to which you apply these less secure lists.
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s Edit 
Access requirements

To customize existing RPLs, you must belong to an access class that grant
access to Restriction Permission Lists.

Getting there  CallPilot System > Messaging Administration > Restriction Permission 
Lists

To customize the On Switch RPL

Note: For most systems, all restriction codes can be removed.

1 Remove unnecessary restriction codes:

a. In the Restriction codes list, hold the Ctrl button and click all numbers 
you need to remove. 

b. Click Remove.

2 Click Save.
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To customize the Local RPL

1 For each permission code you need to add (such as the dialing prefix to get 
an outside line):

a. In the Permission box, type the number (for example, 9).

b. Click Add.

2 Remove unnecessary restriction codes:

a. In the Restriction codes list, hold the Ctrl button and click all numbers 
you need to remove. 

b. Click Remove.

3 Add any restriction codes required to prevent calls to local numbers that 
you do not want users to dial:

a. In the Restriction box, type the number (for example, 9555 to prevent all 
calls to local exchange 555).

b. Click Add.

4 Click Save.

To customize the Long Distance 1 RPL for domestic long distance

1 Add the permission code to allow access to a long distance line:

a. In the Permission box, type the dialing prefix for a long distance line (for 
example, 91).

b. Click Add.

2 For each restriction code required to prevent calls to pay-per-use services:

a. In the Restriction box, type the number (for example, 91900).

b. Click Add.

3 For each restriction code required to prevent overseas calls:

a. In the Restriction box, type the number (for example, 91011).

b. Click Add.

4 Remove unnecessary restriction codes:

a. In the Restriction codes list, hold the Ctrl button and click all numbers 
you need to remove. 

b. Click Remove.
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5 Click Save.

To customize the Long Distance 2 RPL for international long distance

1 Add the permission code to allow access to a long distance line:

a. In the Permission box, type the dialing prefix for a long distance line (for 
example, 91).

b. Click Add.

2 For each restriction code required to prevent calls to pay-per-use services:

a. In the Restriction box, type the number (for example, 91900).

b. Click Add.

3 Add the permission code to allow access to an overseas long distance line:

a. In the Permission box, type the dialing prefix for a long distance line (for 
example, 91011).

b. Click Add.

4 For each restriction code required to prevent calls to countries that are off-
limits to your users:

a. In the Restriction box, type the number (for example, 91011996).

b. Click Add.

5 Remove unnecessary restriction codes:

a. In the Restriction codes list, hold the Ctrl button and click all numbers 
you need to remove. 

b. Click Remove.

6 Click Save.
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Controlling access to administration 
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In this chapter
 Multiple CallPilot administrators 80

 Guidelines for planning access classes 83
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Multiple CallPilot administrators

Introduction

When the CallPilot Administration Client is installed, a system administrator
with Create/Delete access to all system resources is automatically created.

You can create multiple administrator accounts so that administrators can 
specialize in tasks such as maintaining users, performing backups, analyzin
reports, or creating multimedia services.

Access classes

Access classes are a way to specify levels of administrative access to each
program on the system. Once set up, you can assign classes to users who
administer or observe the configuration of your system.

An access class consists of a set of program names (one for each program
CallPilot System tree), each with an associated access level. These levels a
explained in “Access levels” on page 81.

Create access classes to give each administrator access only to those parts
system that relate to his or her role. You can also use access classes to give
only privileges to interested customer staff, such as certain managers.

Default access class for system administrators

The Administrator access class is already assigned to the prepackaged 
Administrator user template. Use this template to create users who have fu
system access.
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Preventing access to administrative information

To prevent users from accessing administrative information, ensure that the
no check mark in the Admin check box of user creation templates that will b
used to add general users to the system. Even if an access class has been
assigned to the template, removing the check mark prevents it from being 
applied.

Applying access classes

After you create an access class, assign it to a user template. Then, when 
add a user to the system with the template, the user becomes a member of
access class specified in the template. If a user’s job requirements change,
can assign or reassign the user to the access class that gives only those 
administrative privileges required.

See also
� Chapter 9, “Adding a mailbox user group”

Access levels

Access levels determine a user’s ability to interact with CallPilot programs. 
can assign one of six access levels to a CallPilot program.

Create/Delete 
Users can add, remove, and change the information stored by a program.

Create/Delete mailbox users only
Users can add, remove, and change only mailbox user information. Users w
this access level cannot create user templates with administrative capability
user sees the administrative capability as read-only information.

Edit 
Users can change the information stored by a program, but they are not allo
to add new information or delete existing information. 

Edit mailbox users only
Users with this access level can change mailbox user information only. They
view but not change the administrative capability assigned to a user templa
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itted 

View
Users can look at the information stored by a program, but they are not perm
to add, remove, or change information.

None
Users cannot access any administration program information.
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Guidelines for planning access classes

Introduction

Use an access class to define a set of privileges for a particular type of 
administrator. Administrators whose accounts are created using the same a
class belong to the same administrator group. Name each access class aft
administrator group.

Never assign access classes to general users who have no need for adminis
information or capability.

Defining a set of access classes for an organization

Before creating access classes, identify the various types of users that requ
access to administrative programs. Based upon their roles, determine 

� the programs each group needs to access 

� the access level the group needs for each program

Example
If the CallPilot system is completely set up by the distributor, and then turne
over to a customer for routine administration, access classes are required f
following people:

� distributor project manager

� distributor project analyst

� distributor switch technician

� customer security administrator

� customer user administrator

� customer telecom manager

Note: This example is not complete or comprehensive.
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te

 

Administrator group Required programs Access level

Distributor project manager All programs Create/Delete

Distributor project analyst Access Classes Create/Dele

Service Directory Number Create/Delete

User Creation Templates Create/Delete

Distributor switch technician Alarm Monitor Create/Delete

Serial Ports Edit

Switch Resource Edit

System Configuration Edit

Customer security administrator Alarm Monitor View

Connected Sessions Create/Delete

Saved User Searches Edit

Security Administration Edit

Customer user administrator AutoAdd Create/Delete
mailbox users 
only

Saved User Searches Edit mailbox 
users only

User Creation Templates View

Users Create/Delete
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Configuring access classes

Introduction

Create an access class to specify 

� the administrative programs to which a specific administrator type has 
access

� the level of access allowed to each program

Create the appropriate access classes before adding new administrative us
your system.

See also
� “Multiple CallPilot administrators” on page 80

� “Guidelines for planning access classes” on page 83

� “Customizing settings for a user group” on page 99

� “Changing access to administrative programs” on page 159

� “Cloning an existing template” on page 282

Before you begin

Before modifying an access class, view a list of the users assigned to it. Be
creating access classes, identify the various types of users in your compan
the levels of access they require to perform system administration. See 
“Guidelines for planning access classes” on page 83.

Access requirements

To view access class information, you must belong to an access class that 
View access to Access Classes.

To create, delete, or rename an access class, you must belong to an acces
that grants Create/Delete access to Access Classes.
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Getting there  CallPilot System > User Administration > Access Classes

To view the users assigned to an access class

Note: You cannot assign users to an access class from the Access Classes
window. See “Changing access to administrative programs” on page 159.

1 Click the name of the access class that you want to view.

2 On the File menu, click Properties.
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3 Click the Members tab.

Note: To sort the list, click a column heading.

4 Click Save.

To rename an access class

1 Click the access class you want to rename.

2 On the File menu, click Properties.

3 On the General tab, edit the name in the Name box by typing a more 
appropriate name for the access class.

Example: Change User Accounts to User Maintenance.

4 Click Save.
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To create an access class

1 On the File menu, choose New.

2 Under the General tab, in the Name box, type a name for the access class.

3 Click the Access tab.

4 For each program:

a. In the Item in system window list, select a program.

b. In the Level of Access list, select the access level you want to assign to 
the administrator group.

5 When you are finished, click Save.
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To delete an access class

Note: Before deleting an access class, you must assign its users to a new a
class. You also need to specify a new access class for any user templates 
associated with the obsolete access class.

1 Select the access class you want to delete.

2 On the File menu, click Delete.

Result: A confirmation dialog box appears.

3 Confirm that you want to delete the selected access class by clicking OK.
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Adding a mailbox user group

In this chapter
 Overview of User Creation Templates 92

 Overview of the AutoAdd feature 95

 Customizing settings for a user group 99

 Adding a group of users all at once 104
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Overview of User Creation Templates

Introduction

User Creation Templates facilitate the creation and maintenance of large 
numbers of mailbox users. 

Create a user template to configure the common capabilities required by ea
group of users. For example, salespeople can require a certain feature setu
while clerical staff and administrators require a different setup. 

After you create a set of templates, use them to add user mailboxes to the 
system—either as individuals or in groups.

When you configure the settings in a template, those settings appear as de
for any new user mailbox that you create with that template. You can then fi
the user’s name, mailbox number and password, and make changes to the d
feature settings if desired.

Relationship between mailbox classes and user creation templates

For the supplied mailbox classes and supplied local mailbox user creation 
templates, there is a one-to-one correspondence between the two. 

Examples

� The Regular User mailbox class corresponds to the Regular User temp

� The Executive User mailbox class corresponds to the Executive User 
template.

A graphical representation looks like this:

Regular User 
Mailbox Class

Regular User 
Template

Executive User 
Mailbox Class

Executive User 
Template
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Users are not linked to templates after creation

The template is a starting point for creating the user. After you create a use
there is no link between the template and the user. If you create a user and
change the settings in the template, this does not affect the settings for the
already-created user.

Types of users

There are three types of CallPilot users: local users, directory entries, and re
users. This chapter focuses on local users. 

See also
� Part 3, “Extending system functionality”

Local users

A local user can have all the capabilities offered to a mailbox. These capabi
include various greetings, messaging and call answering, and multiple DNs.
majority of users on your system are local users.

Supplied Local User templates

CallPilot provides prepackaged Local User templates. When you first set up
your CallPilot system, decide which of the supplied templates you need and
customize them to suit your needs. You can use the following six templates
create various local users:

� Administrator Template

� Assistant Template

� Basic Users Template

� Executive Users Template

� Fax Buffering Mailbox Template

This template lets you create a fax-capable mailbox for a fax machine.
more information, see Part 3, “Extending system functionality.”

� Regular Users Template
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What are capabilities?

The term capabilities refers to the set of system functions a user has permi
to access. In CallPilot, you can assign two kinds of capability. 

Administrative capability
Administrative capability, which means the user has some level of access to
Administrative Client programs, is reserved for users who administer the 
system. Most users do not require this capability. 

Administrators can have varying levels of access to administer programs on
system, depending on the access class to which they belong.

Mailbox capability
Mailbox capability means the user has a mailbox and can use the mailbox’s
messaging options. Most or all users require mailbox capability. 

A mailbox class is associated with each template

Each prepackaged template is also associated with a prepackaged mailbox
of the same name. For example, the Executive mailbox class includes addit
messaging capabilities; it is the default user class for the Executive templat
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Overview of the AutoAdd feature

Introduction

In CallPilot, a user represents one person who needs to interact with the sy
as an administrator, a mailbox user, or both. 

The AutoAdd feature provides a quick way to add many users who share th
same mailbox capabilities, such as students in a university dormitory. Selec
create a user template (or set of user templates), and then use the AutoAdd
feature to translate a data file that contains unique user information, such a
user’s name and mailbox number, into new users. After you create a user, y
can change any of the preconfigured settings provided by the template.

Note: You cannot use this feature to create directory entries or remote user

Password prefix

To avoid problems using the AutoAdd feature, either define a security passw
prefix or ensure that the data file does not contain a trivial password. 

The system validates the mailbox password when a user is added. The pas

� cannot be the same as the mailbox number

� must have a minimum length defined in the Security profile

If the password is not one of the input parameters from the source data file
system generates a password automatically by attaching the security prefix 
user’s mailbox number. This automatic generation fails if the security prefix 
mailbox number together do not meet the minimum password length.

For more information, see “Security password requirements” on page 97.

The AutoAdd log file

The AutoAdd feature records in a log file all problems with the data file. The 
file lists all successful and unsuccessful additions. Use the log file to 
troubleshoot the data file.
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Template requirements

All the users you create at once share the same feature configuration, beca
the new users are all based on the same template. You must create the tem
before you begin. If you do not have a template that is appropriate for your 
purposes, see Chapter 21, “Adding user creation templates.”

You can inspect a read-only version of the template to confirm that the setti
are appropriate for the users you are creating. If the template is not approp
create a new template or modify an existing one, before you proceed.

You cannot change these values in the template during the AutoAdd proced
but after the users are created, you can change any configuration details—e
Volume ID—on an individual basis.

Distributing users across more than one volume

When you use the AutoAdd feature, you base an entire group of users on t
same template. That means that all users have the same Volume ID; their 
mailboxes reside on the same volume on the hard drive. 

If you create too many users with the same Volume ID, the volume on the h
drive can run out of storage space. Limit the number of users that you add t
same volume. 

To automatically distribute users across volumes during a single AutoAdd 
operation, enable the utility to automatically distribute mailboxes across 
volumes in the user creation template that defines mailbox and administrati
capabilities for the new users. 

To manually distribute users across volumes, divide large groups of users in
smaller groups and perform AutoAdd on the smaller groups, changing the 
Volume ID in the template each time. This way you spread the users across
hard drives.

See also
� “To add or change default mailbox capabilities” on page 100
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Security password requirements

When you use the AutoAdd feature, ensure that either the input data file con
valid mailbox passwords or the Security prefix is defined. You can do this in 
of the following ways:

� Use a mailbox password from the data file. 

The mailbox password defined in the data file must not be trivial (for 
example, the same as the mailbox number or consecutive numbers, su
1234). Additionally, the minimum password length must be defined in 
Security Administration.

� Use a system-generated mailbox password. 

The password prefix must be defined in Security Administration. The 
prefix and mailbox number together must meet the minimum password
length. For more information, see Chapter 6, “Configuring mailbox 
security.”

Attention
If a Security password prefix is not defined, or if the data file contains a 
password that cannot be validated by the system, the AutoAdd feature fails
create users.

Data file requirements

The data file provides the raw data for each new user that you create. This 
includes unique user information, such as names or mailbox numbers. The
file is in ASCII format and lists user field values separated by commas or ta
Each line ends with a carriage return.

Every line of the data file must have the same number of columns, and the 
following fields must be represented in the columns: 

� First Name

� Last Name

� Mailbox Number

You can add additional columns and information, as in the “Example data file 
format” on the next page.
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Note: You might need to set up the conversion process so that the mail syst
overlooks parameters in the data file that do not apply or that are irrelevant 
mail users. For instructions, see “To add multiple members to a user group” on
page 106.

Example data file format
In the data file, each user’s values occupy an entire line. A carriage return 
separates each line, as shown in the following example:

Naoko,Kusaka,9T66,6237
Piedro,Ramirez,9T66,6195
Cathy,Travell,9T44,7738

Data file values are matched up with CallPilot user values
You must associate the values from the data file with CallPilot user values s
that they are in one-to-one correspondence.  

CallPilot user fields Data file element

First Name Naoko
Piedro
Cathy

Last Name Kusaka
Ramirez
Travell

Department

Note: This field must be added to the 
list of CallPilot user fields on the 
AutoAdd dialog box.

9T66
9T66
9T44

Mailbox Number 6237
6195
7738
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Customizing settings for a user group

Introduction

To customize settings for a user group, modify the property sheets of the us
creation template to be applied to group members. Fill in the remaining field
when you create a user based on the template.

Access requirements

To modify properties for an existing user group (user creation template), yo
must belong to an access class that grants Edit access to User Creation 
Templates.

See also
� “Adding a group of users all at once” on page 104

� Chapter 8, “Controlling access to administration programs” 

� Chapter 10, “Configuring mailbox capabilities for a user group” 

Getting there  CallPilot System > User Administration > User Creation Templates
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To open an existing template for modification

From the File menu, select Properties.

To add or change default mailbox capabilities

1 Open a user template and make sure there is a check mark in the Mailbox 
Capabilities check box.

2 Specify the default Mailbox Class (see page 101). 

3 Set up the Revert DN (see page 102).

4 Configure the default messaging options (see page 103).

5 Click Save.

ATTENTION To change a template, you must open the template 
properties sheet. When you double-click a template name 
to open it, you are adding a new user to the user group.
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To assign a default mailbox class

1 Click the Mailbox tab.

2 In the Mailbox class list, select the mailbox class appropriate for the group.

3 For users who prefer another language: From the Language list, select the 
preferred language for mailbox prompts.

Note: The user hears the primary language after he or she logs on to the 
mailbox. 

4 Specify whether the new mailboxes are to be stored on a specific volume or 
automatically distributed across volumes:

� To distribute users proportionately across volumes, ensure there is a 
check mark in the Automatic distribution of mailboxes across volumes 
check box.

� To define the volume on the hard drive where the system stores the user 
data for users created with this template, from the Volume ID list, select 
the desired volume number. 

Note:  You cannot change this volume later in User Administration.
Administrator’s Guide 101



Adding a mailbox user group Standard 1.0

ey 
as not 
ult. 
To specify the default revert DN for a user group

Note: A revert DN is the common DN to which callers are forwarded when th
press 0 on the phoneset keypad. If the RPL assigned to the mailbox class h
been modified, you cannot specify the revert DN. The Local RPL is the defa

1 Click the DNs tab.

2 Type the DN of the receptionist or departmental administrative assistant in 
the Revert DN box.

See also
� “Customizing supplied RPLs” on page 75
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To specify default messaging options for a user group

1 Click the Set Up tab.

2 Specify the messaging options for the user group. To learn more about a 
specific field, use the context-sensitive Help.

3 To define the type of messages that will trigger the flashing light on a user’s 
phoneset, select an option from the Message waiting indication options list.
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Adding a group of users all at once

Introduction

Use the following procedures to add a group of users based on the same 
template, to a CallPilot system.

Note: If the data file you select includes users that are already on the system
CallPilot does not add, overwrite, or duplicate the existing record. For an 
explanation of why users are not added, display the log file, which is a text 
located in the same directory as the selected data file.

Before you begin

Ensure that you are aware of the password requirements outlined in “Overview 
of the AutoAdd feature” on page 95.

Access requirements

To add users to a user group, you must belong to an access class that gran
either Create/delete or Create/delete (mailbox users only) access to Users.

To add a group of users to the CallPilot system

1 Identify or create the ASCII file that contains the raw user data (see “Data 
file requirements” on page 97 and “To create a data file” on page 105).

2 Ensure that you have the required user templates (see “To identify the 
required user templates” on page 105).

Attention: Ensure your template contains the appropriate feature 
configuration for your users. If you want to distribute your users across 
more than one volume, ensure that the utility to automatically distribute 
users across volumes is enabled.

3 Use the AutoAdd feature to convert the data in the ASCII file to CallPilot 
data (see page 106).
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To create a data file

You can create a data file containing lists of user information from a variety 
sources. For example, you can create the data file manually, using a word 
processor or a text-editor application. You can also create the data file by 
extracting a flat file from a database of individuals or from a spreadsheet.

Tip:  To help you set up the AutoAdd operation, print the file so that you can
easily identify the position of each column of information.

To identify the required user templates

1 From the User Administration User Creation Templates list, select the 
template for this user group.

2 Click View details to see the contents of the template.

Note: If the current one is not correct, select another template.

3 Decide which template best meets your requirements.

4 Determine whether the template needs to be modified or cloned. See 

� “Customizing settings for a user group” on page 99

� Chapter 21, “Adding user creation templates”

5 Close the template to return to User Administration.
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Getting there  CallPilot System > User Administration > AutoAdd

To add multiple members to a user group

1 In the AutoAdd dialog box, click Browse.

2 In the Browse window, find the path to your data file.

3 Click the data file and then click Open.

4 In the Template box, select the user template to provide the configuration 
for all the new users.

1 For each field name that has a corresponding value in the data file:

a. Click the CallPilot user field name to select it.

b. Click Add to include it in the File columns box.

2 For each data file element that you do not want to include as CallPilot 
information:

a. In the CallPilot user fields list, click <Ignore>.

b. Click Add to include <Ignore> in the File columns box.
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3 For each entry in the File columns box that does not correspond to any data 
in the data file, you must remove the entry:

a. In the File columns box, select the file column you want to delete.

b. Click Remove to delete the file column.

4 Ensure that the order of the field names and <Ignore> entries in the File 
columns box matches the order in which the data appears in the data file. 
Use the Move Up and Move Down buttons to rearrange the order of the 
field names and <Ignore> entries.

5 Click Run.

Result: The AutoAdd dialog box displays the user data as the program 
interpreted it.

6 Verify that the user data is properly classified.
Administrator’s Guide 107



Adding a mailbox user group Standard 1.0
7 Click Continue and wait a few seconds while the new members are added 
to the user group.

Result: AutoAdd creates a log file that displays the results of the operation.

8 If the results showed that the operation failed, open the log file in any text 
editor and view the error messages. The error log is created in the same 
folder as the user data.
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Configuring mailbox capabilities for a 
user group

In this chapter
 Mailbox classes and user groups 110

 Configuring mailbox storage capacity 112

 Configuring dialing restrictions and permissions 114
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Mailbox classes and user groups

Introduction

A mailbox class is a way to define messaging capabilities for a group of use

To have any mailbox capabilities, a mailbox user must have a mailbox that 
belongs to a mailbox class. 

Use mailbox classes to

� adjust mailbox storage capacity for a user group

� adjust dialing restrictions and permissions for user groups

Mailbox Classes versus Class of Service (COS) on the switch

Do not confuse the CallPilot mailbox class feature with Class of Service on
switch. Class of Service on the switch applies certain dialing restrictions to li
sets, or trunks, not to CallPilot features. 

Ready-to-use mailbox classes

CallPilot provides mailbox classes that correspond to the supplied user cre
templates. For example, the Basic User mailbox class is assigned to the Ba
User Template.

The ready-to-use mailbox classes are organized into the following groups:

Mailbox class Description

Regular Users Satisfies the common requirements of most users in a
typical office.

Note: If you create a new mailbox class, the default value
are the same as the original Regular Users class.

Executive Users Supports executives and other users who require large
storage space and message backups, and advanced 
messaging features.
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Default mailbox class dialing restrictions and permissions

By default, the Local restriction/permission list (RPL) is assigned to all supp
mailbox classes. To let a user group dial long distance, or to restrict a user g
to on-switch dialing, assign a different (already customized) RPL to the mail
class that is assigned to the user group.

See also
� “Customizing supplied RPLs” on page 75

� “Overview of User Creation Templates” on page 92

Assistants Supports administrative assistants who require modera
storage space and backups, and the ability to circulate 
messages on behalf of executive users.

Basic Users Supports infrequent users of messaging features.

Fax Buffering Mailbox Intended exclusively for fax machines that require buffe
that have a maximum storage of new messages but als
minimum retention time of messages.

Administrator Supports system administrators who assess the status
other users on the system.

Mailbox class Description
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Configuring mailbox storage capacity

Introduction

If a particular group of users requires additional capabilities, you do not hav
change each individual user, just the mailbox class. Each user assigned to 
mailbox class automatically acquires the changes.

Access requirements

You must belong to an access class that grants Edit access to Mailbox Clas

Getting there  CallPilot System > User Administration > Mailbox Classes > Mailbox tab

To define storage limits and rules

1 In the Voice storage limit box, type the total number of voice message 
minutes that users can store.

Note: You can specify the limit in minutes, pages, or multiples of 10 Kbytes.
112 CallPilot



April 2000 Configuring mailbox capabilities for a user group

ngth.
2 To force the system to delete old voice messages, ensure there is a check 
mark in the Delete read messages (voice) box.

3 In the associated after ____ days box, type the number of days that the 
system keeps read voice messages before deleting them.

4 To force the system to delete old fax messages, ensure there is a check 
mark in the Delete read messages (fax) box.

5 In the associated after ____ days box, type the number of days that the 
system keeps read fax messages before deleting them.

6 To prevent a caller from leaving a message when a mailbox is full, ensure 
there is a check mark in the Block call answering when mailbox is full box. 

Note: This does not block system-generated messages, such as system 
delivery notification and alarms or broadcast messages.

7 To keep a copy of a composed and successfully sent message after 
completing a messaging session, ensure there is a check mark in the 
Retain copy of sent messages box.

8 To let users define the DN to which callers will be forwarded when they 
press 0 during a call answering session, ensure there is a check mark in 
the Revert DN set by telset box.

To define the maximum message lengths

1 In the Max composed message length box, select the longest length (in 
minutes and seconds) for a message that mailbox users can compose and 
send.

2 In the Max call answering message length box, select the longest length (in 
minutes and seconds) for a message that callers can leave during a Call 
Answering session.

Note: The Voice Storage Limit time must be greater than the Maximum 
Composed Message Length and the Maximum Call Answering Message Le
Administrator’s Guide 113



Configuring mailbox capabilities for a user group Standard 1.0

t a 
o the 

ses.
Configuring dialing restrictions and 
permissions

Introduction

By default, the Local RPL is assigned to all supplied mailbox classes. To le
user group dial long distance, assign a different (already customized) RPL t
mailbox class that is assigned to the user group.

Access requirements

You must belong to an access class that grants Edit access to Mailbox Clas

Getting there  CallPilot System > User Administration > Mailbox Classes > RPLs tab
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To allow a user group to make long distance calls

1 In the Mailbox thru-dialing list, select either Long Distance 1 or Long 
Distance 2, depending on how you have customized those RPLs.

2 When you finish configuring the mailbox class, click Save.
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Creating and maintaining shared 
distribution lists

In this chapter 
 Guidelines for creating an SDL 118

 Configuring SDLs 120

 Modifying an existing SDL 123

 Deleting an SDL 127

 Documenting an SDL 128
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Guidelines for creating an SDL

Introduction 

SDLs allow users to send messages to a group of mailbox users. There are
storage capacity restrictions based on the number of members on the list an
size of the distributed message.

Impact of Networking on SDLs

To include a remote user site in an SDL, you must define the site and locati
your messaging network, and have Networking installed.

To include users at remote sites in a CallPilot network, you must define the
remote voice users in the local database. The following types of numbers d
have mailboxes associated with them and, therefore, cannot be included in
SDL:

� remote notification (RN) targets

� nonusers who require Delivery to Telephone (DTT)

Restrictions on distribution lists

The following restrictions are placed on distribution list numbers:

� An SDL cannot be assigned a number 1–99. These numbers are reser
for PDLs.

� Each SDL must have a unique distribution list number.

� An SDL number must not conflict with any dialing plan prefixes or code

� An SDL number cannot be the same as any mailbox number, including
broadcast mailbox number. The default broadcast mailbox number is 5

� An SDL number cannot be the same as a directory entry user’s DN. If 
SDL number and a directory entry user number are the same, the SDL
number takes priority when a list is created.

� An SDL cannot be nested inside another SDL.
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Number of addresses

A single message can be sent to 500 addresses. 

Note: Each SDL is one address, regardless of the number of entries on the
Each entry on a PDL is one address. Therefore, an SDL with ten entries is 
address, while a PDL with ten entries is ten addresses.

Dealing with multimedia messages

Users can send multimedia messages with an SDL. Users can assume tha
internal numbers all have voice- and fax-receiving capabilities.

However, you cannot assume that external numbers can receive multimedia
messages. Create an SDL of external phone numbers for voice messages 
second SDL of external fax numbers.

See also

� information about address capabilities and distribution lists in the Desktop 
Messaging Installation and Configuration Guide
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Configuring SDLs

Introduction

CallPilot users can address a voice, fax, or multimedia message to multiple
recipients. 

Access requirements

To create a new SDL, you must belong to an access class that grants Crea
delete access to Shared Distribution Lists.

See also

� “Guidelines for creating an SDL” on page 118

Getting there  CallPilot System > User Administration > Shared Distribution Lists
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To create and configure an SDL

1 To create and label the new SDL, follow these procedures.

a. “To create and label the SDL” on page 121

b. “To record a spoken name for the SDL” on page 122

2 To add users to the SDL, choose from the following methods:

� “To generate a list of users to add (in whole or in part)” on page 124

� “To add a local user whose Callback DN or mailbox number is known” 
on page 125

� “To create a remote user and add him or her to the SDL” on page 126

� “To create a directory entry and add it to the SDL” on page 126

To create and label the SDL

1 From the File menu, select New.

Result: The Properties dialog box appears.

2 In the Name box, type a unique name for the SDL.

3 In the Address box, type the unique access number for the SDL.

4 In the Comments box, type an optional description of the SDL.
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To record a spoken name for the SDL

1 Click Record.

Result: The Specify Phoneset dialog box appears.

2 In the Enter a phone number box, type the phone number of the phoneset 
you want to use for recording.

3 Answer the phoneset when it rings.

Result: The Voice Recorder dialog box appears.

4 Click Record.

5 Speak an appropriate name for the distribution list into the phoneset.

6 Click Stop to stop the recording.

7 To listen to the recorded title, click Play.

8 When you are satisfied with the recorded title, click Done.
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Modifying an existing SDL

Introduction

The procedure to add users to an existing SDL depends on both the type o
and the method you will use to add the user.

Adding a user by using the callback DN or mailbox number

You can add a user who is not in the list of users to the SDL if you know tha
user’s mailbox number or callback DN. This option is useful if you generate
list of users with the search mechanism, and you then wish to include addit
users who were not included in the generated list but who should be in the 

Requirement
You must belong to an access class that grants Edit access to Shared Distri
Lists.

Creating a CallPilot Remote User or directory entry to add to the SDL

If you want to add a CallPilot Remote User (a user at another networking 
location) to the SDL, but that user has not yet been added to the database 
remote user, you can do both at the same time.

If you want to add a directory entry user to the SDL, but that user has not y
been added to the database, you can do both at the same time.

Note: Although a directory entry has no mailbox, it receives a message from
SDL in the same way as the Delivery to Telephone message is received by p
numbers that are not on the system.

Access requirements
You must belong to an access class that grants 

� View or Edit access to User Creation Templates

� Create/delete or Create/delete mailbox users only access to Users

� Edit access to Shared Distribution Lists
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Getting there  CallPilot System > User Administration > Shared Distribution Lists > 
SDL Properties sheet

To generate a list of users to add (in whole or in part)

1 Click Search Users. 

Result: The Search Users dialog box appears.

2 Enter the search criteria and run the search.

3 For each local user mailbox you want to add to the SDL:

a. In the Users to add box, click the user name.

b. Click Add.
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4 To add all the users from the generated list to the SDL, Click Add all.

5 For each user that you want to delete from the SDL:

a. In the Distribution list contents box, click the user name.

b. Click Remove.

6 When the distribution list is completed, click Save.

See also
� “Specifying criteria and performing a search” on page 134

To add a local user whose Callback DN or mailbox number is known

1 Click Add user.

Result: The Add a user to distribution list dialog box appears.

2 If you know the user’s mailbox number, click the Mailbox number button, 
and type the number into the box beside it.

3 If you know the user’s Callback DN, click the Callback DN button, and type 
the DN into the box beside it.

4 Click Save to add the user, and return to the Properties tab.
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To create a remote user and add him or her to the SDL

1 Click the New remote user button for the selected user to appear in the 
Distribution list contents box.

2 In the First name box, type a first name for the user.

3 In the Last name box, type a last name for the user.

4 To include extra information to identify the remote user more easily when 
administering the system, in the Comments box, type the information.

5 In the Department box, type the name of the user’s department. 

6 In the Title box, type the user’s business title.

7 To configure the mailbox settings for this remote user, follow the procedure 
in “To create a directory entry and add it to the SDL” below.

To create a directory entry and add it to the SDL

Note: Both the first name and last name are required.

1 Click New directory entry.

2 In the First name box, type a descriptive name that identifies the phoneset’s 
users or its location (for example, Technical Services).

3 In the Last name box, type a descriptive name that identifies the phoneset’s 
users or its location (for example, Boardroom).

4 Type any extra information in the Comments box.

5 To configure the settings for the new directory entry user, follow the 
procedure “To define mailbox settings for a directory entry” on page 186.
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Deleting an SDL

Introduction

Delete an SDL that you no longer need.

Access requirement

You must belong to an access class that grants Create/delete access to Sh
Distribution Lists.

Getting there  CallPilot System > User Administration > Shared Distribution Lists 

To delete an SDL

1 Select an existing distribution list.

2 On the File menu, select Delete.

Result: A dialog box appears, asking you to confirm the deletion.

3 Click Yes to delete the list.
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Documenting an SDL

Introduction

Print the contents of an SDL when you want a hard copy of all the settings.
can also print a list of all the SDLs on the system.

Getting there  CallPilot System > User Administration > Shared Distribution Lists

To print a list of all SDLs

1 Ensure that no individual SDL is highlighted.

2 On the File menu, select Print.

Result: The Windows Print box appears.

3 Make any necessary adjustments to the print setup and click OK.

To print the contents of an SDL

1 Select an SDL.

2 On the File menu, select Properties.

Result: The Windows Print box appears.

3 Make any necessary adjustments to the print setup and click OK.
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Frequently performed
administrative tasks

In this part
Chapter 12: Searching for users 131

Chapter 13: Enabling and disabling mailbox access privileges 141

Chapter 14: Moving a user to a different user group 153

Chapter 15: Adding and deleting users and directory entries 161
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Searching for users

In this chapter
 Overview 132

 Specifying criteria and performing a search 134

 Modifying and reusing your latest user search 137

 Saving a user search 138

 Using a saved user search 139

 Deleting a saved user search 140
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Overview

Introduction

You can use the CallPilot User Search feature to create, save, and reuse se
criteria. 

Saved user searches

Your set of saved user searches includes some that are supplied with your 
CallPilot system. Supplied user searches include All Users, Password Expi
Locked Out, and Remote Users.

Wildcards

Use wildcards in the value statement when 

� you are searching for a range 

For example, if you are interested in all users with last names beginnin
with the letter S, select Last Name from the Search Criteria list and type
in the Value box.

� you are searching for user last names you are not sure how to spell 

For example, if you know the user’s last name begins with Sm, then typ
Sm* in the value box. The search produces a sublist of users with last 
names that begin with Sm (for example, Smilla, Smith, Smothers, Smy

Placeholders

A placeholder is a special character that represents any single character. T
CallPilot placeholder character is the question mark (?). If you include a 
question mark in your value statement, the search function might find more
matching records than without the question mark. For example, if you type 
“J??n” in the value box with the search criteria set to First Name, the search
produce a sublist of users with the first names John and Joan. However, it w
not include Johann, because this name has too many letters.
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Common user searches

The following are examples of common searches:

See also
� “Specifying criteria and performing a search” on page 134

� “Modifying and reusing your latest user search” on page 137

� “Saving a user search” on page 138

� “Using a saved user search” on page 139

� “Deleting a saved user search” on page 140

Search criteria Result

Last Name is Smith Retrieves a sublist of all users named Smith

Last Name is Sm* Retrieves a sublist of all users with last name
beginning with Sm

Title is Manager Retrieves a sublist of all users who are manag

Title is NOT Manager Retrieves a sublist of all users who are not 
managers

Department = Human 
Resources

Retrieves a sublist of all users who are membe
of the Human Resources department

Password retry count > 1 Retrieves a sublist of all users who entered 
incorrect user ID and password more than onc
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Specifying criteria and performing a search

Introduction

The Search Users window lets you specify up to three search criteria that a
based on the information stored in the CallPilot system. 

Broadening a user search

If you cannot find the user(s) you are looking for, you can widen the scope 
your search. A wider search increases the number of matches your search
produces.

Example 
In your system, some users are Shift Managers. Some users are Departme
Managers. You know that your target user is one or the other. 

To view a list that contains both types of managers, search for User Title = S
Manager OR User Title = Department Manager.

Restricting a user search

Your first search might bring back too many users that match your criteria. T
reduce the number of matches found in a search, reduce the scope of your
search. 

Example
There are 30 users named Smith in your system. The Smith you need to fin
manager. 

To find the manager named Smith, search for Last Name = Smith AND Title
manager.

Access requirements

To create and execute a user search, you must belong to an access class t
grants View access to Users.
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Getting there  CallPilot System > User Administration > Users > Search Users

To create the search

1 Beside Search for users that meet, click a button to choose the type of 
search.

� All conditions means that only users who meet all the conditions set in 
your search will be included in the search results.

� At least one condition means that a user only needs to meet one of the 
conditions set in your search to be included in the search results.

2 From the Search Criteria list, select the search criteria.

3 From the Operator list, select an appropriate operator.

4 From the Values list, enter or select an appropriate value.

Note: Based on the search criteria you select, you can enter a value in the 
Value box or select from a list of values generated by the Value box.

5 From the Select View list, select an appropriate view.

Note:  The view determines the user information that is listed when a user 
search is completed. The General view shows general information about 
the user (for example, his or her title, department, and name). The 
Administrative view shows the user’s administrative capabilities (for 
example, his or her password retry count and access class). The 
Messaging view shows the user’s mailbox capabilities (for example, 
mailbox class or the Target Number for a paging device).
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To broaden the search

1 Click At least one Condition. This means that a user only needs to meet 
one of the conditions set in your search to be included in the search results.

2 In the second row, fill in the Search Criteria, Operator, and Value fields to 
add a second condition for your search.

3 If desired, fill in the fields of the third row to add a third condition for your 
search.

4 From the Select View list, select an appropriate view.

To restrict the search

1 Click All conditions. This means that only users who meet all the conditions 
set in your search will be included in the search results.

2 Review your search criteria to ensure that none of the conditions conflict 
with one another.

3 From the Select View list, select an appropriate view.

To perform the search

Click Search Now.

Result: The Users window appears, showing the results of the user search.
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Modifying and reusing your latest user search

 Introduction

If you want to modify the search (for example, widen or narrow the scope), 
can retrieve your most recent search criteria settings using the Open Searc
menu command.

You must have already specified at least one set of search conditions and ru
search. If you have not, see “Specifying criteria and performing a search” on 
page 134.

Access requirements

To retrieve your latest search, you must belong to an access class that gran
View access to Users.

Getting there  CallPilot System > User Administration > Users 

To retrieve your latest user search

On the File menu, click Open Search.
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Saving a user search

 Introduction

If you search for a specific group of users regularly, save the search criteria
reuse. 

Access requirements

To save user search criteria for reuse, you must belong to an access class 
grants Create/delete access to Saved User Searches.

Getting there  CallPilot System > User Administration > Users > Search Users

To save a user search

1 Specify your search criteria (see “To create the search” on page 135).

2 Click Save Search.

3 In the Name box, type a name for the search.

4 Click OK.

See also
� “To create the search” on page 135

� “Using a saved user search” on page 139
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Using a saved user search

Introduction

You can run a saved user search as is, but you cannot modify it before you 

Access requirements

To run a saved user search, you must belong to an access class that grants
access to Saved User Searches.

Getting there  CallPilot System > User Administration > Saved User Searches

To run a saved user search

Double-click the name of the saved search you want to run.

Result: The Users window appears, displaying the results of your search.
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Deleting a saved user search

Introduction

If the criteria specified in the saved search become obsolete, you can remov
search from the system.

Access requirements

To delete a saved user search, you must belong to an access class that gra
Create/delete access to Saved User Searches.

Getting there  CallPilot System > User Administration > Saved User Searches

To delete a saved user search

1 Click the saved search you want to delete. 

2 On the File menu, click Delete.

Result: A confirmation dialog box appears, asking you to confirm the 
deletion.

3 Click Yes.
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Enabling and disabling mailbox 
access privileges

In this chapter
 Overview 142

 Reenabling a disabled mailbox 143

 Resetting a user’s mailbox password 144

 Enabling or disabling Autologon to a mailbox 146

 Disabling and restoring a user’s access to administrative programs 148

 Resetting a user’s administrative password 150
Administrator’s Guide 141



Enabling and disabling mailbox access privileges Standard 1.0

ave 

lbox 

ides 
Overview

Introduction

Administrators are often asked to help users who are having problems or h
been locked out of their mailboxes.

Common user problems include

� forgotten passwords

� expired passwords

� mailbox lockout after too many failed logon attempts

� difficulty using the phoneset interface to configure features such as mai
Autologon

Some users might have some administrative capabilities. This chapter prov
information for helping mailbox users and administrative program users.

See also
� “Connecting to a CallPilot server” on page 34

� Chapter 12, “Searching for users” 

� information about maintaining CallPilot security in Monitoring and 
Security for the Administrator
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Reenabling a disabled mailbox

Introduction

A mailbox is automatically disabled when it has been unused long enough t
disabled by the system or there are too many consecutive invalid logon atte

Access requirements

You must belong to an access class that grants Edit or Edit (mailbox users 
access to Users.

Getting there  CallPilot System > User Administration > Users > Search Users > 
Security tab

To reenable a user mailbox

1 Select Enabled from the Logon Status box.

2 Click Save.
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Resetting a user’s mailbox password

Introduction

Use this procedure when a user forgets his or her password.

Access requirements

You must belong to an access class that grants Edit or Edit (mailbox users 
access to Users.

Getting there  CallPilot System > User Administration > Users > Search Users > 
Security tab
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To reset the password for a user mailbox

Requirement: You must enter the password as digits (for example, 
“PASSWORD” = 72779673).

1 Click Set password.

2 In the Set password box, type the default password, then type it again in the 
Confirm password box.

3 Click Save.
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Enabling or disabling Autologon to a mailbox

Introduction

When Autologon is enabled by the mailbox user, it allows a caller to 
automatically log on to the mailbox from a DN associated with the mailbox.

An administrator enables and disables Autologon DNs

To allow the user to enable and disable Autologon to his or her mailbox, use
procedure “To enable or disable Autologon DNs for a user mailbox” on page
147. 

The user enables and disables Autologon from a phoneset

For a user to enable or disable Autologon to his or her mailbox, the user mu
logged on to the mailbox. The user presses 8–0 for mailbox options, and th
presses 4 for Autologon. The user can then press 1 to enable Autologon, o
press 2 to disable Autologon.

If no DNs are AutoLogon-enabled in the user’s profile, the user cannot enab
Autologon from a phoneset.

Security feature

To prevent unauthorized access to a mailbox, CallPilot disables Autologon 
all DNs whenever an associated DN is added to the user’s DNs list. The en
DNs remain enabled in the user’s profile, but the user must reenable Autolo
from the phoneset.

Note: If a user complains that Autologon is not working when it has been 
enabled, check for recent changes to the DN list for that user.

Access requirements

You must belong to an access class that grants Edit or Edit (mailbox users 
access to Users.
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Getting there  CallPilot System > User Administration > Users > Search Users > DNs 
tab

To enable or disable Autologon DNs for a user mailbox

1 To enable Autologon for an associated DN, ensure there is a check mark in 
the corresponding Autologon allowed check box.

2 To disable Autologon for an associated DN, ensure the corresponding 
Autologon allowed check box is clear.

3 When you finish configuring user properties, click Save.
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Disabling and restoring a user’s access to 
administrative programs

Introduction

If a user with access to administrative programs fails three times to enter th
correct user ID and password, he or she is locked out of the CallPilot syste
window. 

Note: An administrative user can also be locked out by an administrator with
adequate permissions. Only a user with adequate administrative permission
restore access to a user who has been locked out. 

Access requirements

You must belong to an access class that grants Edit or Edit (mailbox users 
access to Users.

See also
� “Resetting a user’s administrative password” on page 150

� “Changing access to administrative programs” on page 159
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Getting there  CallPilot System > User Administration > Users > Search Users > 
Admin tab

To cancel administrative capability for a user

1 In the tree structure, clear the check box beside Admin Capability.

2 Click Save.

To restore a user’s desktop access

1 Click Restore.

Result: The Restore label changes to Lockout.

2 Click Save.
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Resetting a user’s administrative password

Introduction

If a user forgets his or her system password, you can reset it to the default.

Access requirements

You must belong to an access class that grants Edit or Edit (mailbox users 
access to Users.

Getting there  CallPilot System > User Administration > Users > Search Users > 
Admin tab
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To reset a user’s password

1 Click Reset Password.

Result: A confirmation dialog box appears, displaying the new password 
and asking you to confirm the reset.

2 Click Yes.

3 Click Save.
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Moving a user to a different user 
group

In this chapter
 Overview 154

 Changing a user’s job title or department 155

 Changing a user’s mailbox class 157

 Changing access to administrative programs 159
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Overview

Introduction

When a user changes jobs, move him or her to the user group that has the 
capabilities required for the new job functions. 

Mailbox classes and user creation templates

Each user creation template is associated with a mailbox class. For exampl
Executive mailbox class includes additional messaging capabilities; it is the
default user class for the Executive template.

Special scenarios

Typically, a user does not have to share a phoneset and is the only person 
access to his or her mailbox. A change in job function can necessitate a ch
in this scenario. For example, if the user has new resources, such as an ass
you might change the mailbox configuration of the user and the assistant.

Access to administrative programs

When a user changes jobs, his or her need for access to administrative pro
can change.

See also
� “Multiple CallPilot administrators” on page 80

� “Mailbox classes and user groups” on page 110

� “Customizing a mailbox for a typical user” on page 165

� “Customizing a mailbox for a specific scenario” on page 175

� “Configuring Remote Notification service” on page 250
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Changing a user’s job title or department

Introduction

To support user searches on job title or department, complete the following
tasks:

� Enter the information precisely as it is for others with that title or in that
department. 

� Follow naming conventions that facilitate the use of wildcards and 
placeholders.

Access requirements

You must belong to an access class that grants Edit or Edit (mailbox users 
access to Users. 

Getting there  CallPilot System > User Administration > Users > Search Users > User 
Properties > General tab
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To change a user’s job information

1 In the Title box, type the user’s new job title.

2 In the Department box, type the user’s new department.

3 When you finish modifying user properties, click Save.
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Changing a user’s mailbox class

Introduction

To have mailbox capabilities required for a certain job, a user must have a 
mailbox belonging to the mailbox class that provides the required capabilitie

Mailbox classes determine these aspects for the user group:

� mailbox storage capacity

� dialing restrictions and permissions

Access requirements

You must belong to an access class that grants Edit or Edit (mailbox users 
access to Users. 

Getting there  CallPilot System > User Administration > Users > Search Users > User 
Properties > Mailbox tab
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To change the mailbox class

1 In the Mailbox class list, select the mailbox class used by other users with 
job functions similar to those of the user.

2 When you finish modifying user properties, click Save.
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Changing access to administrative programs

Introduction

If a user who is also an administrator changes his or her position within you
company, you might need to modify his or her access class. You can also g
or cancel administrative access for an existing user through this procedure.

Example
When a manager changes departments he or she performs system mainte
instead of managing users in the system. Change the access class.

Access requirements

You must belong to an access class that grants Edit or Edit (mailbox users 
access to Users. 

Getting there  CallPilot System > User Administration > Users > Search Users > 
Admin tab
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To give administrative capability to a user

1 Click the Admin tab.

2 On the left side of the sheet, click the check box beside Admin Capability in 
the file tree.

3 From the Access Class list, select the user’s administrative access class.

4 When you finish modifying user properties, click Save.

To change a user’s administrative access class

1 From the Access Class list, select the new access class.

2 When you finish modifying user properties, click Save.

To cancel administrative capability for a user

1 On the left side of the sheet, clear the check box beside Admin Capability in 
the file tree.

2 When you finish modifying user properties, click Save.
160 CallPilot



C h a p t e r  1 5

Adding and deleting users and 
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In this chapter
 Adding an individual mailbox user 162

 Customizing a mailbox for a typical user 165

 Customizing a mailbox for a specific scenario 175

 Creating a fax buffering mailbox for a user 182

 Adding a directory entry 185

 Adding a CallPilot user at a remote site to the local system 187

 Providing a spoken name for a user or directory entry 191

 Deleting a user or directory entry 193
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Adding an individual mailbox user

Introduction

Before adding a mailbox to the system, you must have an appropriate user
template. Either create a user template or use an existing template. 

Based on the type of user you are creating (local, directory entry, or CallPilo
Remote User), use one of the following procedures:

� “To add a local user to the CallPilot system” on page 164

� “Adding a directory entry” on page 185

� “Adding a CallPilot user at a remote site to the local system” on page 1

Access requirements

To add a user to the system, you must belong to an access class that grant
Create/delete or Create/delete (mailbox users only) access to Users.

See also
� Chapter 9, “Adding a mailbox user group” (for more information on 

templates)
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Getting there  CallPilot System > User Administration > User Creation Templates
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To add a local user to the CallPilot system

1 Select a template that has capabilities that are appropriate to the user type. 

2 On the File menu, click Add New User.

3 In the First name box, type the user’s first name. In the Last name box, type 
the user’s last name.

4 In the Comments box, type any additional information about the user.

5 Verify the user’s mailbox capabilities, and make changes where required.

6 When you finish entering information, click Save.
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Customizing a mailbox for a typical user

Introduction

The user template provides default values for mailbox features. Once you h
created an individual user, you can modify most of the defaults for the user.
Employ one or more of the following procedures: 

� “To open the User Properties sheet for an existing user” on page 167

� “To view or print the status of the user mailbox” on page 169

� “To modify mailbox capabilities for the user” on page 170

� “To define the DNs associated with the user mailbox” on page 171

� “To specify the user’s RN information” on page 173

Relationship between mailbox number and DNs

A mailbox number can be associated with any or all of the following items:

� up to eight extension DNs

� an MWI DN

� a Callback DN (for Call Sender and Name Dialing purposes)

� a Revert DN

By default, the system assigns the user’s mailbox number to the

� user’s first extension DN

� MWI DN

� Callback DN

You can overwrite any or all of these defaults for a user group (template) or
individual user. 

Typical mailbox configuration

Typically, a user has sole use of a phoneset, does not share the primary DN
another user, and has sole use of the mailbox. For this typical configuration
mailbox number and the primary DN can be the same.
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MWI DN dependencies

Success of the MWI DN configuration depends on switch configuration opti
that vary from one software version to another. 

Note: If the MWI DN options that you configure do not work, refer to the 
Installation and Configuration Guide for your switch or Hot Spare Procedures.

See also

� “Customizing a mailbox for a specific scenario” on page 175

� information about CallPilot Web Messaging, message addressing, mes
playback, hardware requirements and associated software in the Desktop 
Messaging Installation and Configuration Guide

Before you begin

If you do not already have the New User Properties sheet open for the user
must search for an existing user.

Access requirements

To view or print user properties, you must belong to an access class that gr
View access to Users.

To edit properties, you must belong to an access class that grants Edit or E
(mailbox users only) access to Users.
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Getting there  CallPilot System > User Administration > Users

To open the User Properties sheet for an existing user

1 In the Search Users dialog box, enter the appropriate search criteria. 

Note: For more detailed information about searching for a user or group of 
users, see the context-sensitive Help.

2 Click Search Now.

Result: A list of users that meet the search criteria appears.
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3 Double-click a user.

Result: A Properties sheet displays user information.
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To view or print the status of the user mailbox

1 In the User Properties sheet, click the Status tab.

2 In the Storage used box, confirm the storage space used by messages in 
the user mailbox.

3 In the Total available box, confirm the storage space that remains for 
messages in the user mailbox. 

4 In the Total system resources used box, confirm the storage space that is 
available to the user mailbox, which includes messages and all other 
individual greetings and personal distribution lists.

5 In the Personal verification box, see if a spoken name is associated with the 
user mailbox that identifies the mailbox.

6 In the Internal personal greeting box, see if there is a mailbox greeting that 
other local users hear.

7 In the External personal greeting box, see if there is a mailbox greeting that 
external callers hear.

8 In the Temporary absence greeting box, confirm that there is a temporary 
greeting for the user mailbox while the user is away from work for vacation, 
illness, travel, and so on. During normal working periods, no temporary 
absence greeting is in place. 
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9 In the Temporary absence greeting expiry box, confirm when the temporary 
mailbox greeting reverts to the regular mailbox greeting.

10 When you finish viewing the user’s properties, click Save.

To modify mailbox capabilities for the user

1 In the New User Properties sheet, ensure the Mailbox Capabilities check 
box is checked, and that the Set Up tab is configured.

2 Click the Mailbox Tab.

3 In the Mailbox number box, type the DN associated with the user’s mailbox.

4 For bilingual or multilingual systems: In the Language box, select the user’s 
preferred language. 

Note: The user hears the primary language until after he or she logs on to 
the mailbox. If the assigned mailbox class is configured to allow callers to 
hear voice prompts in the user’s preferred language, CallPilot uses this 
setting to determine the voice prompts used when callers reach a user’s 
voice mailbox. 

5 Configure DNs, using the procedure “To define the DNs associated with the 
user mailbox” on page 171.
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6 For RN users: Set up how and when a user receives Remote Notification, if 
the user has RN capability, using the procedure “To specify the user’s RN 
information” on page 173.

Note: Remote Notification must be enabled by the user group’s mailbox 
class before you can define the way in which the user receives Remote 
Notification.

7 Record the user’s mailbox password or greetings if they do not exist, using 
the procedure “To provide a personal verification message for the user” on 
page 174

8 When you finish configuring the user’s properties, click Save.

To define the DNs associated with the user mailbox

Note: All DNs defined in CallPilot must be dialable from the switch connecte
to the CallPilot server. For more information, see the NMS Implementation and 
Administration Guide for Product Release 1.0.

Example: If the DN is for a DMS/Centrex phoneset, include the access cod
the DN using the following format: <Centrex/DMS access code><10- or 7-d
Centrex/DMS DN>. 

Note: For more information and examples, see “Customizing a mailbox for a 
specific scenario” on page 175.
Administrator’s Guide 171



Adding and deleting users and directory entries Standard 1.0
1 In the New User Properties sheet, click the DNs tab.

2 In the first Extension DNs box, type the primary telephone number of the 
user’s mailbox. 

Note: If the mailbox has no extension numbers, go to step 5.

3 If the user has other DNs that he or she normally uses, type those 
extension DNs. 

Note: CallPilot answers any calls that these DNs do not answer.

4 To let users automatically log on to Messaging Administration without 
entering their mailbox number and password when calling from a defined 
extension DN, ensure the related Auto logon check box is checked.

5 To define a device that lets a user know that messages are in the mailbox, 
type a number in the MWI DN box. 

6 To define a DN to which Call Sender can reach the user, type a number in 
the Callback DN box. 

7 When you finish configuring the user’s properties, click Save.
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To specify the user’s RN information

Note: Remote Notification must be enabled by the user group’s mailbox cla
before you can define the way in which the user receives Remote Notificati

1 Click the Remote notification tab.

2 Ensure the RN on check box is checked.

3 In the Target number box, type the dialing number for the device that 
receives the notification for the user.

4 In the Message type list, select the type of message that is received in the 
user’s mailbox that also triggers an RN.

5 In the Device type box, select the device that receives RN from the user’s 
mailbox.

6 If the user’s device type is a paging service, in the PIN number box, type 
the user’s identification number to log on at the paging service.

7 If the user’s pager can display the pager’s number, in the Callback number 
box, type the number the user dials to access messages on CallPilot.

8 When you finish configuring the user’s properties, click Save.
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To provide a personal verification message for the user

1 Click the Status tab.

2 If the Personal verification box displays “Not Recorded,” either record the 
user’s name or import an existing WAV file.

Note: For additional instructions, see the context-sensitive Help.

3 When you finish configuring the user’s properties, click Save.
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Customizing a mailbox for a specific scenario

Introduction

In many organizations, some users must share resources while others have
resources at their disposal. Use this section to identify your scenario and th
steps to configure the affected user mailboxes appropriately.

Access requirements

To edit properties, you must belong to an access class that grants Edit or E
(mailbox users only) access to Users.

Scenario 1: The user has sole use of a phoneset but shares DNs

A manager and her assistant share the manager’s telephone number so tha
to the manager rings both their phonesets. If the manager lets the phonese
more than twice, the assistant answers the call. The assistant also has her 
extension defined on the switch.

When a call to the manager is not answered by the manager or the assista
Call Answering service

� sends the call to CallPilot

� presents the call as coming from the manager’s extension

� leaves any message in the manager’s mailbox

If the assistant receives a personal call, it rings only her own phoneset. If the
is unanswered, Call Answering leaves any message in the assistant’s mailb

For this scenario, the following conditions are in place:

� Both extensions are assigned on the switch to the assistant. The mana
extension is assigned to both users.

� A different mailbox DN is configured on the switch for each user.
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Perform the following procedures:

� “To customize a mailbox for a manager with an assistant” on page 179

� “To customize a mailbox for a manager’s assistant” on page 179

Scenario 2: The user has a shared phoneset and a unique DN 

Several mailbox users sit together and use a single phoneset. The phonese
configured with a unique extension DN for each user.

For this scenario, the following conditions are in place:

� The primary telephone extension is assigned on the switch to all the 
mailbox users who share the phoneset.

� A different mailbox DN is configured on the switch for each user.

Perform the following procedures:

� “To customize a mailbox for a user with a shared phoneset” on page 18

� For each user with a pager: “To create separate MWIs for users sharing a
phoneset” on page 180

Scenario 3: A technical support group has no single phoneset but has 
its own mailbox and associated DNs defined on the switch

Where customers call a common phone number for the technical support g
the number does not correspond to a particular phoneset. Instead, the num
mapped to multiple phonesets. There is a single mailbox associated with th
DN. Each member of the group has his or her own private DN for personal 
and shares a group pager.

For this scenario, the following conditions are in place:

� The technical support group is defined on the switch as a user with its 
extension DN and mailbox.

� Each group member is defined on the switch with his or her own exten
DN and mailbox. These users each have two extension DNs and two 
mailbox DNs.
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Perform the following procedures:

� “To customize a mailbox for a user with a shared phoneset” on page 18

� “To create separate MWIs for users sharing a phoneset” on page 180 (using 
an MWI DN that is mapped to different devices)

Scenario 4: A suggestion box has a mailbox only (no phoneset)

A department might have a suggestion mailbox where customers can leave
comments. Callers can contact the mailbox via Express Voice Messaging o

A person with a suggestion calls the Express Voice Messaging DN and spe
the published Suggestion Box mailbox in which to leave a message. 

For this scenario, the suggestion box is defined on the switch as a user with
own mailbox but no telephone extension.

Perform the following procedure:

� “To customize a mailbox for a user who shares a phoneset with a singl
extension but has an individual mailbox” on page 181

� Optional: “To create separate MWIs for users sharing a phoneset” on p
180 (only if a device or another mailbox user has been designated for 
notification of new suggestions)

Scenario 5: Users with individual mailboxes share a phoneset with a 
single extension DN

On a shop floor there is a single phoneset for several workers. Workers can
Express Voice Messaging to leave each other messages.

When no one answers a call to the shared phoneset, the call is sent to Exp
Voice Messaging. The caller can select a mailbox user from a voice menu a
then use the Call Sender feature to leave a message.

For this scenario, the following conditions are in place:

� The Express Voice Messaging CDN is defined in the CallPilot SDN tab

� The same extension DN is defined on the switch for each worker.

� A different mailbox DN is defined on the switch for each worker.
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Perform the following procedures:

� “To customize a mailbox for a user who shares a phoneset with a singl
extension but has an individual mailbox” on page 181 (leaving the Mailbox 
DN value blank)

� Optional: “To create separate MWIs for users sharing a phoneset” on p
180 (only for workers with pagers)

Scenario 6: Guests need an extension for callers to leave messages

In most organizations, short-term contractors and other occasional or one-t
visitors need to be able to collect messages from callers. 

For this scenario, one option is to use the Express Voice Messaging CDN 
defined in the CallPilot SDN table.

Perform the following procedure:

� “To set up a guest mailbox” on page 181
178 CallPilot



April 2000 Adding and deleting users and directory entries

nd 
Getting there  CallPilot System > User Administration > Users > Search Users > DNs 
tab

To customize a mailbox for a manager with an assistant

1 In the first Extension DNs box, type the manager’s extension.

Result: The manager’s extension is automatically copied into all other 
boxes.

2 When you finish configuring the user’s properties, click Save.

To customize a mailbox for a manager’s assistant

Note: The assistant has two extensions configured on the switch: her own a
her manager’s. 

1 In the first Extension DNs box, type the assistant’s extension.

Result: The assistant’s extension is automatically copied into all other 
boxes.

2 When you finish configuring the user’s properties, click Save.
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To customize a mailbox for a user with a shared phoneset

Note: With this procedure, each user must log on to his or her CallPilot mail
to find out who the message is for. For a workaround, see “To create separate 
MWIs for users sharing a phoneset” on page 180.

1 In the first Extension DNs box, type the phoneset’s primary extension.

Result: The primary extension is automatically copied into all other boxes.

2 Type the user’s mailbox number in

� the first Extension DNs box

� the MWI DN box 

� the Callback DN box

Note: If the user has a pager, type the pager number in the MWI DN box.

3 When you finish configuring the user’s properties, click Save.

To create separate MWIs for users sharing a phoneset

1 For each user with a shared phoneset: In the MWI DN box, type the user’s 
pager number.

2 When you finish configuring the user’s properties, click Save.

To customize a mailbox for a technical support group without a 
phoneset 

Requirement: You must belong to an access class that grants Edit or Edit 
mailbox users only access to Users.

1 Ensure the first Extension DNs box is empty.

2 Type the user’s mailbox number in the Callback DN box.

3 In the MWI DN box:

a. If there is no designated device or owner, leave it blank.

b. If there is a designated owner, type the number of the device or the 
owner’s pager.

4 When you finish configuring the user’s properties, click Save.
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To customize a mailbox for a user who shares a phoneset with a 
single extension but has an individual mailbox

Requirement: You must belong to an access class that grants Edit or Edit 
mailbox users only access to Users.

1 Ensure the first Extension DNs box is empty.

2 Type the telephone extension number in the Callback DN box.

3 In the MWI DN box:

a. If the user has no pager, leave it blank.

b. If the user has a pager, type the pager’s DN.

4 When you finish configuring the user’s properties, click Save.

To set up a guest mailbox

Requirement: You must belong to an access class that grants Edit or Edit 
mailbox users only access to Users.

1 In the CallBack DN box, type either the Express Messaging DN or the 
department assistant’s extension.

2 Under the Set Up tab, in the Message waiting indication options list, click 
None.

3 When you finish configuring the user’s properties, click Save.
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Creating a fax buffering mailbox for a user

Introduction

To ensure faxes are received, even when a fax machine is busy or unable t
answer, define a fax buffering mailbox for an individual user. When a fax 
machine does not answer a call, Fax Call Answering accepts the call and s
the fax message in the designated fax buffering mailbox. The owner of this 
mailbox can print stored faxes and then manually distribute them to users. 

Use the supplied template to set up the fax buffering mailbox to automatica
send a fax to a printer when the fax machine is not available. 

Note: When a fax is sent to a mailbox without fax capability, the Fax Call 
Answering service either deposits the fax in the designated mailbox or drop
call. It never sends messages to a fax general delivery mailbox.

Unique feature

A fax buffering mailbox automatically sends fax messages to the fax machi
when the machine is no longer busy. When a message is sent to the machi
status changes to “read” and the system can delete it. For all other mailbox
types, auto-printing does not change the status of a message from “unread
“read.”

Limitations

You cannot set up Remote Notification for a fax buffering mailbox, but you c
set up an MWI DN, a Revert DN, or a Callback DN. 

Access requirements

To add a fax buffering mailbox, you must belong to an access class that gra

� View access to User Creation Templates

� Create/delete or Create/delete mailbox users only access to Users
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Before you begin

Before you set up a fax buffering mailbox, be aware of the following factors

� You need the fax machine’s DN.

� If no name dialing and address dialing prefix has been set up in Messa
Administration for the fax buffering mailbox, you need to set up a 
password.

Getting there  CallPilot System > User Administration > User Creation Templates 
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To set up a new fax buffering mailbox

1 In the list of templates, click Fax Buffering Mailbox Template.

2 In the File menu, click Add New User.

Result: The Fax Buffering Mailbox template appears.

3 In the First name box, type the user’s first name.

4 In the Last name box, type the user’s last name.

5 In the Comments box, type any additional information about the user.

6 Click the Mailbox tab. 

7 In the Mailbox number box, type the extension DN of the fax machine.

8 Click the Set Up tab.

9 In the Default Printing DN box, type the extension DN of the fax machine.

10 If a prefix (for name dialing and name addressing) is not assigned in 
Messaging Administration, click the Security tab and assign a password.

11 When you finish configuring the fax buffering mailbox properties, click Save.
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Adding a directory entry

Introduction

A directory entry is a user without a mailbox. You might want a directory en
for a number of situations. For example:

� A phoneset is in a meeting room or lab used by many people, so there 
mailbox for that phoneset. 

� A support technician from an organization that services a user group d
not have a mailbox but needs to be accessible by telephone whenever
she is onsite.

Because directory entries do not have mailboxes, they cannot use voice 
messaging features such as composing and sending messages, nor can th
features such as outcalling or AMIS networking.

Access requirements

To add a directory entry, you must belong to an access class that grants 

� View access to User Creation Templates

� Create/delete or Create/delete mailbox users only access to Users
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Getting there  CallPilot System > User Administration > User Creation Templates > 
Directory entry template > Settings tab

To define mailbox settings for a directory entry

Note: Complete the General and Admin tabs as you do for a local user (see
“Adding an individual mailbox user” on page 162).

1 In the first Extension DNs box, type the primary DN of the directory entry.

2 If the directory entry has additional extension numbers, type those in the 
remaining Extension DNs boxes.

3 If the DN that will reach this user via Call Sender or Name Dialing is 
different from the user’s primary extension DN, overtype the value in the 
Callback DN box.

4 If the Personal verification recorded box displays “No,” follow the 
instructions in “Providing a spoken name for a user or directory entry” on 
page 191.

5 To let external callers call the directory entry user by spelling its name (for 
example, B-O-A-R-D-R-O-O-M), ensure the Name dialable by external 
callers check box is checked.

6 When you finish configuring the directory entry’s properties, click Save.



April 2000 Adding and deleting users and directory entries

ho 
 the 
 

ilot 
t 

rs.

ilot 

 user 
, he or 
ocal 
 

 

Adding a CallPilot user at a remote site to the 
local system

Introduction

A remote user is not the same as a CallPilot user at a remote site. 

� A remote user has a mailbox configured on the local CallPilot system. 
When using CallPilot from the office computer, the user is a local user w
accesses his or her mailbox as usual. When using CallPilot away from
office, the same user is a remote user who must dial in to the system to
send, receive, or download messages.

� A CallPilot user at a remote site has a mailbox configured on the CallP
system at that site. Local CallPilot users can communicate with CallPilo
users at remote sites in the same way they communicate with non-use

The following table shows how each type of user sends and receives CallP
messages:

Remote User Template

The Remote User Template lets you define, on the local system, a CallPilot
at a remote site. Once a user at a remote site is defined on the local system
she is referred to as a CallPilot Remote User. CallPilot Remote Users and l
users can communicate with one another as if they are all at the same site.

To receive messages To send messages

A CallPilot remote 
user (over a dialup 
connection)

must dial in to the system to 
receive new messages

must dial in to the system to 
transfer sent messages to the
server

A CallPilot user at a 
remote site

receives messages as a local 
user receives them

sends messages as a local 
user sends them
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See also
� Enterprise Networking Implementation and Administration Guide for 

Product Release 1.0

Access requirements

To you add a CallPilot Remote User to the local system, you must belong to
access class that grants 

� View access to User Creation Templates

� Create/delete or Create/delete mailbox users only access to Users

Before you begin

Before you add a CallPilot Remote User to the local system, you need to be
aware of the following factors:

� When local CallPilot users address a message to a CallPilot Remote U
they need to hear a personal verification for the recipient.

� Local CallPilot users can use name dialing and name addressing to dir
calls and messages to a CallPilot Remote User.

� While listening to a message from a CallPilot Remote User, a local 
CallPilot user can use Call Sender to immediately place a call to the 
CallPilot Remote User.

� External callers to the local CallPilot system can name-dial a a CallPilo
Remote User.

� Local users and administrators can add CallPilot Remote User to 
distribution lists.
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Getting there  CallPilot System > User Administration > User Creation Templates > 
Remote User Template > Settings tab

To define mailbox settings for a CallPilot Remote User

Note: Fill in the General and Admin tabs as you would for a local user (see 
“Adding an individual mailbox user” on page 162).

1 In the Mailbox number box, type the CallPilot Remote User’s mailbox 
number, as it would be dialed by a local user. 

Example:  If a local user dials a prefix (such as 6) and an ESN number 
(such as 408-9999) to reach theCallPilot Remote User, type 64089999 in 
the Mailbox number box.

2 In the first Extension DNs box, type the primary telephone number of the 
user’s mailbox. 

3 If the directory entry has additional extension numbers, type those in the 
remaining Extension DNs boxes. Use the same format (that is, include the 
prefixes and ESN number) that you used for the primary DN.
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4 If the DN that will reach this user via Call Sender or Name Dialing is 
different from the user’s primary extension DN, overtype the value in the 
Callback DN box.

5 If the Personal verification recorded box displays “No,” follow the 
instructions in “Providing a spoken name for a user or directory entry” on 
page 191.

6 To let external callers call the CallPilot Remote User by name dialing, 
ensure there is a check mark in the Name dialable by external callers box.

7 To automatically remove a CallPilot Remote User from the system once the 
user is no longer frequently called, ensure the Temporary user check box is 
checked.

8 When you finish configuring the CallPilot Remote User’s properties, click 
Save.
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Providing a spoken name for a user or 
directory entry

Introduction

Record a unique name for the user or directory entry that identifies the phon
to someone sending a message or composing a distribution list.

Access requirements

You must belong to an access class that grants Edit or Edit mailbox users o
access to Users.

Getting there  CallPilot System > User Administration > Users > Search Users > 
Settings tab
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To record a spoken name for a CallPilot Remote User

1 To record a name on behalf of the user or directory entry, click Record.

Result: The Specify Phoneset dialog box appears.

2 In the Enter a phone number box, type the phone number of the phoneset 
you want to use for recording.

3 Answer the phoneset when it rings.

Result: The Voice Recorder dialog box appears.

4 Click Record.

5 Speak a name for the CallPilot Remote User into the phoneset.

6 Click Stop.

7 To review the recorded name, click Play.

8 To save the recording, click Done to return to the Settings tab.

To import a WAV file 

1 Click Import.

2 Select the file that contains the appropriate recording.

3 Click Open.

4 Click OK.
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Deleting a user or directory entry

Introduction

When a mailbox user, a CallPilot Remote User, or a directory entry is no longe
required, delete it to prevent hackers from making use of it.

Note: If you customize a user search to describe a group that periodically n
deletion (such as mailboxes that have been inactive for three months), you 
use the Shift key to select all users in the group.

See also
� Chapter 12, “Searching for users”

Access requirements

You must belong to an access class that grants Create/delete or Create/de
mailbox users only access to Users.

Getting there  CallPilot System > User Administration > Users > Search Users > list of 
found users
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To delete a user or directory entry

1 Click the user you want to delete.

2 On the File menu, click Delete.

3 In the confirmation box, click Yes.
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Overview of optional services

In this chapter
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Multimedia Messaging

Introduction

Multimedia Messaging gives users a single multimedia mailbox and a single
point of access for both voice and fax messages. Users can compose, send
receive, and manipulate voice, fax, and multimedia (combined voice and fa
messages from a single mailbox. 

Express Voice Messaging

Express Voice Messaging allows both internal and external callers to route v
messages directly to users’ mailboxes. 

Express Voice Messaging

� makes it unnecessary to call a user’s phoneset first and then be forward
the user’s mailbox

� allows callers who reach a human attendant to leave a voice message 
user’s mailbox on the same call

� allows callers who reach a voice menu to leave a message in a user’s 
mailbox

� allows an administrator to set up a guest mailbox without linking it to a 
phoneset

Express Fax Messaging

Multimedia Messaging and Express Fax Messaging differ in the following w

� Multimedia Messaging allows a mailbox user to send a fax to another 
mailbox user, as long as his or her mailbox has fax capability enabled.

� Express Fax Messaging allows internal or external callers to route faxe
from a faxphone to a user mailbox. It can be set up in two ways: to send
fax to a predefined mailbox or as direct fax delivery, which routes faxes
directly to the specified user’s mailbox.
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Direct fax delivery
With direct fax delivery, callers dial one company-wide or department-wide 
number. Callers need to know only the service DN and the user’s mailbox 
number. The fax is put directly into the specified mailbox. Direct fax delivery
improves the timeliness and confidentiality of transmissions, and frees cleri
personnel for other tasks. 

Multiple Express Fax Messaging
With multiple Express Fax Messaging services, you can set up several fax 
message desks for different departments. You can set up each Express Fa
Messaging service with a unique SDN, or you can create an Application Bu
application to make multiple fax message desks available from a voice men

See also
� “To add an SDN” on page 223

� “Configuring a fax mailbox for a group” on page 246

� Chapter 19, “Configuring outcalling services”

� Chapter 22, “Managing channels (M1 switch only)”

� information about creating an application in Application Builder Guide
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Multimedia Call Answering

Introduction

Multimedia Call Answering enables mailbox users to receive mixed voice a
fax messages during a Call Answering session.

Users can receive any of the following messages:

� a multimedia message (fax and voice)

� a voice-only message

� a fax-only message

Message blocking

You can configure a mailbox so that 

� incoming messages are automatically blocked

� incoming messages are automatically blocked when the user activates
temporary greeting

Requirements

The Multimedia Messaging CDN on the switch must be defined in the CallP
SDN table as a Voice Messaging SDN with media type fax. DNs associated
user mailboxes must be configured to forward messages to this SDN. 

Matra switch caveat

If the Matra switch is not properly configured, messages might be forwarde
the Voice Messaging CDN rather that the Multimedia Messaging CDN. 

See also
� switch configuration information in the Installation and Configuration 

Guide
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Fax Call Answering

Introduction

Fax Call Answering behaves like a fax machine. There is no greeting or voi
prompt played for callers.

Personal Fax Call Answering

Some users might want or need a personal fax number that is different from
regular phoneset number. With a different fax number, senders think they a
calling a real fax machine. For this setup, users do not need dedicated fax 
machines or analog lines. 

To give a user a unique fax number, you must set up a phantom DN (on the
for the user and make sure the DN is always forwarded to the Multimedia 
Messaging SDN. 

Based on how the mailbox is set up, received faxes are either immediately 
printed to the user’s designated default fax machine or stored in the CallPilo
mailbox. MWI indicates there is a new message. The recipient can use the 
CallPilot Desktop Messaging client to view the message on-screen and prin
a shared printer or fax machine.

See also
� “Customizing a mailbox for a typical user” on page 165
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Outcalling services

Introduction

Outcalling services require an outbound SDN before they can perform their
functions. You cannot create an outbound SDN in the SDN Table. Typically, 
one of the default SDNs on the switch and is automatically included in the S
Table.

Outcalling services include 

� Remote Notification (RN)

� Delivery to Telephone (DTT)

� Delivery to Fax (DTF)

Remote Notification

Remote notification (RN) service generates notifications that inform users o
new voice, email, fax, or multimedia messages. Notifications can be sent to
remote phonesets or to pagers. 

A notification might or might not include the message. If a notification is sen
a voice or alphanumeric pager, the new message can be played or displaye
the recipient. 

The administrator must enable RN for users, but either the user or the 
administrator can configure the destination for notifications and the schedul
generating them.

To enable RN service and define rules for the user group, configure the RN
options for the associated mailbox class.

Delivery to Telephone

Enable Delivery to Telephone (DTT) for user groups that need to be able to
compose and send voice messages to phonesets, whether or not they have
mailboxes associated with them. 
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Delivery to Fax

While Multimedia Messaging allows users to send faxes to other mailbox us
who have fax capability, Delivery to Fax (DTF) service allows users to send
faxes to internal or external faxphones.

Delivery of multimedia messages to nonusers

The DTT service is used to send the voice portion of a multimedia message
addressed to an external recipient. DTT has its own defined time periods du
which CallPilot is permitted to send DTT messages. In this case, messages
checked against the intersection of the DTT and DTF time ranges.

Example
The allowed delivery time for DTT is 9:00 a.m. to 8:00 p.m. The allowed 
delivery time for DTF is 8:00 a.m. to 11:00 p.m. Thus, the allowed delivery ti
for a multimedia message is 9:00 a.m. to 8:00 p.m., since this is the period 
time that overlaps the two allowed delivery time periods.

Delivery of fax messages to nonusers

Multimedia Messaging and DTF service differ in the following ways:

� Multimedia Messaging allows transmission of fax messages between 
CallPilot mailbox users.

� DTF service allows users to send faxes to external faxphones.

How to use DTT and DTF services in your organization

DTT and DTF can be used to facilitate communications 

� by supporting telecommuters

� as a reminder service
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Supporting telecommuters
Telecommuters’ home phonesets do not have mailboxes defined on the sys
If DTT is enabled for a user group, team members at work can send messa
items to any other team member, regardless of where they are working. If DT
also enabled, mailbox users can also send fax items to team members with
access to a fax device.

DTT as a reminder service
When combined with the Timed Delivery service, DTT can function as a 
reminder service. Users can record voice messages to themselves (either a
office or at home) and tag them for timed delivery.

Multimedia messages

For messages that contain both voice and fax, CallPilot assumes that the ad
is either a telephone number or a fax number. Based on how the call is answ
the system sends the voice part, the fax part, or both parts of the message.

See also
� “Express Fax Messaging” on page 198

� Chapter 19, “Configuring outcalling services”
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Speech Activated Messaging services

Introduction

Speech Activated Messaging provides a form of hands-free messaging. Us
give commands by speaking them instead of by pressing phoneset keys. T
means that users can use a rotary phoneset to give spoken commands tha

� log the user on

� navigate the mailbox

� play messages

� print faxes

� respond to messages

Speech Activated Messaging provides an alternate way to access messagin
call answering features without providing additional features. Users can 
interrupt playback of system prompts, voice messages, and other recorded 
items to issue a command (for example, to switch to Paced Speech Messag
it is configured with its own SDN).

Speech Activated Messaging required continuous digit entry, which allows u
to speak naturally, without pausing between each digit.

Paced Speech Messaging

For users with accents or speech impediments, or who call frequently from 
noisy environment, Paced Speech Messaging provides greater accuracy. It
prompts the user to speak the next digit and then validates the digit. When 
validation fails, it queries the user. 

Limitations

Speech Activated Messaging does not allow users to record personal greet
or verifications, create or edit personal distribution lists, use the Goto comm
or change the mailbox password (unless prompted because the password 
expired).
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Automatic access to Paced Speech messaging

Three unsuccessful attempts to speak a command activates the Paced Spe
Messaging service and offers the user the option to switch to touchtone inp

Recommendation

Define a separate SDN for Paced Speech Messaging so that users who 
consistently have problems with continuous digit entry can dial the Paced 
Speech Messaging service directly.

Requirements

To provide Speech Activated Messaging and Paced Speech Messaging to 
CallPilot system users, you need to 

� enter the speech recognition keycode when installing the system

� configure two phantom DNs on the switch for each language supported
then add each phantom DN to the SDN Table

Note: Phantom DNs are configured on M1 and MSL-100 switches. Thir
party switches use hunt group technology instead.

� allocate some multimedia channels as speech recognition channels

� enable speech recognition capability in the applicable mailbox classes

See also
� information about SDNs and the SDN Table in Installation and 

Configuration Guide

� “Adding an SDN” on page 221

� “Enabling multimedia mailbox capabilities” on page 238

� “Allocating channels to services” on page 291
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Multilingual mailbox and answering services

Introduction

You can use CallPilot to provide mailbox or Call Answering services in differ
languages. 

The system allows you to do any or all of the following options:

� configure mailboxes to prompt users in the language of choice

� configure mailboxes to answer callers (through Call Answering) in the 
language of the mailbox user’s choice

� configure Call Answering to be bilingual

� configure Application Builder applications in any installed language

� use an Application Builder block to specify a language 

See also
� “Relationship between mailbox classes and user creation templates” o

page 279

Requirement

The CallPilot system must be installed with all desired languages. If necess
upgrade the system to install additional languages.

See also
� information about upgrading the system in Installation and Configuration 

Guide

Configuring mailbox prompts in a specified language

Within an organization, some user groups might prefer to use different 
languages. You can configure CallPilot user mailboxes to prompt users in a
specific language, either at the group level or for individuals.
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For a user group that prefers a language other than the primary language, m
the user template for creating group members. If necessary, create speciali
user templates for user groups who prefer the second language

For existing users who prefer the new language, modify the user mailbox 
properties to specify the new language (see “To assign a default mailbox class” 
on page 101).

See also
� “To modify mailbox capabilities for the user” on page 170

Configuring call answering services for bilingual or preferred-
language prompts

By default, all supplied mailbox classes are configured to provide call answe
services in the primary language. You can configure mailbox classes to pro
call answering services in either dual language prompts or in the mailbox u
preferred language.

See also
� “Configuring the language for call answering voice prompts” on page 2

� “Making system greetings bilingual” on page 242

Using front-end voice menus to determine the language for a service

If you want callers to hear voice prompts immediately in a language that ha
been added to the CallPilot system, use Application Builder to create a front
application for each language. Then add an SDN for each additional langua
and publish the SDNs to interested parties. 

When you add the SDNs, configure the session profiles to specify the langu
If the service media type is speech recognition, the language specification 
applies to voice responses as well as voice prompts.

See also
� “Adding an SDN” on page 221

� “To specify the language for session prompts and speech recognition” 
page 226
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� “Making system greetings bilingual” on page 242

� information about creating applications in the Application Builder Guide
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Media requirements for CallPilot services

Introduction

Different services process different types of data. Certain kinds of data (suc
fax and speech recognition) require more channel resources to process them
example, a fax service requires twice as much processing power as a voice
service. A speech recognition service requires four times as much processi
power as a voice service.

Types of channels

As a result, three types of multimedia channels handle this variety of proces
requirements:

� voice

� fax

� speech recognition

Media type

As part of SDN configuration, you must select the appropriate media type to
ensure the service has access to the required processing power.

Application Builder applications that contain Multimedia messaging or Expr
Fax Messaging must have access to fax channels.

Built-in services versus created services
For built-in CallPilot services, such as Voice Messaging or Express Fax 
Messaging, the media type is automatically selected. For applications creat
with Application Builder, you must select the media type that is appropriate 
the service. 
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Media do not share channels

The media type assigned to a service prevents a service from using channe
another type. This means that voice services use voice channels only. This i
even if all voice channels are busy and some fax channels are idle. This app
ensures that traffic bursts can be handled simultaneously for all media type

Example
You have a 24-channel system that is partitioned into 16 voice channels, 2 
channels, and 1 speech recognition channel. There is a burst of fax activity
your system, and all of the fax channels become busy. Another fax call com
to the system. There are no fax channels to handle the call. The speech 
recognition channel is idle but not used. Instead, the call waits until there is
idle fax channel.

At another point in the day, all voice channels become busy. Additional calls
voice services are prevented from using the idle fax channels. The fax chan
remain available to handle any calls to fax services that come in.

See also
� information about resource allocation in Installation and Configuration 

Guide

� “Allocating channels to services” on page 291
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Making optional services available

In this chapter
 SDNs and service behavior 214

 SDNs for fax services 217

 Shareable SDNs 220

 Adding an SDN 221

 Configuring a session profile for voice menus and features 224

 Configuring an SDN for sharing 228

 Configuring fax callback handling 230
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SDNs and service behavior

Introduction

SDNs correspond to numbers that have been configured on the switch. Eac
SDN you enter in the SDN Table must correspond to one of the following 
numbers on the switch:

� the Control DN of an ACD queue

� the DN of a Phantom TN (MSL-100 switch)

In addition to providing a unique dialable number for each CallPilot service,
SDN configuration also determines certain aspects of the service’s behavio

Channel media type

A service’s SDN controls the type of channels the service can use (voice, fa
speech recognition), the number of channels that are guaranteed for that se
and the maximum number of channels that the service can use at any one 
These options are available when you configure an SDN. They control the 
minimum and maximum number of channels available for a given service.

Session profile

For certain types of services, such as Application Builder services, the SDN
configuration includes a session profile. This profile determines how the ser
behaves during a call session (for example, the maximum session length an
maximum number of faxes callers can select).

Fax callback handling

If a service includes fax items that can be delivered on a separate call to num
entered by callers, you must also define fax callback handling properties. Y
must select an appropriate RPL to control the callback numbers to which 
CallPilot can deliver faxes.
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Multiple SDNs for a single service

Create more than one SDN for a service whenever you need to configure 
different session profiles for different user groups. 

Examples

� Whenever a block in an Application Builder application must behave 
differently from other blocks in the application, create the block as a 
separate application instead of as a block within a single application. T
you can configure the session profile for each use of the application blo
For more information, see the Application Builder Guide.

� If your CallPilot system supports multiple languages for Fax Item 
Maintenance, Voice Item Maintenance, Speech Activated Messaging, o
Paced Speech Messaging, create an SDN for each supported languag
each service.

Inbound and outbound SDNs

Inbound SDNs are required for dialable services. The SDN is the number th
callers dial to access the service. You must add these SDNs to the SDN Ta
Once added, you can change their default configuration. 

Outbound SDNs are added to the SDN Table automatically during installati
Outbound SDNs are not dialed by callers. They are used by the system to p
outbound calls and to determine the channel resources allocated to the ser
You cannot use the CallPilot Administration Client to create or modify outbou
SDNs. 

Outbound SDNs

Typical default outbound SDNs listed in the SDN table are as follows:

� OUTBOUND11 (Remote Notification)

� OUTBOUND15 (Multi-delivery to Fax)

� OUTBOUND18 (Desktop Telephony Agent)

� OUTBOUND6 (Admin Agent)

� OUTBOUND7 (Delivery to Telephone)

� OUTBOUND8 (Delivery to Fax)
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� OUTBOUND9 (Enterprise Networking)

If your system was purchased with the appropriate keycode, there might als
SDNs for

� AMIS Networking

� Multimedia Messaging
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SDNs for fax services

Introduction

If you want a fax service to be able to deliver faxes to more than national 
numbers, international numbers, ESN numbers, or CDP numbers, you have
options:

� Create separate SDNs for each required callback format. 

� Create a menu as a front end. 

� Create only one SDN.

Option 1: Separate SDNs

Create separate SDNs for each caller market (for example, local, long dista
and international) and publish the appropriate SDN to each market.

Note: As an alternative, you can create two SDNs: one for local and long 
distance callers (which requires callers to always enter the area code but n
country code), and one for international callers.

Advantage
This option is easiest for users.

Option 2: Menu front end

Create a menu in Application Builder as a front end that allows callers to spe
where their fax machine is located. CallPilot then prompts callers to enter th
callback number in the required format.

Note: You still need to create multiple SDNs for each service that is activate
the menu. The only way to have a variety of callback number formats is to cr
one SDN per required format. 
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Example: Front-end menu for receiving a fax item
Your company is located in Boston. You have a new product bulletin (in TIFF
format) that you want to make available to your North American customers.
However, you also have a strong European customer base, so you also wa
make this bulletin available to your European customers. You want to create
only one set of marketing materials and publish one number for both caller 
markets.

To set up this service, do the following actions:

1. Add an SDN (for example, 4010) which invokes this fax item. Set its 
callback number treatment (on the Callback Handling tab) to National.

2. Add an SDN (for example, 4110) which also invokes this fax item. Set 
callback number treatment (on the Callback Handling tab) to Internatio

3. Add an SDN for the menu (for example, 4009).

4. Create the menu.

� Make menu choice 1 call SDN 4010.

� Make menu choice 2 call SDN 4110.

� Record a prompt that instructs callers on what to do. For example: “
your fax machine is in North America, press 1. If your fax machine is
any other country, press 2.”

Result

� Callers dial 4009 to access the voice menu.

� When a caller presses 1, the system calls SDN 4010. The session profi
SDN 4010 is used. The system prompts the caller to enter an area/city 
and the fax number.

� When a caller presses 2, the system calls SDN 4110. The session profi
SDN 4110 is used. The system prompts the caller to enter a country co
area/city code, and fax number.

Advantage
Only the SDN of the main menu service needs to be published to callers.
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Option 3: Single SDN

For all callers, create a single SDN that is configured to handle internationa
callback numbers. Callers are always prompted to include their country code
area code as part of the fax number, even if they are within the same count
area code.

Advantage
You do not need a menu for selecting country codes, as required by Option

Disadvantage
Many people who are unfamiliar with international dialing do not know their
country code. Callers within your country code might, therefore, have difficu
using the service.

See also
� “Adding an SDN” on page 221

� “Configuring a session profile for voice menus and features” on page 2

� “Configuring fax callback handling” on page 230
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Shareable SDNs

Introduction

Networking services can have their own dedicated SDNs or they can share
SDN with another service, such as an Application Builder voice menu or Vo
Item Maintenance. 

Networking SDNs and session profiles

When an AMIS or Enterprise call comes in to the system, the SDN recogniz
the initiator tone. CallPilot switches to the appropriate networking service so
that the inbound network call can be answered. 

Note: Only Voice Item Maintenance and Fax Item Maintenance can be 
configured to use the setting, Act on AMIS/Enterprise initiator tone. 

Shared SDNs allow you to reduce the number of required SDNs and MSL-1
Phantom DNs.

SDN queues

You can share multiple SDNs with these networking services so that if a 
networking call comes in to an SDN that is busy, the network call can try com
in on another SDN that is configured for sharing.

Because session profiles are required only by certain services, AMIS 
Networking, Integrated AMIS Networking, and Enterprise Networking must 
share an SDN with one of the following services:

� any Application Builder service

� Express Voice Messaging

� Express Fax Messaging

� Fax Item Maintenance
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Adding an SDN

Introduction

Use this procedure to make optional features and front-end voice menus 
available to mailbox users or external callers. 

Requirements

Any required Application Builder applications or voice menus must already 
added to the system. Use the following procedure to associate these applic
with a dialable number.

See also
� “SDNs for fax services” on page 217

� information about creating applications in the Application Builder Guide

Access requirements

You must belong to an access class that grants Create/delete access to Se
Directory Number.
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Getting there  CallPilot System > System Administration > Service Administration > 
Service Directory Number
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To add an SDN

1 On the File menu, click New.

2 On the General tab, in the Service DN box, type the dialable number you 
want to assign to the service or front-end voice menu.

3 In the Application Name list, click the feature or voice menu that you want to 
enable.

4 In the Media Type list, select Fax. 

5 If the Service DN requires no additional configuration, click Save.
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Configuring a session profile for voice menus 
and features

Introduction

Configure a session profile for

� any Application Builder voice menu or feature

� Express Voice Messaging

� Express Fax Messaging

See also
� “SDNs for fax services” on page 217

Access requirements

To configure a session profile for an existing SDN, you must belong to an ac
class that grants Edit access to Service Directory Number.

To configure a session profile for a new Express Voice Messaging or Expre
Fax Messaging SDN, you must belong to an access class that grants Crea
delete access to Service Directory Number.
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Getting there  CallPilot System > System Administration > Service Administration > 
Service Directory Number > Session Profile tab

To limit session length and number of consecutive logon attempts

1 In the Session time limit box, type the maximum number of minutes callers 
can stay on the line to use a service.

Note: This limit prevents malicious callers from using up your system’s 
resources.

2 In the Maximum invalid password entries box, type the maximum number of 
times a caller can enter an invalid password when accessing a password-
protected service. If this number is exceeded, CallPilot disconnects the call.

Note: This step is necessary only if the SDN is for an Application Builder 
application that includes a password check block.

3 When you finish configuring the SDN, click Save.
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To configure Express Voice Messaging or Express Fax Messaging

Example: DN 3654 is defined in the SDN Table for Express Fax Messaging
Mailbox number 8050 is specified in the Session Profile for the Express Fax
Messaging DN. 

Note: If the Mailbox number is left blank, the system prompts callers for the
mailbox number.

1 In the Mailbox number box, type the mailbox number for the fax machine or 
attendant, depending on the service being configured. 

2 When you finish configuring the SDN, click Save.

To specify the language for session prompts and speech recognition

Note: The Language list is available only if the Application Builder applicatio
requires it (not used for Express Voice Messaging or Express Fax Messagin

1 In the Language list, click the installed language for the service being 
configured. 

2 When you finish configuring the SDN, click Save.

To configure fax options

1 Ensure the Fax selections check box is checked.

2 In the Maximum number box, type the maximum number of fax items a 
caller can request for delivery during one call.

3 In the Page limit for fax items box, type the maximum number of fax pages 
that can be transmitted to a caller during one call.

4 In the Sender fax number box, type the DN of the fax machine that sends 
faxes. 

Note: This number appears on printed pages.

5 To include a custom cover page with faxes, do the following actions:

a. Ensure the Sponsor fax item check box is checked.

b. Click Import to open a list of files.

c. Select the file that contains the custom page, and click Open.

Note: The file must be in TIFF-F format.
226 CallPilot



April 2000 Making optional services available
6 In the Billing DN box, type the telephone number to be charged for callback 
fax transmissions.

Note: If this number is not specified, calls are charged to the SDN.

7 Specify how the system responds to transmission errors by clicking one of 
the Page transmission error handling buttons:

� Click Continue if you want the system to ignore an error and transmit the 
next page.

� Click Retransmit if you want the system to stop the current fax and 
resend it.

8 From the Fax delivery options list, select the method by which faxes are 
sent (Callback, Same Call, or Caller’s Choice).

9 When you finish configuring the SDN, click Save.
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Configuring an SDN for sharing

Introduction

To share an existing SDN with one of these networking services, the sessio
profile of the shared service must have the Act on AMIS/Enterprise initiator t
option enabled.

Note: Only Voice Item Maintenance and Fax Item Maintenance can be 
configured to use the setting, Act on AMIS initiator tone.

You can configure any of the following services to share its SDN with your 
AMIS or Enterprise networking service:

� any Application Builder service

� Express Voice Messaging

� Express Fax Messaging

� Fax Item Maintenance

Access requirements

You must belong to an access class that grants Edit access to Service Dire
Number.
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Getting there  CallPilot System > System Administration > Service Administration > 
Service Directory Number > Session Profile tab

To configure an SDN to share its resources with a networking service

Note: Only Voice Item Maintenance and Fax Item Maintenance can be 
configured to use the setting, Act on AMIS/Enterprise initiator tone. 

1 Ensure there is a check mark in the Act on AMIS/Enterprise initiator tone 
option box.

2 When you finish configuring the SDN, click Save.
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Configuring fax callback handling

Introduction

When planning callback handling options, identify how callback numbers ne
to be treated for the service you are configuring. Callback numbers must be
format that the system can use to generate a dialable number. This ensure
the requested fax items can be delivered. 

The treatment you select determines how callers are prompted to enter fax
callback numbers. Ensure that callers are prompted to enter the necessary d
codes, such as country code or area code. Identify the potential calling aud
and where the members will be calling from. CallPilot needs the correct acc
code to originate a telephone call from the switch.

Note: If all boxes are disabled, no further configuration is necessary.

Access requirements

You must belong to an access class that grants Edit access to Service Dire
Number.
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Getting there  CallPilot System > System Administration > Service Administration > 
Service Directory Number > Callback Handling tab

To obtain the callback DNs 

Note: To include caller numbers in the fax trimtab, configure the system to 
prompt callers for their extensions when they call for faxes.

1 Ensure the Callback extension prompt box is checked.

2 From the Treat callback number as list, select the type of callback numbers 
supported by the service.

3 When you finish configuring the SDN, click Save.
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To restrict delivery to certain numbers

1 From the Callback dialing RPL list, select the appropriate RPL.

2 When you finish configuring the SDN, click Save.

See also
� Chapter 7, “Customizing dialing restrictions and permissions”

ATTENTION Because services with callback capability can originate 
calls from the switch, your system is charged for these 
calls. To prevent unauthorized callers from abusing 
your system and incurring long distance charges, select 
an appropriate RPL.
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To include a system cover page

1 Under the Callback Handling tab, make sure there is a check mark in the 
Automatic cover sheet check box.

Note: A custom cover page for this service is recommended.

2 To specify the organizational information you want printed on the cover 
page, click the Name and address display box, and then type your business 
name, address, and telephone number.

3 To include a logo or graphic on the system cover page, make sure the 
Cover Page Background check box is checked. Otherwise, go to step 6.

4 To specify the file that contains the logo or graphic, click Import. 

5 Select the graphic file and click OK.

6 When you finish configuring the SDN, click Save.
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Configuring mailboxes for optional 
services
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 Configuring the fax general delivery mailbox 244

 Configuring a fax mailbox for a group 246

 Configuring a broadcast mailbox 247
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Specifying multimedia mailbox storage limits

Introduction

The maximum size of a Fax Call Answering message is the number of pag
equivalent to the maximum size of a Voice Call Answering message, rounde
to the nearest whole page. One minute of voice is equivalent to approximat
3.5 pages of fax. If the maximum size of the voice message is set to 0, no f
messages are accepted.

Access requirements

You must belong to an access class that grants Edit access to Messaging 
Administration.

See also

� information about maximum message length, hardware requirements, 
associated software in the Desktop Messaging Installation and 
Configuration Guide
236 CallPilot



April 2000 Configuring mailboxes for optional services
Getting there  CallPilot System > Messaging Administration > Messaging 
Administration > General tab

To specify the maximum number of pages in a fax

1 In the Maximum number of pages per fax item allowed on system box, type 
the maximum for any single fax item. CallPilot reinterprets this figure to 
determine the maximum number of seconds in a voice item.

2 When you finish configuring the messaging options, click Save.
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Enabling multimedia mailbox capabilities

Introduction

Typically, users have one mailbox number that accepts both voice and fax 
messages. Users do not need a dedicated fax machine or fax DN. They jus
to be assigned to a mailbox class that has fax capability enabled.

See also

� “Express Fax Messaging” on page 198

� information about hardware requirements and associated software in th
Desktop Messaging Installation and Configuration Guide

Access requirements

You must belong to an access class that grants Edit access to Mailbox Clas

Getting there  CallPilot System > User Administration > Mailbox Classes > Media tab
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To let group members receive fax messages in their mailboxes and 
print the faxes

1 Ensure the Fax capability check box is checked.

2 To let group members print fax messages from their mailboxes, select the 
quality of fax output from the Maximum fax resolution box.

3 When you finish configuring the mailbox class, click Save.

To enable speech recognition functionality for a mailbox class

1 Ensure the Speech activated messaging check box is checked.

2 When you finish configuring the mailbox class, click Save.

To let users view their messages from their PC desktops

1 Ensure the Desktop messaging check box is checked.

2 When you finish configuring the mailbox class, click Save.
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Configuring the language for call answering 
voice prompts

Introduction

Call answering services are configured at the mailbox class level. The defau
all supplied mailbox classes is to provide prompts in the primary language o
system. 

Bilingual voice prompts

If callers are likely to use either a primary or secondary language, configure
mailbox class to play bilingual prompts. The caller hears the system promp
the primary language and then in the secondary language.

Matching voice prompts to the recipient’s preferred language

If callers are likely to use the language of the call recipient, configure the 
mailbox class to play prompts in the mailbox user’s preferred language. Wh
caller dials a mailbox user who does not pick up the phoneset, the Call 
Answering service checks the user’s property sheet for the preferred langua
plays all subsequent voice prompts in the specified preferred language.

See also

� “Multilingual mailbox and answering services” on page 207

� “Relationship between mailbox classes and user creation templates” o
page 279

� “Making system greetings bilingual” on page 242

Access requirements

You must belong to an access class that grants Edit access to Mailbox Clas
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Getting there  CallPilot System > User Administration > Mailbox Classes > Mailbox tab

To provide bilingual voice prompts

1 In the Language for callers box, select System Dual Language.

2 When you finish configuring the mailbox class, click Save.

To provide callers with prompts in the recipient’s preferred language

1 In the Language for callers box, select User’s preferred.

2 When you finish configuring the mailbox class, click Save.
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Making system greetings bilingual

Introduction

You can record global default system greetings in an alternate language. En
is always the primary language. 

Note: Users must request that the secondary language play as the greeting
their mailboxes.

Primary language example

“Welcome to the XYZ Corporation. Please leave a message at the sound o
tone or press 0 to be connected to an operator.”

Secondary language example

“Bienvenue à XYZ. Veuillez laisser un message après la tonalité ou faites le
pour communiquer avec la réception des appels.”

Access requirements

You must belong to an access class that grants Edit access to Mailbox Clas

See also

� “Configuring the language for call answering voice prompts” on page 2

� “Phoneset requirements for recording prompts” on page 59

� “Multilingual mailbox and answering services” on page 207
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Getting there  CallPilot System > Messaging Administration > Messaging 
Administration > Mailboxes tab

To record the secondary language greetings

Note: You can also import a WAV file that contains a recorded greeting. For 
instructions, see “To import a WAV file” on page 192.

1 In the System Greetings area of the Messaging Administration Properties 
Mailboxes tab, beside Primary Language (or Secondary Language), click 
Record.

2 In the Specify Phoneset box, type the extension of the phoneset you use for 
recording. 

3 Click OK.

4 When the phoneset at the specified extension rings, pick up the receiver 
and click Record.

5 At the sound of the beep, speak into the phoneset to record the greeting in 
the primary (or secondary) language.

6 Click Stop.

7 Click Disconnect, and hang up the phoneset.
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Configuring the fax general delivery mailbox

Introduction

A fax general delivery mailbox provides a way for users with voice mailboxe
receive fax messages.

If a caller dials the Fax Express Messaging SDN and enters a mailbox with
fax capability, a voice message informs the caller that the mailbox cannot 
receive faxes and offers the fax general mailbox as a destination. The calle
either accept the transfer of the fax message or hang up. 

To deposit a message directly into the fax general delivery mailbox, a caller 
dial the Express Fax Messaging SDN from a faxphone. 

Access to messages

Anyone who knows the fax general delivery mailbox password can access a
messages sent to it. Typically, an administrator checks the mailbox periodic
and distributes messages to individual recipients. You can also configure th
general delivery mailbox to automatically print messages.

Privacy considerations and recommendation

The fax general delivery mailbox is like a system-wide bulletin board becau
all faxes sent to it are available to a large group of users. 

Use the fax general delivery mailbox only for messages that do not contain
proprietary or other confidential information. Users likely to receive confiden
information must have fax capability.

Requirements
� An Express Fax Messaging SDN must be configured in the SDN Table w

media type fax.

� The fax general delivery mailbox must be defined with fax capability 
enabled.
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See also
� “SDNs for fax services” on page 217

� “Adding an SDN” on page 221

� “To configure Express Voice Messaging or Express Fax Messaging” on
page 226

� “Enabling multimedia mailbox capabilities” on page 238

Access requirements

You must belong to an access class that grants Edit access to Messaging 
Administration.

Getting there  CallPilot System > Messaging Administration > Messaging 
Administration > Mailboxes tab

To set up a system-wide fax general delivery mailbox

1 In the Fax general delivery mailbox box, type the number of the mailbox that 
receives faxes whenever the recipient’s mailbox is not fax capable.

2 When you finish configuring system-wide messaging options, click Save.
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Configuring a fax mailbox for a group

Introduction

You can set up group fax mailboxes for customers with many voice channels
few fax channels. 

In this scenario, make these assumptions:

� The majority of user mailboxes are not configured with fax capability 
because there are not enough fax channels to support the potential tra

� There are customer fax machines that serve groups of users. 

� Mailbox users have the Express Fax messaging SDN as the fax numbe
their business cards. When callers dial the fax number, the system forw
the fax message to the fax-capable mailbox associated with the group 
machine. Users can access the group fax mailbox either through CallP
Desktop Messaging Client or through the phoneset, by dialing the Expr
Fax Messaging DN. 

Printing the faxes

Users who access the group fax mailbox via Desktop Messaging can send 
to a printer. Those who access the mailbox via the phoneset can send faxe
fax machine for printing.

Requirement

Each fax mailbox must be configured with fax capability enabled.

See also

� “SDNs for fax services” on page 217

� “To add an SDN” on page 223

� “To configure Express Voice Messaging or Express Fax Messaging” on
page 226
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Configuring a broadcast mailbox

Introduction

You can set up a DN that a caller can use to send a fax message to all use
the CallPilot system.

The number of channels that can be simultaneously allocated to deliver the 
determined in its SDN setup:

� The minimum number of channels determines the number of channels
guaranteed for broadcast message deliveries, regardless of how busy 
system is. 

� The maximum number of channels determines the number of channels
can be allocated to broadcast message deliveries at a time. 

� A minimum setting of 0 means that no channels are guaranteed for this
service.

In your DTF configuration, specify the minimum number of recipients requir
for a fax message to be considered a broadcast fax message. 

Note: You might need to increase channel allocations for broadcast fax deliv
Because channel allocations for services are determined in a service’s SDN
definition, two separate outbound SDNs are assigned to the DTF service in
SDN Table. One is for Delivery to Fax and one is for Multicast Delivery to F

See also

� Chapter 11, “Creating and maintaining shared distribution lists”

� Chapter 22, “Managing channels (M1 switch only)”

Access requirements

You must belong to an access class that grants Edit access to Messaging 
Administration.
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Getting there  CallPilot System > Messaging Administration > Messaging 
Administration > Mailboxes tab

To set up a system-wide broadcast mailbox

1 In the Broadcast mailbox Mailbox number box, type the number of the 
mailbox that is used for broadcasts.

2 Optional: Either record or import a personal verification for the broadcast 
mailbox. 

3 When you finish configuring messaging options, click Save.
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Configuring outcalling services

In this chapter
 Configuring Remote Notification service 250

 Configuring Delivery to Telephone and Delivery to Fax for a user group 255
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Configuring Remote Notification service

Introduction

Remote Notification (RN) is an Outcalling service that notifies users of new
messages that have been deposited into their mailboxes. Recorded messag
inform users that new messages exist can be sent to remote phonesets or p
as defined by the user or the administrator.

A notification might or might not include the message. If a notification is sen
a voice or alphanumeric pager, the new message can be played or displaye
the recipient. 

To define RN rules for users added with a particular template, configure the
options for the associated mailbox class.

Requirements
� The Remote Notification SDN must be defined in the SDN table.

� There must be a mailbox class to assign to each group of RN users.

Hours of operation can be restricted

Remote Notification can operate 24 hours a day, or only during certain times
certain days of the week, as desired.

See also
� “To specify the user’s RN information” on page 173

� Chapter 17, “Making optional services available”

Access requirements

You must belong to an access class that grants Edit access to Mailbox Clas
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Getting there   CallPilot System > User Administration > Mailbox Classes > Remote 
Notification tab

To set up Remote Notification for a user group

Note: You might need to finish configuring the user’s RN schedule on an 
individual basis (see “To specify the user’s RN information” on page 173), or 
users can finish the configuration using their phoneset.

1 To enable RN for mailbox class members, select Enable from the RN 
capability box.

2 To specify the circumstances under which the system stops RN, select a 
value from the Success criteria for notification list.

3 To let users administer their RN schedule from a phoneset, ensure there is 
a check mark in the Telset access check box.

4 To limit RN to new messages only, ensure there is a check mark in the New 
message notification only box.
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To configure pagers for RN

1 To set up the options for pagers that receive RN, click Configure pager.

2 If the user must enter a special terminator character (such as #, to indicate 
that the PIN is completely entered), type that character in the PIN 
terminator box.

3 From the Transmit list, select the amount of information that the user group 
pagers can receive (notification only, CLID, or short voice message).

4 If the user group members have voice pagers:

a. Select the maximum amount of time for a message in the Max 
message length for voice box.

b. Select whether the pager gets the voice message, the header 
information, or both.

5 In the Default callback number displayed box, type the number that RN 
users must call to log on to the messaging system.

6 Click Save.
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To define the retry strategy for remote notification failures

1 Use the Retry limits and frequency settings under the Remote Notification 
tab.

2 Specify the retry strategy for calls that receive a busy signal:

a. In the Retry limit box, type or select the maximum number of times the 
system tries to resend a message if the target number is busy.

b. In the Interval box, type or select how long the system waits before 
retrying DTT when the target number is busy.

3 Specify the retry strategy for calls that receive no answer:

a. In the Retry limit box, type or select the maximum number of times the 
system tries to resend a message if the target number is busy.

b. In the Interval box, type or select how long the system waits before 
retrying DTT when the target number is busy.

4 Specify the retry strategy for calls that are answered but dropped before 
there is a voice response:

a. In the Retry limit box, type or select the maximum number of times the 
system tries to resend a message if the target number is busy.

b. In the Interval box, type or select how long the system waits before 
retrying DTT when the target number is busy.
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5 In the Retry limit before RN stopped box, select the maximum number of 
remote notification cycles before the feature is disabled.

6 Click Save.
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Configuring Delivery to Telephone and 
Delivery to Fax for a user group

Introduction

Configure Delivery to Telephone (DTT) for users who need to be able to 
compose and send voice messages to phonesets that do not have mailbox
defined on the system, such as those that are off-switch and on the public 
network (for example, phonesets used by employees who work at home). 

Configure Delivery to Fax (DTF) service for users who need to send faxes t
faxphones that are not defined as mailboxes on the system, including externa
faxphones.

Configuring DTT and DTF

When you specify dialing restrictions on DTT addresses, you are also specif
them on any DTF service that you configure. The tasks for setting up each 
service are nearly identical, and are typically done during the same session

For a comparison of the tasks for setting up each service, see “Task summary for 
setting up DTT and DTF services” on page 256.

DTT/DTF address prefixes and dialing codes

The addressing prefix tells the system that

� the numbers about to be entered constitute a DTT or DTF address 

� the message is to be delivered to the address using the service

When a user composes a message, CallPilot assumes that the addresses 
are mailbox numbers. If an address does not correspond to a mailbox num
CallPilot must be able to determine that the DTT or DTF service is used to 
deliver the message instead of the Multimedia Messaging service. Otherwis
the message is not delivered and the user receives a nondelivery notificatio
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Task summary for setting up DTT and DTF services

DTT tasks DTF tasks

1. “To specify DTT playback options” on page 
260

Note: Playback can be activated when the 
recipient provides DTMF input to confirm 
playback or it can be voice-activated. DTT 
messages can be set to play either once or 
twice.

1. “To set the DTF broadcast threshold 
and time limit” on page 261 

Note: Broadcast faxes can have differen
channel allocations than regular faxes. 
The broadcast threshold determines how
many recipients a fax must be addresse
to before it is considered a broadcast 
fax. 

2. “To set DTT and DTF delivery times” on page 262

Note: Local laws might not permit delivery of machine-generated messages at certa
times of the day. You are responsible for determining these times and ensuring that
allowed delivery time does not overlap with restricted hours. 

3. “To define a retry strategy” on page 263

Note: The conditions that can lead to a delivery failure are listed on the Delivery to 
telephone tab of the Outcalling Administration dialog box. Define for each condition h
often and up to how many times the system will try to resend a message if the first 
delivery attempt is unsuccessful.

4. “To define address prefixes for both DTT and DTF” on page 264

Note: Define the prefixes that users must enter when addressing messages to non-
mailbox numbers. Define one prefix for each type of call you want to support (such 
local and long distance). For each prefix, specify the dialing code (public network ac
code) that the switch requires to place the call. In most cases, make the prefix and 
dialing code identical. 

5. “To test a DTT or DTF configuration” on page 265

6. “To specify the user’s RN information” on page 173

7. “To assign RPLs to features” on page 273
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Guidelines for configuring DTT and DTF

When you configure DTT or DTF, consider the following requirements and 
recommendations.

Requirements

� To ensure that the DTT/DTF service is activated, you must define one 
more dialing prefixes. Publish these prefixes so users can specify them
during message composition and when entering addresses in distributi
lists.

� For each DTT prefix, an associated dialing code must also be defined. 
When a user enters a DTT prefix, the system actually replaces the prefi
user entered with the associated dialing code. The dialing code is the p
network access code that the system needs to place the call.

� DTT prefixes cannot conflict with mailbox numbers. If you have a 
controlled dialing plan (CDP), the prefix can be the same as the initial 
number(s) of a CDP steering code, but cannot be the same as the enti
code. For example, if one of your steering codes is 566, 5 or 56 can be
as a DTT prefix, but 566 cannot be used. 

For these cases, you need an arbitrary prefix that does not conflict with
other numbers for the system to remove and replace with a dialing cod
create a dialable number.

Synchronizing the DTT prefix and the dialing code
Make the DTT prefix and dialing code the same wherever possible. This 
simplifies message addressing for users because the numbers users enter
addressing a DTT message are exactly the same as the numbers they dial
placing an external call.

Example: If the public network access code for local calls is 9, define both t
DTT prefix and the dialing code as 9. When a user enters a number such a
9555-2124 during message composition, the prefix 9 is removed and then 
replaced by the dialing code 9.
Administrator’s Guide 257



Configuring outcalling services Standard 1.0

u 
ers 
r 

fix is 

 that 
de to 
s 9) is 
lls.

-

le 

sable 
Prefixes for internal numbers
If you want to allow users to send DTT messages to internal extensions, yo
must set up a separate DTT prefix. This prefix is different, however, from oth
because it does not require an associated dialing code. Dialing codes are fo
access to the public network, and internal extensions are on your private 
network. When sending DTT messages to internal extensions, the prefix is 
simply stripped out of the address and the local extension is dialed. The pre
simply needed to inform CallPilot to use the DTT service.

A DTT prefix for each dialing scenario
You need a DTT prefix and associated dialing code for each dialing scenario
you want to allow. This is because the system requires a different dialing co
place a call in each of the scenarios. For example, one dialing code (such a
used to place local calls, whereas another (91) is used for long distance ca
. 

DTMF confirmation
You can specify whether DTMF confirmation is required either on a user-by
user basis or on a system-wide basis. 

� If most users who receive DTT messages have rotary phonesets, disab
DTMF confirmation for the entire system.

� If most users who receive DTT messages have answering machines, di
DTMF confirmation for the entire system.

Dialing scenario
Example 

Prefix
Dialing 
code

Internal: For internal extensions 56* none

ESN: For numbers on your private ESN network, 
if you have one

6 6

Local: For local numbers on the public network 9 9

Long distance: For long distance numbers in the 
same country code

91 91

International: For long distance numbers with 
different country codes

9011 9011
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� If users need to be able to send messages to a diversity of recipients, su
in different parts of the world where there might or might not be DTMF 
support, enable or disable DTMF confirmation at the user level. 

Automatically repeating the message

� Some answering machine greetings contain a long pause, which migh
trigger the playback of the message before the greeting has finished. T
means that the start of the DTT message will not be recorded since the
greeting is still playing. Repeating the message makes it more likely th
the entire message will be successfully recorded.

� People who do not have a lot of experience with automated delivery of
machine-generated messages might not realize what is happening init
Playing the message twice increases the chance that they will be able 
listen to the content of the message.

Access requirements

To configure DTT or DTF, you must belong to an access class that grants E
access to Outcalling Administration.

See also

� information about CallPilot Web Messaging, message addressing, mes
playback, hardware requirements and associated software in the Desktop 
Messaging Installation and Configuration Guide
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Getting there  CallPilot System > Messaging Administration > Outcalling 
Administration > Delivery to telephone tab

To specify DTT playback options

1 In the Require recipients to confirm message playback box, specify whether 
DTT message recipients are required to press a key to confirm they want to 
hear the message (All, None, or Accept user preference). 

2 Specify the number of times to play the DTT message. Click 1 to play 
messages once, or 2 to play messages twice. 

3 Either click Save or click another tab to continue to configure the DTT 
service.
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Getting there  CallPilot System > Messaging Administration > Outcalling 
Administration > Delivery to fax tab

To set the DTF broadcast threshold and time limit

1 In the Number of recipients required for broadcast box, type or select the 
minimum number of recipients to which a fax must be addressed before it is 
considered a broadcast fax.

2 In the Delivery time limit (stale time) box, type or select the amount of time 
that must elapse between a request to deliver a fax and the actual delivery 
before the fax becomes nondeliverable.

3 Either click Save or click another tab to continue to configure the DTF 
service.
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Getting there  CallPilot System > Messaging Administration > Outcalling 
Administration > Delivery to telephone or Delivery to Fax tab

To set DTT and DTF delivery times

1 In the Delivery time limit (stale time) box, specify the duration of time that 
the system can attempt to deliver a message before it becomes 
nondeliverable.

2 Click Define delivery times to define the legally allowed delivery times for 
business days and nonbusiness days in your region.

3 In the Business Days column:

a. Select those days of the week that conform to normal business days in 
your region.

b. In the Delivery Time from box, type or select the time at which local 
laws allow message delivery to begin on business days.

c. In the Delivery Time to box, type or select the time at which message 
delivery must stop on business days.

4 In the Non Business Days column:

a. Select those days of the week that conform to nonbusiness days in 
your region.
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b. In the Delivery Time from box, type or select the time at which local 
laws allow message delivery to begin on nonbusiness days

c. In the Delivery Time to box, type or select the time at which message 
delivery must stop on nonbusiness days.

5 Either click Save or click another tab to continue to configure the DTT or 
DTF service.

To define a retry strategy

Note: For descriptions of the boxes used in this procedure, use the dialog b
field-level context-sensitive Help.

1 For each fax delivery failure condition, change the retry limit or retry 
interval, if necessary.

2 Click Save, or to continue to configure the DTT or DTF service, click 
another tab.
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Getting there  CallPilot System > Messaging Administration > Outcalling 
Administration > Addressing tab

To define address prefixes for both DTT and DTF

1 Click the Addressing tab.

2 For each dialing scenario you want to support:

a. In the Addressing prefixes box, type the prefix that users must enter 
when addressing messages to non-mailbox numbers.

b. In the Dialing codes box, type the public network access code that the 
switch uses to place local, long distance, or international calls. 

3 Either click Save or click another tab to continue to configure the DTT or 
DTF service.
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To test a DTT or DTF configuration

Before you put Delivery to Telephone (DTT) or Delivery to Fax (DTF) into 
service for your users, test the service to ensure your configuration works. T
test, do the following actions:

� Set up one mailbox class in which the service is enabled (the mailbox y
use to test the service must belong to this mailbox class).

� Log on to a mailbox and address a few messages to non-mailbox num
(such as your home number) to see if they are delivered.

For either service, DTT needs to be enabled in the mailbox class to which t
mailbox you will use to test belongs. This involves

� enabling DTT in mailbox classes

DTT is not automatically enabled for all users on the system. You must
identify the mailbox classes that service users that require DTT, and en
the service in those classes.

� assigning the appropriate RPL to DTT

Because both DTT and DTF can place calls outside your system, you m
assign dialing restrictions that are appropriate for the mailbox class.
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Configuring RPLs for optional 
messaging features

In this chapter
 Creating an RPL for a service 268

 Assigning an RPL to a mailbox class 272

 Assigning an RPL to an Application Builder application 274
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Creating an RPL for a service

Introduction

Create special RPLs for any out-dialing feature or for any Application Builde
application that has out-dialing blocks.

To be sure that you account for all out-dialing features, do the following acti

� For Call Answering/Express Voice Messaging thru-dial, determine the 
dialing restrictions and permissions you want to apply to all mailbox us

� When creating a new Application Builder application that includes thru-
dial or fax callback capability, apply the RPL when you create the 
application. 

� Apply RPLs to features on a mailbox class basis.

Guidelines for Mailbox Class RPLs

When you create an RPL, consult a list of the application users. Then 

� for each mailbox class, determine which out-dialing features are neede
users in that class.

� for features users do not need, ensure all dialing codes are restricted (
0–9 should be defined as the restriction codes).

� for features users require, decide on the appropriate dialing restrictions
permissions for each feature.

� move users to other mailbox classes as required.

See also
� “Assigning an RPL to a mailbox class” on page 272

� “Features that allow thru-dialing” on page 272

� “Assigning global restriction/permission lists” on page 69

� “Customizing supplied RPLs” on page 75
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Access requirements

You must belong to an access class that grants Create/delete access to 
Restriction Permission Lists.

Getting there  CallPilot System > Messaging Administration > Restriction Permission 
Lists
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To create a new RPL

Note: Add a restriction code to specify the first digits of a number that is 
restricted from dialing. Then, add a permission code to allow exceptions to 
restriction codes. For example, if 212 is a permission code and 21 is a restri
code, a call to 2125555555 is permitted.

1 On the File menu, choose New.

2 In the General dialog box, in the List name box, type a name that clearly 
identifies the function of the RPL.

3 If desired, use the Comments box to type in extra information describing the 
RPL’s restrictions.

4 For each set of restriction and permission codes that you want to add:

a. In the Restriction codes box, type a number that callers might not use 
to call out (in this example, 12), then click Add. 

b. In the Permission box, type a number that callers might use to call out 
that overrides the corresponding restriction code by adding an 
additional digit (in this example, 212), then click Add.

Note:  You might need to add more than one permission code for a 
restriction code.
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5 In the Restriction codes list, click on the number you want to remove.

Tip: To select multiple codes, hold the Ctrl button and click the other 
numbers you want to remove.

6 Click Remove.

7 In the Permission codes list, click the number you want to remove.

Tip: To select multiple codes, hold the Ctrl button and click the other 
numbers you want to remove.

8 Click Save.
Administrator’s Guide 271



Configuring RPLs for optional messaging features Standard 1.0

r the 

llow 

the 
r the 
r to 

ge.
Assigning an RPL to a mailbox class

Introduction

Apply RPLs to services that members of the mailbox class can use. Conside
calling requirements of the members and the restrictions needed for cost 
management and system security.

Features that allow thru-dialing

Assign a level of restrictions and permissions to system-wide features that a
external callers to thru-dial off the local switch.

These features include

� Call Answering/Express Voice Messaging thru-dial

� Mailbox Thru-Dialing

� Name Dialing and Name addressing by external callers

� External Call Sender

� Custom Revert

� Delivery to Telephone and Delivery to Fax

� AMIS Open Networking

� Remote Notification

� Fax Printing

� Application Builder services that include a thru-dial block

MSL-100 switch limitation
The MSL-100 switch transfers a thru-dialed call only after confirmation that 
call is placed successfully. This confirmation can be either a ringback tone o
sound of a voice. This method of handling thru-dials allows the original calle
return to CallPilot when the transfer is not completed. Consequently, if the 
confirmation is voice, the first one or two words are missing from the messa
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Access requirements

You must belong to an access class that grants Create/delete access to Ma
Classes.

Getting there  CallPilot System > User Administration > Mailbox Classes > RPLs tab 

To assign RPLs to features

1 For each service that is enabled for the mailbox class:

a. Select an RPL.

b. Click Properties to verify the RPL configuration.

2 Click Save.
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Assigning an RPL to an Application Builder 
application

Introduction

Apply RPLs to the features defined in Application Builder. Consider the call
requirements of the members and the restrictions needed for cost managem
and system security.

Access requirements

You must belong to an access class that grants Edit access to Service Dire
Number.

Getting there  CallPIlot System > System Administration > Service Administration > 
Service Directory Number > Callback Handling tab
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To select the RPL to assign to an application

1 From the Callback dialing RPL box, select an RPL.

2 Click Save.
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Adding user creation templates

In this chapter
 Overview of customer-specific templates 278

 Creating a new user template 280

 Cloning an existing template 282

 Maintaining a set of user templates 284
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Overview of customer-specific templates

Introduction

Your system already contains several prepackaged templates. The templat
named according to the types of users who require them. For example, the
Executive template provides the most extensive messaging features and me
storage capacity. You can use the prepackaged templates as they are, or y
customize the templates before you use them. 

User creation template clones for user groups with special needs

The user population sometimes has members with special needs or equipm

Examples

� Some users have offices in different branches; others do not.

� Some users have well-equipped home offices; others do not.

� Some users need to send messages over the public network; others do

� Some users send or receive volumes of faxes; others do not.

� Some users have PCs with multimedia capabilities; others do not.

User creation template clones for each additional volume 

If, when using the AutoAdd feature, the administrator specifies the volume 
which new users are stored, clone a user template for each volume to store
based on the original template.

Note: You can configure the template to automatically distribute new users 
across volumes.

User creation template clones for each administrator type

If you distribute CallPilot administrative responsibilities among a team of 
administrators, create a user template for each administrator type. As 
administrators are added to the system, the responsible administrator can a
the appropriate access class to the new administrator.
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Relationship between mailbox classes and user creation templates

For the supplied mailbox classes and local mailbox user creation templates
there is a one-to-one correspondence between the two. 

Examples

� Basic User mailbox class corresponds to the Basic User template.

� Executive User mailbox class corresponds to the Executive User templ

A graphical representation looks like this:

As the system develops, the user population changes, and mailbox classes
user templates are cloned and created, the graphical representation looks m
like this:

See also
� Chapter 8, “Controlling access to administration programs” 

� “Adding a group of users all at once” on page 104

� “Changing access to administrative programs” on page 159

Basic User 
Mailbox Class

Basic User 
Template

Executive User 
Mailbox Class

Executive User 
Template

Basic User 
Mailbox Class

Basic User 
Template

Executive User 
Mailbox Class

Executive User 
Template

Basic User 
(with RN)

Mailbox Class

Executive User 
(with Speech Act.) 

Mailbox Class

Basic User 
(with RN)
Template

Executive User 
(with Speech Act.) 

Mailbox Class

Basic English User 
(with RN)
Template

Basic French User 
(with RN)
Template
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Creating a new user template

Introduction

To create a new template without copying and modifying an existing templa
you need to

� name the template

� assign an access class to the template, if the user has administrative 
capability

� specify the user type’s title

� specify the user type’s department

Note: You can create user templates only if you have Create/Delete access 
User Creation Templates program.

Access requirements

You must belong to an access class that grants Create/delete access to Us
Creation Templates.

Getting there   CallPIlot System > User Administration > User Creation Templates
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To create a new user template

1 On the File menu, choose Create New Template.

Result: A blank New Template Properties sheet appears.

2 Under the template tab, in the Template Name box, type the template 
name.

3 Click the General tab.

4 If the user group is based on job function, type the job title in the Title box.

5 If the user group is based on business unit, type the department name in 
the Department box.

6 If the template is to create a group of administrators:

a. Click the Admin tab.

b. Check the Admin Capability item in the tree list if it is not checked.

c. From the Access Class list, select the access class you want to assign 
to this template.

d. If you want to prevent user group members from accessing the 
desktop, click the Lock out button.

7 Click Save.
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Cloning an existing template

Introduction

Create templates quickly and easily by basing your new template on an exi
one. The properties of the existing template are transferred to the new one.
can then edit the general information stored in the template, or assign a diff
access class to the template, or both.

Access requirements

You must belong to an access class that grants Create/delete access to Us
Creation Templates.

Getting there  CallPIlot System > User Administration > User Creation Templates

ATTENTION To change a template, you must open the template 
properties sheet. 

When you double-click a template name to open it, you
are adding a new member to the user group.
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To clone an existing template

1 In the Templates list, select a template that is similar to the new one.

2 On the File menu, choose Duplicate.

3 Click the Template tab if it is not open.

4 In the Template Name box, type a name for the template.

5 To change the default ID number assigned to the template, type the new ID 
number in the Template ID box.

6 Verify that the Admin Capability item in the tree list is checked only if the 
template is to create users with administrative rights.

7 If the template is to create a group of administrators

a. Click the Admin tab.

b. From the Access Class list, select the access class you want to assign 
to this template.

c. If you want to prevent user group members from accessing the 
desktop, click the Lock out button.

8 Click Save.
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Maintaining a set of user templates

Introduction

When you maintain a set of user templates, you must keep records and de
obsolete templates from the system.

Access requirements

To view or print user template properties, you must belong to an access clas
grants View access to User Creation Templates.

To delete a user template, you must belong to an access class that grants C
delete access to User Creation Templates.

Template documentation

Print a hard copy of the following reports for your records:

� the template name and ID of one template

� a list of template names and IDs for all defined templates

� a detailed list of all properties of each template

Deleting a user template

When you delete a template, you do not delete the users who were created
that template. 

See also
� “Deleting a user or directory entry” on page 193
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Managing channels (M1 switch only)

In this chapter
 Multimedia services and M1 channels 286

 Allocating channels to services 291

 Disabling a service 294
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Multimedia services and M1 channels

Introduction

If your CallPilot system is connected to an M1 switch, it can use functions 
provided only by the Application Module Link (AML). Use these functions to
change channel allocations to services based on current usage.

The way you allocate channels depends on several factors, such as how m
traffic you expect the service to generate and the importance of the service

Third-party switches

If your CallPilot system is connected to a third-party switch, you can limit th
number of channels available to a service, but you cannot reallocate a chan
a service using a different media type. 

Supported third-party switches use hunt groups for resource allocation. For 
information, see the Software Installation and Configuration Guide for your 
server.

Total number of channels

The total number of channels available for any CallPilot system is keycode-
controlled. If you need more channels, upgrade yourCallPilot server.

Default channel allocations

By default, CallPilot allocates channels to services dynamically, based on 
available channel resources. For many systems, this default configuration w
very efficiently.

The default minimum
The minimum number of channels allocated to each service is zero. This m
that services are not guaranteed access to any channels. Other services ar
allowed to use up all of the channels of a particular type (such as fax), leavin
available channels. 
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Example: A Fax on Demand service has no guaranteed channels (minimum
zero). All fax channels on the system become busy due to the traffic genera
by other fax services. A call in to the Fax on Demand service is queued unt
fax channel becomes idle.

The default maximum
By default, the maximum number of channels that a service can use at any
time (by default) is all channels of the required type. 

Example: Four fax channels are on your system. A burst of traffic is directed
a particular Fax on Demand service. Because all four channels are idle, thi
service is allowed to use all four channels simultaneously, leaving no chann
available to other fax services.

Guaranteeing a minimum number of channels

For certain critical services, you can guarantee a certain minimum number 
channels. The specified number of channels is always reserved for the serv
and cannot be used by other services.

Note: This method of allocating channels is not recommended for a large 
number of services, since it can reduce the overall efficiency of your system

Restriction
The total number of minimum channel settings for all your services must be
than the total number of channels assigned to that media type. 

Example
If you a allocate a minimum of two fax channels to Delivery to Fax (service,
least two fax channels is always available to the Delivery to Fax service. Th
number of fax channels available to the other fax services is reduced by two

Limiting the number of channels used by a service

Instead of allowing a service to use up all channels of a particular type, you
place a limit on how many channels a service can use simultaneously.
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Example
There are four fax channels on your system. For a particular Fax on Deman
service, you change the default setting to two. The service can now use no 
than two fax channels simultaneously, even if the other two fax channels are

Example: Allocating and reallocating channel resources

A new voice menu application is put into service. This menu informs compa
employees of the new benefits plan, and is expected to generate heavy traf
during the first month it is used.

Your system has 18 voice channels. For the first month of service, you alloc
minimum of two channels and a maximum of four channels to the voice me

After one month, when the amount of traffic generated by the service decre
you reduce the minimum number of channels to zero and the maximum to 

Note: A minimum setting of zero means that the service is not guaranteed a
channels. If all voice channels are busy, that service cannot obtain a chann
until there is an idle channel.

Allocations for Application Builder services with fax callback

If the session profile for an Application Builder service allows fax callback 
delivery, the channel allocations assigned to the service’s SDN are not used
Instead, the channel allocations assigned to the Delivery to Fax SDN are us
because the Delivery to Fax service delivers faxes on a callback.

Allocations for speech recognition services

Speech recognition channels use four times the processing power of multim
channels.

Estimating service requirements

Use the guidelines in the Planning and Engineering Guide to estimate the 
number of channels a service needs. Then monitor actual service usage us
Reporter to see if you need to adjust the channel allocations. 
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Reporter reports

The Reporter utility provides predefined reports to help you monitor service
usage and performance.

System status reports
Run the following reports to view statistics for each channel type. These rep
include data such as the number of callers who waited for a channel and th
number of callers who abandoned their calls.

� Service Quality Summary report

� Service Quality Detail report

� Channel Usage report

Traffic reports
Run the System Traffic Summary report to identify how much particular 
services are used. For example, you can identify the percentage of total tra
generated by a service. This gives you an idea of whether the current chan
allocations for that service are adequate.

Outcalling reports
Run the following reports to determine if outcalling services are able to acqu
channels when needed. You can view the average and maximum times that
service had to wait to acquire a channel.

� DTT Activity report

� Fax Deliveries Activity report

� Fax on Demand Audit Trail Detail report

� Fax Print Audit Trail Detail report

� RN Activity report

� RN Audit Trail Detail report

Networking reports
If any AMIS or VPIM Networking services are installed, you can run the Ope
Networking Activity report. A high number of blocked sessions means that t
service cannot acquire channels to complete calls.
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See also
� information about managing channels in Monitoring and Security for the 

Administrator

� information about channel usage reports in Reporter Guide
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Allocating channels to services

Introduction

If your telephony services are provided by an M1 switch, you can change th
minimum number of channels guaranteed for a service if traffic generated b
service is greater than originally anticipated.

Restrictions on editing outbound SDNs

Outbound SDNs are automatically created by the system during installation
there are certain things that you cannot change. You cannot

� create or delete an outbound SDN

� rename an outbound SDN

� change the actual Service DN

Note: This number is specific to each service and is automatically assig

� modify the session profile or callback handling properties

Access requirements

You must belong to an access class that grants Edit access to Service Dire
Number.
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Getting there   CallPilot System > System Administration > Service Administration > 
Service Directory Number
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To allocate channels for inbound or outbound services (M1 switch 
only)

1 Either create a new SDN or open an existing one.

2 Specify how you want the system to allocate resources:

� To allow the system to allocate channels based on available resources, 
make sure the Use Default Maximum box is checked and leave the 
Minimum channels setting at 0.

� To guarantee that the service has access to a certain number of 
channels at any time, type this number in the Minimum Channels box.

� To limit how many channels the service can use simultaneously to a 
specific number, make sure the Use Default Maximum box is not 
checked. In the Maximum Channels box type the maximum number of 
channels the service can use at any one time. 

3 Either click Save or continue configuring the SDN. 
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Disabling a service

Introduction

If your CallPilot server is connected to an M1 switch, you can temporarily 
disable a service by allocating no channels to it. When you wish to reenable
service, you do not need to reconfigure its session profile and other parame

Note: If your telephony services are provided by a switch other than the M1, 
cannot temporarily disable a service. 

Access requirements

You must belong to an access class that grants Edit access to Service Dire
Number.

Getting there   CallPilot System > System Administration > Service Administration > 
Service Directory Number > General tab
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To temporarily disable a service (M1 switch only)

Set both the maximum and minimum number of channels to zero. 

Result: The Fax Buffering Mailbox template appears.

1 In the First name box, type the user’s first name.

2 In the Last name box, type the user’s last name.

3 In the Comments box, type any additional information about the user.

4 Click the Mailbox tab. 

5 In the Mailbox number box, type the extension DN of the fax machine.

6 Click the Set Up tab.

7 In the Default Printing DN box, type the extension DN of the fax machine.

8 If a prefix (for name dialing and name addressing) is not assigned in 
Messaging Administration, click the Security tab and assign a password.

9 Click Save.
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Configuring remote administration of 
the server

In this chapter
 Overview of remote administration via pcANYWHERE32 298

Section A: Configuring pcANYWHERE32 on a PC 301

Section B: Establishing a dial-up connection to the server 309

Section C: Performing remote tasks using pcANYWHERE32 315
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Overview of remote administration via 
pcANYWHERE32

Introduction

This chapter describes the following tasks:

� how to set up an administrative PC with pcANYWHERE32 software to 
perform remote administration tasks on a server

� how to establish a dial-up connection to a CallPilot server

� how to use pcANYWHERE32 to control the connected CallPilot system
from a remote or local administrative PC

In this chapter, a remote support PC or a local PC used to administer or ac
the server is referred to as an administrative PC.

Establishing a network connection with the server from a remote PC

Administrative PCs that are not on the same LAN as the server must use Dia
Networking (DUN) to connect to the server. Remote Access Service (RAS) m
be installed and configured on the server. 

Dial-Up Networking software is usually installed during the Windows NT 4.0
Windows 95, or Windows 98 initial installation. If the Dial-Up Networking 
folder does not appear in the My Computer window, the software is not insta
Refer to your Windows documentation for a Dial-Up Networking installation
procedure.

RAS is installed on the CallPilot server at the factory. RAS is configured on-
as part of the Configuring Windows NT procedures.

ATTENTION Do not schedule intensive remote tasks during peak ca
traffic hours. This can adversely affect call processing 
capabilities of the server.
298 CallPilot



April 2000 Configuring remote administration of the server

is on 

 

 

A dial-up connection enables the remote administrative PC to appear as if it 
the same LAN as the server, and allows you to

� perform limited file transfers from the administrative PC to the CallPilot
system

� perform administration on the CallPilot server using CallPilot 
Administration Client on the administrative PC

� attempt to establish a pcANYWHERE32 remote control session over a
modem link
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Section A: Configuring pcANYWHERE32 
on a PC

In this section
 Overview of pcANYWHERE32 302

 Installing pcANYWHERE32 on the administrative PC 303

 Configuring pcANYWHERE32 on the administrative PC 306
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Overview of pcANYWHERE32

Introduction

You can use pcANYWHERE32 to perform advanced administrative tasks o
connected CallPilot server. You can control the CallPilot server as though y
were directly connected to it.

One licensed copy of pcANYWHERE32 Version 8.0 is provided for the serv
on the CallPilot server software CD. pcANYWHERE32 is installed on the 
server at the factory. 

To install pcANYWHERE32 Version 8.0 on the administrative PC, you must 
purchase a separate license for the administrative PC.

When to use pcANYWHERE32

Remote control (using pcANYWHERE32) lets administrators and Nortel 
Networks customer support representatives perform advanced administrativ
actions, such as

� querying the server event logs

� shutting down or restarting the server

� using server-only support tools

� applying PEPs

System requirements for the administrative PC
� Windows NT 4.0, Windows 95, or Windows 98 operating system

� Dial-Up Networking (DUN) if connecting over the Public Switch 
Telephone Network (PSTN); DUN is normally included on Windows PC

� pcANYWHERE32 (must be purchased for the administrative PC)

See also
� information about preparing the server for remote access with 

pcANYWHERE in the Software Installation and Configuration Guide
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Installing pcANYWHERE32 on the 
administrative PC

Introduction

Nortel Networks does not provide a pcANYWHERE32 license for an 
administrative PC. 

Before you install pcANYWHERE32 on an administrative PC, purchase a 
separate license from the pcANYWHERE32 vendor. 

Steps for installing pcANYWHERE32

To complete the installation and initial setup of pcANYWHERE32 on the 
administrative PC, you must follow the steps in the following procedures:

� “To install pcANYWHERE32 on the administrative PC” on page 303

This procedure installs the software on the administrative PC.

� “To start pcANYWHERE32 for the first time” on page 304

This procedure identifies the network protocol. 

� “To set the video mode” on page 305

This procedure synchronizes the video card settings of the administrati
PC with that of the CallPilot server. This ensures that the remote user c
see the graphical user interfaces properly. 

To install pcANYWHERE32 on the administrative PC

1 Log on as Administrator.

2 Insert the MAS Operating System CD in the CD-ROM drive. 

3 Run the cdinst.exe program on the CD-ROM to start the installation.

4 Click the Install Software button.

Result: The Welcome window appears.

5 Click Next.

Result: The User Information window appears.
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6 Enter both the user and the company names, then click Next.

Result: The Online License Agreement window appears.

7 Click Yes to accept the software license agreement.

Result: The Choose Destination window appears.

8 Click Next until you get to the Registration Wizard screen.

9 Click Skip.

Result: The pcANYWHERE32 Setup window appears. The system asks 
whether you want to view the readme file.

10 Click No.

11 Select Yes to restart the computer, then click Finish.

To start pcANYWHERE32 for the first time

1 Click Start > Programs > pcANYWHERE32 > pcANYWHERE.

Result: The Smart Setup Wizard window appears. 

2 Click Next.

Result: The Network Device window appears.

3 Ensure only TCP/IP is selected, then click Next.

4 Select Finish.
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To set the video mode

1 In pcANYWHERE32, select Application Options from the File menu. 

2 Select the Host Operation tab.

3 Click the Video mode drop-down list to change from the default setting to 
Compatibility.

4 Click Apply.

5 Click OK to exit.
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Configuring pcANYWHERE32 on the 
administrative PC

Introduction

You must create a remote control connection icon in pcANYWHERE32 that
allows you to connect to the server. Configure other options on 
pcANYWHERE32 as required by the customer.

Getting there  Windows Start > Programs > pcANYWHERE32 > pcANYWHERE

To create a remote control connection icon

1 Select Remote Control.

2 Double-click the Add Remote Control icon.

3 Create a new pcANYWHERE32 connection profile using the following 
parameters:

a. Assign a profile name.

b. For the connection device, select TCP/IP. Do not select a modem.
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c. If the administrative PC is connecting to the server via a CLAN or ELAN 
card, enter the CallPilot CLAN or ELAN IP address as the Host PC 
Name.

d. Clear the check box for Automatically begin remote control session 
upon wizard completion field, then click Finish.

4 Right-click the new remote control connection icon, then select Properties.

5 Under the Setting tab, increase the Number of connection attempts to a 
value higher than zero. 

6 Under the Security Options tab, ensure that pcANYWHERE encryption is 
selected (this is the default).

7 All other fields are optional. Set as required for the customer, or leave at 
default values.

8 Click OK.

What’s next?

If you are using pcANYWHERE32 on a remote administrative PC, then 
continue with Section B: “Establishing a dial-up connection to the server,” on
page 309.

If you are using pcANYWHERE32 on a local administrative PC (that is, the 
is on the same LAN as the server), then continue with Section C: “Performing 
remote tasks using pcANYWHERE32,” on page 315.
Administrator’s Guide 307



Configuring remote administration of the server Standard 1.0
308 CallPilot



April 2000 Configuring remote administration of the server
Section B: Establishing a dial-up 
connection to the server

In this section
 Overview of the dial-up connection 310

 Creating the Dial-Up Networking connection profile 311

 Establishing a connection using Dial-Up Networking 313
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Overview of the dial-up connection

Introduction

This section provides procedures for creating a dial-up networking connect
profile for connecting a remote administrative PC to the server. 

Once you have established a network connection with the server, the remo
administrative PC can behave as though it is on the same LAN as the serve
can either launch a CallPilot system or use pcANYWHERE32 to control the
server.

See also
� Chapter 6, “Configuring mailbox security” 
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Creating the Dial-Up Networking connection 
profile

Introduction

The Dial-Up Networking software enables you to establish a connection 
between the server and administrative PC over the public switch telephone
network (PSTN). 

A Dial-Up Networking connection profile contains the connection informatio
required for the remote administrative PC to connect to the server. This is n
required for administrative PCs that are on the same LAN as the server. Wh
connection profile is created, an icon representing the connection profile app
in the Dial-Up Networking folder. 

Before you begin

Dial-Up Networking must be installed
Dial-Up Networking software is installed during the Windows NT 4.0, Window
95, or Windows 98 setup and is usually present on PCs that have a standa
setup.

If the Dial-Up Networking folder does not appear in My Computer, it is not 
installed. Refer to your Windows documentation for a Dial-Up Networking 
installation procedure.

What you need
To create a server Dial-Up Networking connection profile, you must have th
following information:

� the server telephone number

� the server IP address

If you do not know this information, contact the system administrator.
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To create a server connection profile (for Windows 95 or 98 
administrative PC)

1 Click Start > Programs > Accessories > Dial-Up Networking.

Result: The Make New Connection wizard appears.

Note: If connections have been created previously on this administrative 
PC, click the Make New Connection icon in the Dial-Up Networking window 
to display the wizard.

2 Enter a name for the connection and select a modem. You do not need to 
configure the profile at this time.

3 Click Next.

4 Enter the server telephone number, then click Next.

5 Click Finish.

6 Continue with “To configure a connection profile” below.

To configure a connection profile

1 Right-click the server connection profile icon, then select Properties.

2 Enter the telephone number of the server if it is not already present or if it is 
incorrect. Make any other changes on this window if required.

3 Click Configure.

4 Update the tabs as required, then click OK.

5 Click Server Settings.

6 For Dial-Up Server, select PPP:Windows NT.

7 For the network protocols, select only TCP/IP and NETBEUI. 

8 Click TCP/IP settings.

9 Select Specify an IP address, and enter the server IP address.

10 Select Use default gateway on remote network.

11 The remaining fields are optional. Fill them in as required for the customer’s 
network.

12 Click OK.
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Establishing a connection using Dial-Up 
Networking

Introduction

Administrative PCs that dial in over the PSTN must establish a dial-up 
connection with the server. If the administrative PC and server are on the s
LAN, then the procedures in this section are not required.

Before you begin

� Ensure that you have created a server connection profile. See “Creating the 
Dial-Up Networking connection profile” on page 311.

� You might need a user ID and password to log on to the customer’s 
network. Contact the customer to obtain this information.

� If you are using pcANYWHERE32, you need the password for a remot
access user account and pcANYWHERE32 caller account on the serve
(for example, the NGenDist user account and pcANYWHERE32 NGenD
caller account).

To establish a connection to the server

1 Log on to the administrative PC.

2 Click Start > Programs > Accessories > Dial-Up Networking.

3 Double-click the server connection profile icon. 

Note: If the icon is unavailable, you have not created a server connection 
profile. See “Creating the Dial-Up Networking connection profile” on page 
311.

4 If prompted for a user ID and password, enter the user ID and password to 
log on to the customer’s network. 

5 Wait until the connection is established.
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To disconnect a dial-up connection

1 Right-click the icon on the toolbar

2 Click Disconnect.

What’s next?

After the connection has been made, you can do the following tasks:

� Launch a CallPilot system to access the CallPilot Administration Client
window.

� Use pcANYWHERE32 to control the server to perform any administrati
task. See “Controlling the server using pcANYWHERE32” on page 317.

� Restart the server. See “Restarting the server remotely” on page 319.
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Section C: Performing remote tasks 
using pcANYWHERE32

In this section
 Overview of remote control of the server 316

 Controlling the server using pcANYWHERE32 317

 Restarting the server remotely 319

 Restarting the server remotely without using pcANYWHERE32 320
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Overview of remote control of the server

Introduction

This section describes how to log on to the server using pcANYWHERE32.
Once you have logged on, you can control the server as though you were s
at a keyboard connected directly to it. 

If the server is powered off, you cannot establish a connection with the serv
Someone at the server’s location must turn on the server.

Testing the connection if the administrative PC is on the server’s LAN

If the administrative PC is on the same LAN as the server, then you do not 
to establish a dial-up connection. 

Test the network connection to the server’s CLAN or ELAN card, depending
whether the administrative PC is connecting to the server over the CLAN or
ELAN.

1 Open up a DOS prompt and type ping "XX.XX.XX.XX" where XX.XX.XX.XX 
is the IP address of the CLAN or ELAN card on the server.

2 If it is successful, then a connection has been established. Otherwise, 
check the cabling and the administrative PC's TCP/IP configuration 
information.
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Controlling the server using pcANYWHERE32

Introduction

You can use pcANYWHERE32 to operate the server as if you were directly
connected to it. 

Before you begin

� If the server is not on the same LAN as the administrative PC, then 
establish a dial-up connection. See “Establishing a connection using Dial-
Up Networking” on page 313.

� You need the password for a remote access user account and 
pcANYWHERE32 caller account on the server (for example, the NGenD
user account and pcANYWHERE32 NGenDist caller account)

Remote tasks

Once a pcANYWHERE32 session is successfully established, you can take
direct control of the server to

� query the server event logs

� shut down or restart the server

� use server-only support tools

� apply PEPs

� perform other advanced administration activities

To control the server using pcANYWHERE32 on the administrative PC

1 If you are dialing in over the PSTN, establish a dial-up connection (see “To 
establish a connection to the server” on page 313).

2 Click Start > Programs > pcANYWHERE32 > pcANYWHERE. 

3 Double-click the remote control icon for the server. 

Note: If the icon is unavailable, see “To create a remote control connection 
icon” on page 306.
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4 When prompted, enter the pcANYWHERE32 logon ID and password.

To end a pcANYWHERE32 remote control session

1 To log off the server, press Ctrl+Alt+Del on the administrative PC and select 
Logout.

2 Disconnect the pcANYWHERE32 connection. 

3 If applicable, disconnect the Dial-Up Networking connection.

a. Right-click the icon on the toolbar.

b. Click Disconnect.
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Restarting the server remotely

Introduction

You might need to restart the server from a remote location if the system go
down or if you need to run startup diagnostic tests. 

Restarting the server using pcANYWHERE32

If pcANYWHERE32 is installed, then establish a remote control session an
restart the server using the Start > Shutdown option. See “Controlling the server 
using pcANYWHERE32” on page 317.

Restarting the server when pcANYWHERE32 is not available

See “Restarting the server remotely without using pcANYWHERE32” on pag
320.
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Restarting the server remotely without using 
pcANYWHERE32

Introduction

This section describes how to restart the server without using pcANYWHER
if it is not installed or not available. If pcANYWHERE32 is installed, then 
establish a remote control session and restart the server using the Start > 
Shutdown option. See “Restarting the server remotely” on page 319.

What restarting the server remotely involves

To restart the server remotely, you must

� configure the Hyperterminal connection

� configure the ports

� edit the Host file to establish a connection with the server

HyperTerminal

HyperTerminal (with a modem) enables you to connect to a remote comput
even if it is not running Windows. You must configure a HyperTerminal 
connection. 

After a HyperTerminal connection is configured, it appears as a submenu in
Accessories in the Programs menu. 

To configure HyperTerminal

1 Click Start > Programs > Accessories > HyperTerminal.

2 Double-click Hyperterminal.

Result: The Connection Description window appears.

3 Enter a name that describes the connection, then select an icon (optional). 
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4 Click OK.

Result: The Connect to window appears.

5 Select the port to which the modem is attached.

Result: The Properties window appears.

6 Select 19200 Bits per second.

7 Click OK.

To configure the modem port

1 Click Start > Settings > Control Panel.

2 Double-click Modems.

3 Click the Device Manager tab.

4 Select View the devices by type.

5 Double-click Ports (COM & LPT).

6 Click the Communications Port used by the modem (either COM1 or 
COM2).

7 Click the Port Settings tab.

8 Select 19200 in the Bits per second tab.

To restart the server remotely 

1 Open Notepad or a similar application.

2 Add the server IP address to the end of the following file: 
WinNT/System32/Drivers/etc/host. 

Example: 127.0.0.1 <name>

3 Establish a connection to the server using Dial-Up Networking (DUN).

For information on how to connect using DUN, see “Establishing a 
connection using Dial-Up Networking” on page 313.

4 Type the following in the host file:

shutdown -n <number> and -r 

Example: shutdown -h myhostname -n 4165971111
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5 Disconnect the DUN connection:

a. Right-click the icon on the toolbar.

b. Click Disconnect.

Result: The connection to the server is broken, and the system calls back 
to the administrative PC at the number entered in step 4. When the 
connection is reestablished, the server restarts and restart information 
appears in the HyperTerminal window.

Note: This process takes approximately five minutes.

6 Type the following in the HyperTerminal window:

ATS0=1 

7 Press Enter.

8 After restart is complete, close the HyperTerminal window.
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A
access classes

changing for administrators 159
configuring 85
creating 85, 88
default for system administrators 80
definition 80
deleting 89
guidelines for planning 83
levels of administrative access 81
renaming 85, 87
viewing 86

access levels 81
access requirements

adding a CallPilot Remote User 188
adding a group of users 104
adding a user 162, 166, 175, 182, 185
adding an SDN 221
assigning global RPLs 69
configuring a broadcast mailbox 247
configuring a fax delivery mailbox 245
configuring a session profile 224
configuring an SDL 120, 123, 127
configuring an SDN 43, 224, 228
configuring mailbox classes 112, 114
configuring time-outs 48
creating a user template 280, 282
customizing existing RPLs 76
customizing system prompts 59
deleting a user 193
enabling or disabling Autologon 146
maintaining user templates 284
making system prompts bilingual 242
modifying a user template 99
modifying user properties 155, 157, 159, 191
reenabling a disabled mailbox 143
resetting a mailbox password 144
resetting a user’s administrative password 150
assigning RPLs to a mailbox class 273

creating RPLs 269
searching for users 134, 137, 138, 139, 140
specifying a user’s access to administrative 

programs 148
specifying a user’s preferred language 240
specifying holiday service times 56
specifying logon requirements 67
specifying mailbox storage limits 48, 236
specifying the attendant DN 54
specifying the billing DN 54
specifying the name dialing DN 54

access to administrative programs
controlling 81, 159
when users change jobs 154

address prefixes 51
and dialing codes 257
defining for DTT/DTF 264
delivery to nonusers 256
description 255
for DTT/DTF 255
how many are needed 258
internal numbers 258

administrative access levels 81
administrative capability 94

adding to a user 160
changing for a user 160
configuring for a user 159
disabling and restoring 148
removing from user 149, 160
resetting a password for users with 150
restoring 149

administrative programs
accessing 35
controlling access to 81, 159
restoring access to 149, 151

Administrator user creation template 80
administrators, description 16
AMIS Open Networking

and hackers 74
and RPLs 72, 272
initiator tone 220, 228, 229
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g

answering machine users and DTT configuration 
258, 259

Application Builder applications
and RPLs 272, 274
and session profiles 224
assigning RPLs to 274
media type 210
special RPLs for 268
voice menus 58
voice prompts 58

application-specific RPLs 274
attendant DN

description 54
specifying 55

AutoAdd
adding users 104
log file 95, 104
overview 95
password prefixes 95
selecting the template 105

Autologon
description 146
enabling and disabling 146, 147
user configuration problems 142

B
bilingual voice prompts 240
billing DN

description 54
specifying 55

blocking messages 49, 200
broadcast delivery

channel allocations 247, 256
number of recipients 247

broadcast fax messages, description 247
broadcast mailbox

channel allocations 247
configuring 248

C
Call Answering 175

and RPLs 272
multilingual service 207, 208

multimedia, description 200
providing dual language voice prompts 208
selecting an RPL for 69
using alternative language for system greetin 

208
Call Sender 177

and RPLs 72, 272
configuring 226
description 74

callback DNs
and RPLs 268
and SDLs 125

CallPilot Administration Client
delegation of administrative tasks 16
description 15

CallPilot Remote Users
and distribution lists 188

capabilities
administrative 94
definition 94
mailbox 94
speech recognition 206

capacities
Autologon 146

CDP numbers 217
channel allocations

and broadcast fax messages 256
and services 286
broadcast delivery 247, 256
for a service requiring an SDN 214

channels
default channel allocations 286
limiting number used by a service 287
minimum number of 287
sharing 211
types 210
types of 210

chargeback reports 54
CLID with unknown format 50
Command Entry time-out 47
configuration task flows

basic CallPilot system 25
high level 24

continuous digit entry 205, 206
controlled dialing plan (CDP) 217, 257
corporate identity, adding to system prompts 58
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Custom Revert
and RPLs 72
and thru-dialing 272

D
default access class 80
default outbound SDNs 215
default SDNs 202
delivery times

DTT and DTF 256
of messages to nonusers 203
setting for DTT/DTF 262

Delivery to Fax (DTF)
and RPLs 72, 272
and SDN Table 247
benefit to users 203
benefits 203
benefits to customers 203
benefits to users 255
broadcast delivery 247
broadcast delivery and channel allocations 

247
configuring 255, 256
defining address prefixes 264
guidelines and requirements 257
prefix and dialing plan conflicts 257
setting delivery times 262
synchronizing the address prefix and dialing 

code 257
testing the configuration 265

delivery to nonusers
DTT/DTF prefixes and dialing codes 256
fax messages 203
multimedia messages 203

Delivery to Telephone (DTT)
and multimedia messages 203
and RPLs 72, 272
answering machine users 258, 259
as a reminder service 204
benefit to users 202
benefits to customers 203
benefits to users 255
configuring 255, 256, 259
defining address prefixes 264
DTMF confirmation 258

DTMF confirmation settings 259
DTMF input 256
guidelines and requirements 257
inexperienced users 259
internal number prefixes 258
message playback 259
multimedia message delivery example 203
prefix and dialing plan conflicts 257
rotary phone users 258
setting delivery times 262
specifying message playback options 260
synchronizing the address prefix and dialing

code 257
testing the configuration 265
using as reminder 204

dependencies
administrative access privileges 94
and channel allocations 286
assigning mailbox class RPL 115
dialing information 50
how outcalling services handle multimedia 

messages 204
mailbox configuration and fax message 

handling 201
MWI DN configuration 166
switch type 50

Desktop Messaging
and RPLs 72
enabling for a user group 239

dialing codes
delivery to nonusers 256
description 255, 257
how many are needed 258

dialing defaults for outcalling services 51
dialing information

description 50
feature use 50
setting up 50
specifying 52
switch type dependencies 50

directory entries
adding 185, 186
deleting 193
importing a spoken greeting for 192
name dialing 186

disabled mailbox 143
distributing users across volumes 96, 278
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distribution lists, shared
adding directory entries 126
adding local users 124, 125
adding remote users 126
adding users 125
and CallPilot Remote Users 188
and multimedia messages 119
contents, printing 128
creating 121
creating user list for 124
deleting user from 125
delivery to nonusers 257
labeling 121
name, recording 122
networking requirements 118
printing list of 128
restrictions 118

DNU
See delivery to nonusers

DTF
See Delivery to Fax (DTF)

DTMF availability and DTT configuration 259
DTMF confirmation 258

DTT message playback 259
DTT settings 259

DTMF input and message playback 256
DTT

See Delivery to Telephone (DTT)
dual language prompts

call answering 208
recording 243

E
Enterprise Networking

and SDN queues 220
initiator tone 220, 228, 229

ESN access codes
description 51
specifying 52

ESN calls, handling 50
ESN numbers 217
Express Fax Messaging 244

and session profiles 224
description 198
for a group 246

mailbox number 226
multiple services 199
versus Multimedia Messaging 198

Express Voice Messaging 177, 178
and RPLs 272
and session profiles 224
description 198
selecting an RPL for 69

external CLID with an unknown format 50

F
Fax 244
Fax Call Answering 182, 201
Fax Express Messaging 244
fax general delivery mailbox 244
Fax Item Maintenance 220, 228, 229
fax messages

delivery to nonusers 203
SDNs needed for fax services 217

Fax Printing and mailbox class RPLs 72, 272
fax services

Delivery to Fax (DTF) 203
Express Fax Messaging 198, 226, 246, 247
Fax Call Answering 201
SDNs 217

G
global RPLs 69
greeting

bilingual 242
importing WAV file 192, 243
recording 243

guest mailbox
creating 181
description 178

H
Help, online 21
high level configuration task flow 24
hunt group technology 206
326 CallPilot



April 2000 Index
I
importing a WAV file 192
inbound SDNs 215
inexperienced users and DTT configuration 259
initiator tone 220, 228
International prefix 51

L
language

mailbox classes 170, 240
providing call answering service in the 

mailbox user’s preferred language 208
providing call answering service with 

bilingual prompts 208
specifying for call answering service 207, 208
user’s preferred 170, 240
using alternative language for system greeting 

208
using front-end voice menus to determine 

prompt language 208
Local prefix 51
Local RPL 75
local users

adding one at a time 164
adding to SDL 124
changing administrative access 159
changing administrative capability 160
changing job functions 154
changing job title or department 155
changing the mailbox class 157
common problems 142
creating a fax buffering mailbox for 184
deleting 193
description 93
DNs associated with mailbox 171
inexperienced 259
modifying mailbox capabilities for 170
personal verification information 174
preferred language 170, 240
reenabling mailbox for 143
resetting administrative password for 151
resetting passwords for 144, 145
restoring administrative capability 149

special mailbox configurations 154
viewing mailbox status 169

locking out administrators 148
log file, AutoAdd 95, 104
logon requirements

configuring 67
recommendations 65

Long distance 1 RPL 75
Long distance 2 RPL 75
Long distance prefix 51

M
M1 switch

and personal fax call answering 201
and phantom DNs 206
and switch type dependencies 50

mailbox access privileges 141
mailbox capabilities

Autologon, enabling and disabling 147
customizing for a specific scenario 175
enabling mailbox capability 94
modifying for a local user 170

Mailbox Class RPLs 114
mailbox classes

and RPLs 272
and user creation templates 92, 154
changing for a user 157
definition 110
language 170, 240
planning 74
ready-to-use 110
special scenarios 154
versus Class of Service 110

mailbox number
broadcast mailbox 248
for fax delivery mailbox 226
typically one 238
using to add user to SDL 125

mailbox security
Autologon 146
configuring access controls 68
global dialing restrictions 64
issues and recommendations 64
passwords 66
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mailbox status, viewing a user’s 169
Mailbox Thru-Dialing and RPLs 72, 272
mailboxes

and MWI 201
choice of language for voice prompts 207
customizing for a specific scenario 175
defining DNs associated with 171
defining Remote Notification (RN) 

information 173
fax buffering, creating 184
fax delivery for a group 246
fax general delivery 244
for guests 178
passwords, resetting 144, 145
reenabling for a user 143
setting up special 246

Matra switch caveat 200
media type

and Application Builder applications 210
channels 214

Message Blocking 200
message delivery

channel allocations 247
DTT multimedia 203
number of broadcast recipients 247

message playback
and DTMF input 256
and DTT options 260

messages
blocking 49, 200
delivery to nonusers 203
distribution lists, shared

number of addresses 119
playback 256, 260

MSL-100 switch 206, 214, 220
and thru-dial confirmation 272

multilingual mailbox and answering services 207
Multimedia Call Answering

description 200
Matra switch caveat 200
requirement 200

multimedia channels
processing power 288
types 210

multimedia mailboxes
enabling capabilities 238

storage limits 236
multimedia messages

and shared distributions lists 119
blocking 49
delivery to nonusers 203
size equivalencies between voice and fax 236

Multimedia Messaging 255
and DTF 203
CDN 201
description 198

N
name dialing

and RPLs 272
directory entries 186
enabling 55
enabling and disabling 54

narrowing user search 136
networking

and SDNs 220
initiator tone 220, 228, 229
Open AMIS 74
Open AMIS and RPLs 72
SDL requirements 118

nondelivery notifications 255
nonusers, delivery of messages to 203

O
On Switch RPL 75
online Help 21
outbound SDNs 215

and outcalling services 202
restrictions on editing 291

outcalling services
and outbound SDNs 202
dialing defaults 51
included services 202

P
Paced Speech Messaging

automated access 206
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benefits 205
recommendation 206
requirements 206

passwords
AutoAdd 95
guidelines for configuring access controls 66
prefixes 95
resetting for a user 144, 145
resetting for administrators 151
sysadmin, changing 36

permission codes
adding 77
adding to new RPL 270
definition 73

Personal Fax Call Answering 201
personal verification message, providing for a 

local user 174
phantom DNs (M1 and MSL-100) 206
phoneset requirements for recording prompts 59
placeholder (user searches) 132
planning

access classes 83
customer-specific user templates 278
user groups 74

preferred language
configuring for a user 101
customizing for a user 170
providing call answering service in the 

mailbox user’s preferred language 208
processing power service requirements 210
prompts

adding 58
bilingual 240
recording 59
voice menus 58

R
ready-to-use mailbox classes 110
ready-to-use templates 92
Record Disconnect time-out 47
recording 192

name of SDL 122
prompts (phoneset requirements) 59
system prompts 59

related information products 19

remote administration of the server 297
Remote Notification (RN)

and fax buffering mailboxes 182
and RPLs 272
benefit to users 202
configuring for a local user 173
description 202, 250
hours of operation 250
requirements 250

Remote User Template 187, 189
Remote Users (CallPilot)

adding 187, 189
creating and adding to SDL 123
deleting 193
description 187
recording a spoken name for 192
versus remote users 187

resetting
administrator password 151
user passwords 145

restoring
access to administrative programs 149
administrative capability 149
latest user search 137

restriction codes
adding to new RPL 270
definition 73
removing from RPL 76

restriction/permission lists (RPLs)
adding codes 270
application-specific 274
assigning to a mailbox class 114
assigning to features 273, 274
configuration guidelines 268
creating 270
customizing 71
for Call Answering service 69
for Express Voice Messaging 69
for thru-dialing sessions 69
global 69
planning 74
supplied 69, 75

restrictions
on distribution list numbers 118
on editing outbound SDNs 291
shared distribution lists 118

retry strategy for DTT and DTF 256
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e 
revert DNs
and RPLs 272
security issue 74

RN
See Remote Notification (RN)

rotary phone users and DTT configuration 258
RPLs

See restriction/permission lists (RPLs)

S
saved user searches

deleting 140
running 139

SDLs
See shared distribution lists; distribution lists, 

shared
SDN Table 206, 247

and outcalling services 202
default outbound SDNs 215

SDNs
See Service Directory Numbers (SDNs)

searching for users
creating a search 135
examples 133
for addition to shared distribution list 124
narrowing search 136
performing search 136
placeholder 132
reusing the last search 137
saving a user search 138
using a saved user search 139
widening search 136
wildcards 132

Service Directory Numbers (SDNs)
default outbound 215
definition 42
disabling a service (M1 switch only) 294
inbound 215
outbound 215
restrictions on editing outbound 291
sharing 220

services
built-in versus created 210
media requirements for 210

multilingual 207
Multimedia Messaging 198
outcalling 202
Speech Activated Messaging 205

session profiles
and Application Builder applications 224
and Express Fax Messaging 224
and Express Voice Messaging 224
description 214

shared channels (resources) 211
shared distribution lists (SDLs)

adding directory entries 126
adding local users 124, 125
adding remote users 126
adding users 123, 125
and multimedia messages 119
configuring 120
contents, printing 128
creating 121
creating a new remote user and adding to th

SDL 123
creating and maintaining 117
creating user list for 124
deleting 127
deleting user from 125
delivery to nonusers 257
guidelines for creating 118
labeling 121
modifying 123
name, recording 122
number of addresses 119
printing list of 128
requirements for networking 118
restrictions 118

Short Disconnect time-out 47
special DNs

configuring 54
description 54

specific scenarios, customizing for 175
Speech Activated Messaging

description 205
limitations 205
requirements 206

speech recognition capability 206
speech recognition functionality 239
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spoken commands 205
spoken name

for a user or directory entry 191
importing 192
importing WAV file 192
recording for a CallPilot Remote User 192

supplied mailbox classes 110
supplied RPLs 75
supplied templates 93
supporting telecommuters 204
switch type dependencies 50
switch types

dependencies 50
supported 18

system greetings
adding a corporate identity 58
bilingual 242
recording dual language 243
using alternative language for 208

system prompts
viewing and changing 58, 61
WAV file formats 59

T
task summary for configuring DTT and DTF 256
telecommuters, supporting 204
templates

Administrator 80
capabilities included in 94
overview 92
supplied 92
viewing in AutoAdd 105

testing DTT/DTF configuration 265
thru-dialing 73, 74

and time-outs 47
dialing restrictions 69
features that allow it 272

Timed Delivery 204

U
unknown format, CLID 50

user creation templates
Administrator 80
and mailbox classes 92, 154
and user properties 93
overview 92
ready-to-use 92
selecting for an AutoAdd operation 105
supplied 92
supplied local 93

user groups
adding 95, 104
adding multiple members to 106
and user creation templates 92
changing default mailbox capabilities for 100
customizing settings for 99
planning 74
specifying default messaging options for 103

user searches
broadening 134
creating 135
examples 133
narrowing 136
placeholders 132
restricting 134
reusing the last search 137
saving 138
widening 136
wildcards 132

user templates
administrative capability 94
Administrator 80
capabilities included in 94
creating from existing template 282
creating new 280
mailbox capability 94
supplied 92, 93

users
distributing across volumes (AutoAdd) 96
searching for 135, 136

using placeholders 132
using wildcards 132

searching for, using a saved search 138
types of 93
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V
viewing

a user’s mailbox status 169
template in AutoAdd 105

Voice Item Maintenance 220, 228, 229
voice menus 58

configuring session profiles for 224
for receiving a fax item 218
to provide access to service 217
to provide choice of language 208

voice prompts
adding 58
bilingual 240
phoneset requirements for recording 59

volumes, distributing users across during an 
AutoAdd operation 96

W
WAV file formats for system prompts 59
WAV file, importing 192
wildcards (user search) 132
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